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1 [bookmark: _Toc339877860][bookmark: _Toc79602546][bookmark: _Toc107404492]
Organizational Structure
1.1 [bookmark: _Toc339877861][bookmark: _Toc79602547][bookmark: _Toc107404493]Chart of Depreciation
1.1.1 [bookmark: _Toc107404494]Copy Reference Chart of Depreciation

	Script Description
	Create chart of depreciation

	Objective
	To define the chart of depreciation for Fusion 1 Project. The chart of depreciation is a list of depreciation areas arranged according to business and legal requirements. When creating a chart of depreciation, you have to copy the reference chart of depreciation for Thailand-specific (0TH).

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Copy Reference Chart of Depreciation/Depreciation Areas -> Copy Reference Chart of Depreciation

	Transaction Code
	EC08

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	Copy chart of depreciation from ‘0TH’ (Sample chart of depreciation: Thailand) to ‘1000’



Screen: Organizational object Chart of depreciation
[image: ]
Configure system by copying Chart of depreciation from ‘0TH’ (Sample chart of depreciation: Thailand) to ‘1000’


Key Fields Definitions
	Field Name
	Description

	From Chart of dep.
	Reference Chart of depreciation number to be copied

	To Chart of dep.
	Chart of depreciation description to be created



1.1.2 [bookmark: _Toc107404495]Specify Description of Chart of Depreciation

	Script Description
	Define description for chart of depreciation

	Objective
	To define description for chart of depreciation.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Copy Reference Chart of Depreciation/Depreciation Areas -> Specify Description of Chart of Depreciation

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Copy Reference Chart of Depreciation

	Remark
	N/A



Screen: Change View “Chart of Depreciation: Specify Name”: Overview
[image: ]
Configure system as below table:
	ChDep
	Description

	1000
	Chart of Depreciation



Key Fields Definitions
	Field Name
	Description

	ChDep
	Chart of depreciation number

	Description
	Chart of depreciation description


1.1.3 [bookmark: _Toc107404496]Assign Chart of Depreciation to Company Code

	Script Description
	Create chart of depreciation and depreciation areas

	Objective
	To assign the chart of depreciation to each company code that is defined in Asset Accounting.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Assign Chart of Depreciation to Company Code

	Transaction Code
	OAOB

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Copy Reference Chart of Depreciation/Depreciation Areas

	Remark
	N/A



Screen: Change View “Maintain company code in Asset Accounting”: Overview
[image: ]


Configure system as below table:
	CoCd
	Company Name
	Chrt dep
	Description

	1010
	BTSG
	1000
	Chart of Depreciation

	1020
	Yongsu
	1000
	Chart of Depreciation

	2010
	BTSC
	1000
	Chart of Depreciation

	2020
	BIS
	1000
	Chart of Depreciation

	2030
	NBM
	1000
	Chart of Depreciation

	2040
	EBM
	1000
	Chart of Depreciation

	2050
	BID
	1000
	Chart of Depreciation

	3010
	VGI
	1000
	Chart of Depreciation

	3020
	888
	1000
	Chart of Depreciation

	3030
	VGI Advertising Media
	1000
	Chart of Depreciation

	3040
	POV
	1000
	Chart of Depreciation

	5010
	DNAL
	1000
	Chart of Depreciation

	5020
	The Community One
	1000
	Chart of Depreciation

	5030
	The Community Two
	1000
	Chart of Depreciation

	5040
	Kingkaew Assets
	1000
	Chart of Depreciation

	5050
	Mochit Land
	1000
	Chart of Depreciation

	5060
	CAPRICORN HILL
	1000
	Chart of Depreciation

	5300
	U City
	1000
	Chart of Depreciation

	5310
	U Global
	1000
	Chart of Depreciation

	5320
	TANAYONG HONG KONG
	1000
	Chart of Depreciation

	5500
	EGS ASSETS
	1000
	Chart of Depreciation

	5510
	Muangthong Assets
	1000
	Chart of Depreciation

	5520
	Nine Square Property
	1000
	Chart of Depreciation

	5530
	MAK8
	1000
	Chart of Depreciation

	5540
	BTS Land
	1000
	Chart of Depreciation

	5550
	Rong Pasee Roi Chak Sam
	1000
	Chart of Depreciation

	5560
	KHONKAENBURI
	1000
	Chart of Depreciation

	5610
	BOONBARAMEE METTA
	1000
	Chart of Depreciation

	5620
	Pacific Hotel Chiangmai
	1000
	Chart of Depreciation

	5630
	Pacific Chiangmai Co.,Ltd
	1000
	Chart of Depreciation

	5800
	UNISON One
	1000
	Chart of Depreciation

	5810
	Kamkoong Property
	1000
	Chart of Depreciation

	5840
	Prime Area Retail
	1000
	Chart of Depreciation

	5850
	U Remix
	1000
	Chart of Depreciation

	5900
	TANAYONG PROPERTY
	1000
	Chart of Depreciation

	5910
	Thana City Golf
	1000
	Chart of Depreciation

	6200
	PROJECT GREEN
	1000
	Chart of Depreciation

	6210
	SIAM PAGING
	1000
	Chart of Depreciation

	6220
	TANAYONG FOOD & BEVERAGE
	1000
	Chart of Depreciation

	6230
	PrannaKiri Assets
	1000
	Chart of Depreciation

	6240
	Ratburana Property
	1000
	Chart of Depreciation

	6250
	NPARK GLOBAL
	1000
	Chart of Depreciation

	6260
	Phraram 9 Alliance
	1000
	Chart of Depreciation

	6270
	Prime Area 12
	1000
	Chart of Depreciation

	7010
	Prime Area 38
	1000
	Chart of Depreciation

	7500
	KEYSTONE ESTATE
	1000
	Chart of Depreciation

	7510
	Keystone Management
	1000
	Chart of Depreciation

	7900
	Rabbit Life Insurance
	1000
	Chart of Depreciation

	8020
	RR
	1000
	Chart of Depreciation

	8030
	BPS
	1000
	Chart of Depreciation

	8040
	BSSH
	1000
	Chart of Depreciation

	8050
	RPS
	1000
	Chart of Depreciation

	8090
	RBS
	1000
	Chart of Depreciation

	8100
	RCASH
	1000
	Chart of Depreciation

	8200
	HHT
	1000
	Chart of Depreciation

	8300
	T23
	1000
	Chart of Depreciation

	8310
	T1
	1000
	Chart of Depreciation

	8330
	T3
	1000
	Chart of Depreciation

	8340
	T4
	1000
	Chart of Depreciation

	8350
	T5
	1000
	Chart of Depreciation

	8360
	T6
	1000
	Chart of Depreciation

	8370
	T7
	1000
	Chart of Depreciation

	8380
	T8
	1000
	Chart of Depreciation

	8390
	T9
	1000
	Chart of Depreciation

	8400
	T10
	1000
	Chart of Depreciation



Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	Company Name
	Company code description

	Chrt dep
	Chart of depreciation ID

	Description
	Chart of depreciation description





1.2 [bookmark: _Toc107404497]Specify Number Assignment Across Company Codes

	Script Description
	Specify main asset number assignment to company code

	Objective
	To define the main asset number assignment for each company code. Therefore, each company code will have their own asset number range.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Specify Number Assignment Across Company Codes

	Transaction Code
	AO11

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “FI-AA: “Assignmt. to company code providing number range”
[image: ]
Configure system as below table:
	CoCd
	Company Name
	No.CoCd

	1010
	BTSG
	1010

	1020
	Yongsu
	1020

	2010
	BTSC
	2010

	2020
	BIS
	2020

	2030
	NBM
	2030

	2040
	EBM
	2040

	2050
	BID
	2050

	3010
	VGI
	3010

	3020
	888
	3020

	3030
	VGI Advertising Media
	3030

	3040
	POV
	3040

	5010
	DNAL
	5010

	5020
	The Community One
	5020

	5030
	The Community Two
	5030

	5040
	Kingkaew Assets
	5040

	5050
	Mochit Land
	5050

	5060
	CAPRICORN HILL
	5060

	5300
	U City
	5300

	5310
	U Global
	5310

	5320
	TANAYONG HONG KONG
	5320

	5500
	EGS ASSETS
	5500

	5510
	Muangthong Assets
	5510

	5520
	Nine Square Property
	5520

	5530
	MAK8
	5530

	5540
	BTS Land
	5540

	5550
	Rong Pasee Roi Chak Sam
	5550

	5560
	KHONKAENBURI
	5560

	5610
	BOONBARAMEE METTA
	5610

	5620
	Pacific Hotel Chiangmai
	5620

	5630
	Pacific Chiangmai Co.,Ltd
	5630

	5800
	UNISON One
	5800

	5810
	Kamkoong Property
	5810

	5840
	Prime Area Retail
	5840

	5850
	U Remix
	5850

	5900
	TANAYONG PROPERTY
	5900

	5910
	Thana City Golf
	5910

	6200
	PROJECT GREEN
	6200

	6210
	SIAM PAGING
	6210

	6220
	TANAYONG FOOD & BEVERAGE
	6220

	6230
	PrannaKiri Assets
	6230

	6240
	Ratburana Property
	6240

	6250
	NPARK GLOBAL
	6250

	6260
	Phraram 9 Alliance
	6260

	6270
	Prime Area 12
	6270

	7010
	Prime Area 38
	7010

	7500
	KEYSTONE ESTATE
	7500

	7510
	Keystone Management
	7510

	7900
	Rabbit Life Insurance
	7900

	8020
	RR
	8020

	8030
	BPS
	8030

	8040
	BSSH
	8040

	8050
	RPS
	8050

	8100
	RCASH
	8100

	8200
	HHT
	8200

	8300
	T23
	8300

	8310
	T1
	8310

	8330
	T3
	8330

	8340
	T4
	8340

	8350
	T5
	8350

	8360
	T6
	8360

	8370
	T7
	8370

	8380
	T8
	8380

	8390
	T9
	8390

	8400
	T10
	8400


[bookmark: _Toc339877863]



Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	Company Name
	Company code description

	No.CoCd
	Key for main asset number assignment


1.3 [bookmark: _Toc107404498]Asset Classes
1.3.1 [bookmark: _Toc339877864][bookmark: _Toc107404499]Specify Account Determination

	Script Description
	Specify account determination for asset class

	Objective
	To specify key and description of account determination for asset class. The account determination links an asset master data to the general ledger accounts to be posted for an accounting transaction using the asset class.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Asset Classes -> Specify Account Determination

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A




Screen: Change View: “FI-AA: Account determination”: Overview
[image: ]

Configure system as below table
	Acct. determ.
	Name of Account Determination

	Z1101
	Land (IP)

	Z1101I
	Land (IP)-Impairment

	Z1102
	Land (PPE)

	Z1102I
	Land (PPE)-Impairment

	Z1103
	Land awaiting Development

	Z1103I
	Land awaiting Development-Impairment

	Z1104A
	Land Improvement (IP) [Admin]

	Z1104AI
	Land Improvement (IP) [Admin]-Impairment

	Z1104C
	Land Improvement (IP) [Cost]

	Z1104CI
	Land Improvement (IP) [Cost]-Impairment

	Z1105A
	Land Improvement (PPE) [Admin]

	Z1105AI
	Land Improvement (PPE) [Admin]-Impairment

	Z1105C
	Land Improvement (PPE) [Cost]

	Z1105CI
	Land Improvement (PPE) [Cost]-Impairment

	Z1201A
	Building (IP) [Admin]

	Z1201AI
	Building (IP) [Admin]-Impairment

	Z1201C
	Building (IP) [Cost]

	Z1201CI
	Building (IP) [Cost]-Impairment

	Z1202A
	Building (PPE) [Admin]

	Z1202AI
	Building (PPE) [Admin]-Impairment

	Z1202C
	Building (PPE) [Cost]

	Z1202CI
	Building (PPE) [Cost]-Impairment

	Z1203A
	Building Improvement (IP) [Admin]

	Z1203AI
	Building Improvement (IP) [Admin]-Impairment

	Z1203C
	Building Improvement (IP) [Cost]

	Z1203CI
	Building Improvement (IP) [Cost]-Impairment

	Z1204A
	Building Improvement (PPE) [Admin]

	Z1204AI
	Building Improvement (PPE) [Admin]-Impairment

	Z1204C
	Building Improvement (PPE) [Cost]

	Z1204CI
	Building Improvement (PPE) [Cost]-Impairment

	Z1205A
	Renovation [Admin]

	Z1205C
	Renovation [Cost]

	Z1301C
	Golf Course Development [Cost]

	Z1301CI
	Golf Course Development [Cost]-Impairment

	Z2101C
	Machine-Rolling Stock [Cost]

	Z2102C
	Machine [Cost]

	Z2201A
	Operating Equipment [Admin]

	Z2201C
	Operating Equipment [Cost]

	Z2301A
	Utility & Supply [Admin]

	Z2301C
	Utility & Supply [Cost]

	Z3101A
	Furniture & Fixtures [Admin]

	Z3101C
	Furniture & Fixtures [Cost]

	Z3201A
	Office Equipment [Admin]

	Z3201C
	Office Equipment [Cost]

	Z3301A
	Computer [Admin]

	Z3301C
	Computer [Cost]

	Z4101A
	Vehicle [Admin]

	Z4101C
	Vehicle [Cost]

	Z5101C
	Digital Advertising [Cost]

	Z5201A
	Advertising Equipment [Admin]

	Z5201C
	Advertising Equipment [Cost]

	Z6101A
	Right of Use Asset-Land [Admin]

	Z6101AI
	Right of Use Asset-Land [Admin]-Impairment

	Z6101C
	Right of Use Asset-Land [Cost]

	Z6101CI
	Right of Use Asset-Land [Cost]-Impairment

	Z6102A
	Right of Use Asset-Building [Admin]

	Z6102AI
	Right of Use Asset-Building [Admin]-Impairment

	Z6102C
	Right of Use Asset-Building [Cost]

	Z6102CI
	Right of Use Asset-Building [Cost]-Impairment

	Z6103A
	Right of Use Asset-Equipment [Admin]

	Z6103AI
	Right of Use Asset-Equipment [Admin]-Impairment

	Z6103C
	Right of Use Asset-Equipment [Cost]

	Z6103CI
	Right of Use Asset-Equipment [Cost]-Impairment

	Z6104A
	Right of Use Asset-Vehicle [Admin]

	Z6104AI
	Right of Use Asset-Vehicle [Admin]-Impairment

	Z6104C
	Right of Use Asset-Vehicle [Cost]

	Z6104CI
	Right of Use Asset-Vehicle [Cost]-Impairment

	Z8101A
	Software & License [Admin]

	Z8101C
	Software & License [Cost]

	Z8102A
	Brand License [Admin]

	Z8103A
	Not Used

	Z8104A
	Trademarks [Admin]

	Z8201C
	Right on Civil to Government [Cost]

	Z8202A
	Right on Building to Government [Admin]

	Z8202C
	Right on Building to Government [Cost]

	Z8203C
	Right on E&M to Government [Cost]

	Z8301A
	Leasehold Right-Land [Admin]

	Z8301C
	Leasehold Right-Land [Cost]

	Z8302A
	Leasehold Right-Building [Admin]

	Z8302C
	Leasehold Right-Building [Cost]

	Z8303A
	Leasehold Right-Condo & Fixtures [Admin]

	Z8303C
	Leasehold Right-Condo & Fixtures [Cost]

	Z9101
	AuC-IP

	Z9102
	AuC-PPE

	Z9103
	AuC-Intangible

	Z9201C
	Spare Parts awaiting Transfer [Cost]

	Z9701A
	Low Valued Asset (LVA) [Admin]

	Z9701C
	Low Valued Asset (LVA) [Cost]

	Z9801
	Dummy for Asset

	Z9901
	Asset for Consignment

	Z9902
	Non Valued Asset (NVA)



Key Fields Definitions
	Field Name
	Description

	Acct. determ.
	Account determination ID which is defined in accordance with Asset class number

	Name for Account Determination
	Account determination description


1.3.2 [bookmark: _Toc107404500]Create Screen Layout Rules

	Script Description
	Create screen layout rules for asset class

	Objective
	To create the keys and descriptions of screen layout rule which specifies the status of the fields in the asset master data. The screen layout is used for determining if fields are required entry or optional entry fields, or if they are suppressed completely.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Asset Classes -> Create Screen Layout Rules

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A 















Screen: Change View “Asset Accounting: Screen layout for master record”: Overview
[image: ]
Configure system as below table
	Screen Layout Rule
	Name of screen layout rule 

	Z100
	Land & Building

	Z10I
	Land & Building-Impairment

	Z200
	Machine & Operating

	Z300
	Office Fur&Fix, Computer

	Z400
	Vehicles

	Z500
	Advertising

	Z600
	Right of Use Asset

	Z60I
	Right of Use Asset-Impairment

	Z800
	Intangible Assets

	Z910
	Assets under Construction

	Z920
	Other Assets

	Z970
	Low Value Asset (LVA)

	Z980
	Dummy Asset

	Z990
	Non Valued Asset (NVA)





Key Fields Definitions
	Field Name
	Description

	Screen Layout Rule
	Screen layout rule ID

	Name for screen layout rule
	Screen layout rule description


1.3.3 [bookmark: _Toc107404501]Define Number Range Interval

	Script Description
	Define interval of asset number range for asset class

	Objective
	To define the number range interval of main asset number for each company code. Each number range interval then will be assigned to asset class.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Asset Classes -> Define Number Range Interval

	Transaction Code
	AS08

	Configuration to PRD
	Direct Configuration

	Prerequisite Step
	Specify Number Assignment Across Company Codes

	Remark
	Number ranges are not required for the assignment of asset sub-numbers.



Screen: Edit Intervals: Asset Number, Object ANLAGENNR
[image: ]
Configure system by entering company code to maintain number range interval.
Click [image: ] to display number range
Click [image: ] to maintain number range
Click [image: ] to maintain current number for number range
Screen: Edit Intervals: Asset Number, Object ANLAGENNR, Subobject <Company Code>
[image: ]
Configure system for all company codes as below table
	No
	From No. 
	To Number
	NR Status
	Ext

	1A
	110100000001
	110199999999
	0
	

	1B
	110200000001
	110299999999
	0
	

	1C
	110300000001
	110399999999
	0
	

	1D
	120100000001
	120199999999
	0
	

	1E
	120200000001
	120299999999
	0
	

	1F
	120300000001
	120399999999
	0
	

	1G
	120400000001
	120499999999
	0
	

	1H
	120500000001
	120599999999
	0
	

	1I
	130100000001
	130199999999
	0
	

	1J
	110400000001
	110499999999
	0
	

	1K
	110500000001
	110599999999
	0
	

	2A
	210100000001
	210199999999
	0
	

	2B
	210200000001
	210299999999
	0
	

	2C
	220100000001
	220199999999
	0
	

	2D
	230100000001
	230199999999
	0
	

	3A
	310100000001
	310199999999
	0
	

	3B
	320100000001
	320199999999
	0
	

	3C
	330100000001
	330199999999
	0
	

	4A
	410100000001
	410199999999
	0
	

	5A
	510100000001
	510199999999
	0
	

	5B
	520100000001
	520199999999
	0
	

	6A
	610100000001
	610199999999
	0
	

	6B
	610200000001
	610299999999
	0
	

	6C
	610300000001
	610399999999
	0
	

	6D
	610400000001
	610499999999
	0
	

	8A
	810100000001
	810199999999
	0
	

	8B
	810200000001
	810299999999
	0
	

	8C
	810300000001
	810399999999
	0
	

	8D
	810400000001
	810499999999
	0
	

	8E
	820100000001
	820199999999
	0
	

	8F
	820200000001
	820299999999
	0
	

	8G
	820300000001
	820399999999
	0
	

	8H
	830100000001
	830199999999
	0
	

	8I
	830200000001
	830299999999
	0
	

	8J
	830300000001
	830399999999
	0
	

	9A
	910100000001
	910199999999
	0
	

	9B
	910200000001
	910299999999
	0
	

	9C
	910300000001
	910399999999
	0
	

	9D
	920100000001
	920199999999
	0
	

	9W
	990200000001
	990299999999
	0
	

	9X
	970100000001
	970199999999
	0
	

	9Y
	 A
	ZZZZZZZZZZZZ
	0
	X

	9Z
	990100000001
	990199999999
	0
	





Key Fields Definitions
	Field Name
	Description

	No
	Number range ID 

	From No.
	The first number (lower limit) to be assigned of an interval 

	To Number
	The last number (upper limit) to be assigned of an interval 

	NR Status
	The last assigned number for an interval

	Ext
	Indicator which determines whether the interval is external number assignment


1.3.4 [bookmark: _Toc107404502]Define Asset Class

	Script Description
	Define asset class

	Objective
	To define asset class. The asset class is the most important criterion for structuring fixed assets from an accounting point of view. Each asset must be assigned to precisely one asset class. The assets and their respective business transactions are assigned to the GL accounts through the asset classes. Several asset classes can use the same account determination
The most important tasks of the asset classes are the following:
1. In the overview screen, enter the key of the asset class, a short text and a description of the asset class.
2. Then maintain the control parameters in the detail screen. The following specifications are very important:
· Account determination
· Screen layout rules 
· Number range interval for the assignment of the main asset number
· Assignment of subnumbers (internal or external)

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Organizational Structures -> Asset Classes -> Define Asset Classes

	Transaction Code
	OAOA

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	· Specify Account Determination
· Create Screen Layout Rules
· Define Number Range Interval

	Remark
	N/A





Screen: Change View “Asset classes”: Overview
[image: ]
Configure system as below table
	Class
	Short Text
	Asset Class Description

	Z1101
	Land (IP)
	Land (IP)

	Z1101I
	Land (IP)-Imp
	Land (IP)-Impairment

	Z1102
	Land (PPE)
	Land (PPE)

	Z1102I
	Land (PPE)-Imp
	Land (PPE)-Impairment

	Z1103
	Land awaiting
	Land awaiting Development

	Z1103I
	Land awaiting-Imp
	Land awaiting Development-Impairment

	Z1104A
	Land Imp(IP)[A]
	Land Improvement (IP) [Admin]

	Z1104AI
	Land Imp(IP)[A]-Imp
	Land Improvement (IP) [Admin]-Impairment

	Z1104C
	Land Imp(IP)[C]
	Land Improvement (IP) [Cost]

	Z1104CI
	Land Imp(IP)[C]-Imp
	Land Improvement (IP) [Cost]-Impairment

	Z1105A
	Land Imp(PPE)[A]
	Land Improvement (PPE) [Admin]

	Z1105AI
	Land Imp(PPE)[A]-Imp
	Land Improvement (PPE) [Admin]-Impairment

	Z1105C
	Land Imp(PPE)[C]
	Land Improvement (PPE) [Cost]

	Z1105CI
	Land Imp(PPE)[C]-Imp
	Land Improvement (PPE) [Cost]-Impairment

	Z1201A
	Building(IP)[A]
	Building (IP) [Admin]

	Z1201AI
	Building(IP)[A]-I
	Building (IP) [Admin]-Impairment

	Z1201C
	Building(IP)[C]
	Building (IP) [Cost]

	Z1201CI
	Building(IP)[C]-I
	Building (IP) [Cost]-Impairment

	Z1202A
	Building(PPE)[A]
	Building (PPE) [Admin]

	Z1202AI
	Building(PPE)[A]-I
	Building (PPE) [Admin]-Impairment

	Z1202C
	Building(PPE)[C]
	Building (PPE) [Cost]

	Z1202CI
	Building(PPE)[C]-I
	Building (PPE) [Cost]-Impairment

	Z1203A
	Bldg Imp(IP)[A]
	Building Improvement (IP) [Admin]

	Z1203AI
	Bldg Imp(IP)[A]-I
	Building Improvement (IP) [Admin]-Impairment

	Z1203C
	Bldg Imp(IP)[C]
	Building Improvement (IP) [Cost]

	Z1203CI
	Bldg Imp(IP)[C]-I
	Building Improvement (IP) [Cost]-Impairment

	Z1204A
	Bldg Imp(PPE)[A]
	Building Improvement (PPE) [Admin]

	Z1204AI
	Bldg Imp(PPE)[A]-I
	Building Improvement (PPE) [Admin]-Impairment

	Z1204C
	Bldg Imp(PPE)[C]
	Building Improvement (PPE) [Cost]

	Z1204CI
	Bldg Imp(PPE)[C]-I
	Building Improvement (PPE) [Cost]-Impairment

	Z1205A
	Renovation[A]
	Renovation [Admin]

	Z1205C
	Renovation[C]
	Renovation [Cost]

	Z1301C
	Golf Course Dev[C]
	Golf Course Development [Cost]

	Z1301CI
	Golf Course Dev[C]-I
	Golf Course Development [Cost]-Impairment

	Z2101C
	Machine-Roll Stck[C]
	Machine-Rolling Stock [Cost]

	Z2102C
	Machine [C]
	Machine [Cost]

	Z2201A
	Operating Equip[A]
	Operating Equipment [Admin]

	Z2201C
	Operating Equip[C]
	Operating Equipment [Cost]

	Z2301A
	Utility & Supply[A]
	Utility & Supply [Admin]

	Z2301C
	Utility & Supply[C]
	Utility & Supply [Cost]

	Z3101A
	Fur&Fix[A]
	Furniture & Fixtures [Admin]

	Z3101C
	Fur&Fix[C]
	Furniture & Fixtures [Cost]

	Z3201A
	Office Equipment[A]
	Office Equipment [Admin]

	Z3201C
	Office Equipment[C]
	Office Equipment [Cost]

	Z3301A
	Computer[A]
	Computer [Admin]

	Z3301C
	Computer[C]
	Computer [Cost]

	Z4101A
	Vehicle[A]
	Vehicle [Admin]

	Z4101C
	Vehicle[C]
	Vehicle [Cost]

	Z5101C
	Digital Ads[C]
	Digital Advertising [Cost]

	Z5201A
	Ads Equip[A]
	Advertising Equipment [Admin]

	Z5201C
	Ads Equip[C]
	Advertising Equipment [Cost]

	Z6101A
	ROU-Land[A]
	Right of Use Asset-Land [Admin]

	Z6101AI
	ROU-Land[A]-I
	Right of Use Asset-Land [Admin]-Impairment

	Z6101C
	ROU-Land[C]
	Right of Use Asset-Land [Cost]

	Z6101CI
	ROU-Land[C]-I
	Right of Use Asset-Land [Cost]-Impairment

	Z6102A
	ROU-Building[A]
	Right of Use Asset-Building [Admin]

	Z6102AI
	ROU-Building[A]-I
	Right of Use Asset-Building [Admin]-Impairment

	Z6102C
	ROU-Building[C]
	Right of Use Asset-Building [Cost]

	Z6102CI
	ROU-Building[C]-I
	Right of Use Asset-Building [Cost]-Impairment

	Z6103A
	ROU-Equipment[A]
	Right of Use Asset-Equipment [Admin]

	Z6103AI
	ROU-Equipment[A]-I
	Right of Use Asset-Equipment [Admin]-Impairment

	Z6103C
	ROU-Equipment[C]
	Right of Use Asset-Equipment [Cost]

	Z6103CI
	ROU-Equipment[C]-I
	Right of Use Asset-Equipment [Cost]-Impairment

	Z6104A
	ROU-Vehicle[A]
	Right of Use Asset-Vehicle [Admin]

	Z6104AI
	ROU-Vehicle[A]-I
	Right of Use Asset-Vehicle [Admin]-Impairment

	Z6104C
	ROU-Vehicle[C]
	Right of Use Asset-Vehicle [Cost]

	Z6104CI
	ROU-Vehicle[C]-I
	Right of Use Asset-Vehicle [Cost]-Impairment

	Z8101A
	Software&License[A]
	Software & License [Admin]

	Z8101C
	Software&License[C]
	Software & License [Cost]

	Z8102A
	Brand License[A]
	Brand License [Admin]

	Z8103A
	Not Used
	Not Used

	Z8104A
	Trademarks[A]
	Trademarks [Admin]

	Z8201C
	Right on Civil[C]
	Right on Civil to Government [Cost]

	Z8202A
	Right on Building[A]
	Right on Building to Government [Admin]

	Z8202C
	Right on Building[C]
	Right on Building to Government [Cost]

	Z8203C
	Right on E&M[C]
	Right on E&M to Government [Cost]

	Z8301A
	LH Right-Land[A]
	Leasehold Right-Land [Admin]

	Z8301C
	LH Right-Land[C]
	Leasehold Right-Land [Cost]

	Z8302A
	LH Right-Bldg[A]
	Leasehold Right-Building [Admin]

	Z8302C
	LH Right-Bldg[C]
	Leasehold Right-Building [Cost]

	Z8303A
	LH Right-Condo[A]
	Leasehold Right-Condo & Fixtures [Admin]

	Z8303C
	LH Right-Condo[C]
	Leasehold Right-Condo & Fixtures [Cost]

	Z9101
	AuC-IP
	AuC-Investment Property

	Z9102
	AuC-PPE
	AuC-Property, Plant and Equipment

	Z9103
	AuC-Intangible
	AuC-Intangible

	Z9201C
	Spare Parts await[C]
	Spare Parts awaiting Transfer [Cost]

	Z9701A
	LVA[A]
	Low Valued Asset (LVA) [Admin]

	Z9701C
	LVA[C]
	Low Valued Asset (LVA) [Cost]

	Z9801
	Dummy for Asset
	Dummy for Asset

	Z9901
	Asset for Consign
	Asset for Consignment



Key Fields Definitions
	Field Name
	Description

	Class
	Asset class ID

	Short Text 
	Asset class short description

	Asset Class Description
	Asset class description





Screen: Change View “Asset classes”: Details
[image: ]
Configure system as below table:
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	Asset Class
	Short Text
	Asset Class Description
	Account Determ.
	Scr.layout rule
	Base Unit
	Number Range
	External sub-no
	Include Asset
	No AuC
	Line item settlement
	Manage historically

	Z1101
	Land (IP)
	Land (IP)
	Z1101
	Z100
	EA
	1A
	
	
	X
	
	X

	Z1101I
	Land (IP)-Imp
	Land (IP)-Impairment
	Z1101I
	Z10I
	EA
	1A
	
	
	X
	
	X

	Z1102
	Land (PPE)
	Land (PPE)
	Z1102
	Z100
	EA
	1B
	
	
	X
	
	X

	Z1102I
	Land (PPE)-Imp
	Land (PPE)-Impairment
	Z1102I
	Z10I
	EA
	1B
	
	
	X
	
	X

	Z1103
	Land awaiting
	Land awaiting Development
	Z1103
	Z100
	EA
	1C
	
	
	X
	
	X

	Z1103I
	Land awaiting-Imp
	Land awaiting Development-Impairment
	Z1103I
	Z10I
	EA
	1C
	
	
	X
	
	X

	Z1104A
	Land Imp(IP)[A]
	Land Improvement (IP) [Admin]
	Z1104A
	Z100
	EA
	1J
	
	
	X
	
	X

	Z1104AI
	Land Imp(IP)[A]-Imp
	Land Improvement (IP) [Admin]-Impairment
	Z1104AI
	Z10I
	EA
	1J
	
	
	X
	
	X

	Z1104C
	Land Imp(IP)[C]
	Land Improvement (IP) [Cost]
	Z1104C
	Z100
	EA
	1J
	
	
	X
	
	X

	Z1104CI
	Land Imp(IP)[C]-Imp
	Land Improvement (IP) [Cost]-Impairment
	Z1104CI
	Z10I
	EA
	1J
	
	
	X
	
	X

	Z1105A
	Land Imp(PPE)[A]
	Land Improvement (PPE) [Admin]
	Z1105A
	Z100
	EA
	1K
	
	
	X
	
	X

	Z1105AI
	Land Imp(PPE)[A]-Imp
	Land Improvement (PPE) [Admin]-Impairment
	Z1105AI
	Z10I
	EA
	1K
	
	
	X
	
	X

	Z1105C
	Land Imp(PPE)[C]
	Land Improvement (PPE) [Cost]
	Z1105C
	Z100
	EA
	1K
	
	
	X
	
	X

	Z1105CI
	Land Imp(PPE)[C]-Imp
	Land Improvement (PPE) [Cost]-Impairment
	Z1105CI
	Z10I
	EA
	1K
	
	
	X
	
	X

	Z1201A
	Building(IP)[A]
	Building (IP) [Admin]
	Z1201A
	Z100
	EA
	1D
	
	
	X
	
	X

	Z1201AI
	Building(IP)[A]-I
	Building (IP) [Admin]-Impairment
	Z1201AI
	Z10I
	EA
	1D
	
	
	X
	
	X

	Z1201C
	Building(IP)[C]
	Building (IP) [Cost]
	Z1201C
	Z100
	EA
	1D
	
	
	X
	
	X

	Z1201CI
	Building(IP)[C]-I
	Building (IP) [Cost]-Impairment
	Z1201CI
	Z10I
	EA
	1D
	
	
	X
	
	X

	Z1202A
	Building(PPE)[A]
	Building (PPE) [Admin]
	Z1202A
	Z100
	EA
	1E
	
	
	X
	
	X

	Z1202AI
	Building(PPE)[A]-I
	Building (PPE) [Admin]-Impairment
	Z1202AI
	Z10I
	EA
	1E
	
	
	X
	
	X

	Z1202C
	Building(PPE)[C]
	Building (PPE) [Cost]
	Z1202C
		Z100
	EA
	1E
	
	
	X
	
	X

	Z1202CI
	Building(PPE)[C]-I
	Building (PPE) [Cost]-Impairment
	Z1202CI
	Z10I
	EA
	1E
	
	
	X
	
	X

	Z1203A
	Bldg Imp(IP)[A]
	Building Improvement (IP) [Admin]
	Z1203A
	Z100
	EA
	1F
	
	
	X
	
	X

	Z1203AI
	Bldg Imp(IP)[A]-I
	Building Improvement (IP) [Admin]-Impairment
	Z1203AI
	Z10I
	EA
	1F
	
	
	X
	
	X

	Z1203C
	Bldg Imp(IP)[C]
	Building Improvement (IP) [Cost]
	Z1203C
	Z100
	EA
	1F
	
	
	X
	
	X

	Z1203CI
	Bldg Imp(IP)[C]-I
	Building Improvement (IP) [Cost]-Impairment
	Z1203CI
	Z10I
	EA
	1F
	
	
	X
	
	X

	Z1204A
	Bldg Imp(PPE)[A]
	Building Improvement (PPE) [Admin]
	Z1204A
	Z100
	EA
	1G
	
	
	X
	
	X

	Z1204AI
	Bldg Imp(PPE)[A]-I
	Building Improvement (PPE) [Admin]-Impairment
	Z1204AI
	Z10I
	EA
	1G
	
	
	X
	
	X

	Z1204C
	Bldg Imp(PPE)[C]
	Building Improvement (PPE) [Cost]
	Z1204C
	Z100
	EA
	1G
	
	
	X
	
	X

	Z1204CI
	Bldg Imp(PPE)[C]-I
	Building Improvement (PPE) [Cost]-Impairment
	Z1204CI
	Z10I
	EA
	1G
	
	
	X
	
	X

	Z1205A
	Renovation[A]
	Renovation [Admin]
	Z1205A
	Z100
	EA
	1H
	
	
	X
	
	X

	Z1205C
	Renovation[C]
	Renovation [Cost]
	Z1205C
	Z100
	EA
	1H
	
	
	X
	
	X

	Z1301C
	Golf Course Dev[C]
	Golf Course Development [Cost]
	Z1301C
	Z100
	EA
	1I
	
	
	X
	
	X

	Z1301CI
	Golf Course Dev[C]-I
	Golf Course Development [Cost]-Impairment
	Z1301CI
	Z10I
	EA
	1I
	
	
	X
	
	X

	Z2101C
	Machine-Roll Stck[C]
	Machine-Rolling Stock [Cost]
	Z2101C
	Z200
	EA
	2A
	
	X
	X
	
	X

	Z2102C
	Machine [C]
	Machine [Cost]
	Z2102C
	Z200
	EA
	2B
	
	X
	X
	
	X

	Z2201A
	Operating Equip[A]
	Operating Equipment [Admin]
	Z2201A
	Z200
	EA
	2C
	
	X
	X
	
	X

	Z2201C
	Operating Equip[C]
	Operating Equipment [Cost]
	Z2201C
	Z200
	EA
	2C
	
	X
	X
	
	X

	Z2301A
	Utility & Supply[A]
	Utility & Supply [Admin]
	Z2301A
	Z200
	EA
	2D
	
	X
	X
	
	X

	Z2301C
	Utility & Supply[C]
	Utility & Supply [Cost]
	Z2301C
	Z200
	EA
	2D
	
	X
	X
	
	X

	Z3101A
	Fur&Fix[A]
	Furniture & Fixtures [Admin]
	Z3101A
	Z300
	EA
	3A
	
	X
	X
	
	X

	Z3101C
	Fur&Fix[C]
	Furniture & Fixtures [Cost]
	Z3101C
	Z300
	EA
	3A
	
	X
	X
	
	X

	Z3201A
	Office Equipment[A]
	Office Equipment [Admin]
	Z3201A
	Z300
	EA
	3B
	
	X
	X
	
	X

	Z3201C
	Office Equipment[C]
	Office Equipment [Cost]
	Z3201C
	Z300
	EA
	3B
	
	X
	X
	
	X

	Z3301A
	Computer[A]
	Computer [Admin]
	Z3301A
	Z300
	EA
	3C
	
	X
	X
	
	X

	Z3301C
	Computer[C]
	Computer [Cost]
	Z3301C
	Z300
	EA
	3C
	
	X
	X
	
	X

	Z4101A
	Vehicle[A]
	Vehicle [Admin]
	Z4101A
	Z400
	EA
	4A
	
	X
	X
	
	X

	Z4101C
	Vehicle[C]
	Vehicle [Cost]
	Z4101C
	Z400
	EA
	4A
	
	X
	X
	
	X

	Z5101C
	Digital Ads[C]
	Digital Advertising [Cost]
	Z5101C
	Z500
	EA
	5A
	
	X
	X
	
	X

	Z5201A
	Ads Equip[A]
	Advertising Equipment [Admin]
	Z5201A
	Z500
	EA
	5B
	
	X
	X
	
	X

	Z5201C
	Ads Equip[C]
	Advertising Equipment [Cost]
	Z5201C
	Z500
	EA
	5B
	
	X
	X
	
	X

	Z6101A
	ROU-Land[A]
	Right of Use Asset-Land [Admin]
	Z6101A
	Z600
	EA
	6A
	
	
	X
	
	X

	Z6101AI
	ROU-Land[A]-I
	Right of Use Asset-Land [Admin]-Impairment
	Z6101AI
	Z60I
	EA
	6A
	
	
	X
	
	X

	Z6101C
	ROU-Land[C]
	Right of Use Asset-Land [Cost]
	Z6101C
	Z600
	EA
	6A
	
	
	X
	
	X

	Z6101CI
	ROU-Land[C]-I
	Right of Use Asset-Land [Cost]-Impairment
	Z6101CI
	Z60I
	EA
	6A
	
	
	X
	
	X

	Z6102A
	ROU-Building[A]
	Right of Use Asset-Building [Admin]
	Z6102A
	Z600
	EA
	6B
	
	
	X
	
	X

	Z6102AI
	ROU-Building[A]-I
	Right of Use Asset-Building [Admin]-Impairment
	Z6102AI
	Z60I
	EA
	6B
	
	
	X
	
	X

	Z6102C
	ROU-Building[C]
	Right of Use Asset-Building [Cost]
	Z6102C
	Z600
	EA
	6B
	
	
	X
	
	X

	Z6102CI
	ROU-Building[C]-I
	Right of Use Asset-Building [Cost]-Impairment
	Z6102CI
	Z60I
	EA
	6B
	
	
	X
	
	X

	Z6103A
	ROU-Equipment[A]
	Right of Use Asset-Equipment [Admin]
	Z6103A
	Z600
	EA
	6C
	
	
	X
	
	X

	Z6103AI
	ROU-Equipment[A]-I
	Right of Use Asset-Equipment [Admin]-Impairment
	Z6103AI
	Z60I
	EA
	6C
	
	
	X
	
	X

	Z6103C
	ROU-Equipment[C]
	Right of Use Asset-Equipment [Cost]
	Z6103C
	Z600
	EA
	6C
	
	
	X
	
	X

	Z6103CI
	ROU-Equipment[C]-I
	Right of Use Asset-Equipment [Cost]-Impairment
	Z6103CI
	Z60I
	EA
	6C
	
	
	X
	
	X

	Z6104A
	ROU-Vehicle[A]
	Right of Use Asset-Vehicle [Admin]
	Z6104A
	Z600
	EA
	6D
	
	
	X
	
	X

	Z6104AI
	ROU-Vehicle[A]-I
	Right of Use Asset-Vehicle [Admin]-Impairment
	Z6104AI
	Z60I
	EA
	6D
	
	
	X
	
	X

	Z6104C
	ROU-Vehicle[C]
	Right of Use Asset-Vehicle [Cost]
	Z6104C
	Z600
	EA
	6D
	
	
	X
	
	X

	Z6104CI
	ROU-Vehicle[C]-I
	Right of Use Asset-Vehicle [Cost]-Impairment
	Z6104CI
	Z60I
	EA
	6D
	
	
	X
	
	X

	Z8101A
	Software&License[A]
	Software & License [Admin]
	Z8101A
	Z800
	EA
	8A
	
	
	X
	
	X

	Z8101C
	Software&License[C]
	Software & License [Cost]
	Z8101C
	Z800
	EA
	8A
	
	
	X
	
	X

	Z8102A
	Brand License[A]
	Brand License [Admin]
	Z8102A
	Z800
	EA
	8B
	
	
	X
	
	X

	Z8103A
	Not Used
	Not Used
	Z8103A
	Z800
	EA
	8C
	
	
	X
	
	X

	Z8104A
	Trademarks[A]
	Trademarks [Admin]
	Z8104A
	Z800
	EA
	8D
	
	
	X
	
	X

	Z8201C
	Right on Civil[C]
	Right on Civil to Government [Cost]
	Z8201C
	Z800
	EA
	8E
	
	
	X
	
	X

	Z8202A
	Right on Building[A]
	Right on Building to Government [Admin]
	Z8202A
	Z800
	EA
	8F
	
	
	X
	
	X

	Z8202C
	Right on Building[C]
	Right on Building to Government [Cost]
	Z8202C
	Z800
	EA
	8F
	
	
	X
	
	X

	Z8203C
	Right on E&M[C]
	Right on E&M to Government [Cost]
	Z8203C
	Z800
	EA
	8G
	
	
	X
	
	X

	Z8301A
	LH Right-Land[A]
	Leasehold Right-Land [Admin]
	Z8301A
	Z800
	EA
	8H
	
	
	X
	
	X

	Z8301C
	LH Right-Land[C]
	Leasehold Right-Land [Cost]
	Z8301C
	Z800
	EA
	8H
	
	
	X
	
	X

	Z8302A
	LH Right-Bldg[A]
	Leasehold Right-Building [Admin]
	Z8302A
	Z800
	EA
	8I
	
	
	X
	
	X

	Z8302C
	LH Right-Bldg[C]
	Leasehold Right-Building [Cost]
	Z8302C
	Z800
	EA
	8I
	
	
	X
	
	X

	Z8303A
	LH Right-Condo[A]
	Leasehold Right-Condo & Fixtures [Admin]
	Z8303A
	Z800
	EA
	8J
	
	
	X
	
	X

	Z8303C
	LH Right-Condo[C]
	Leasehold Right-Condo & Fixtures [Cost]
	Z8303C
	Z800
	EA
	8J
	
	
	X
	
	X

	Z9101
	AuC-IP
	AuC-Investment Property
	Z9101
	Z910
	
	9A
	
	
	
	X
	X

	Z9102
	AuC-PPE
	AuC-Property, Plant and Equipment
	Z9102
	Z910
	
	9B
	
	
	
	X
	X

	Z9103
	AuC-Intangible
	AuC-Intangible
	Z9103
	Z910
	
	9C
	
	
	
	X
	X

	Z9201C
	Spare Parts await[C]
	Spare Parts awaiting Transfer [Cost]
	Z9201C
	Z920
	EA
	9D
	
	X
	X
	
	X

	Z9701A
	LVA[A]
	Low Valued Asset (LVA) [Admin]
	Z9701A
	Z970
	EA
	9X
	
	X
	X
	
	X

	Z9701C
	LVA[C]
	Low Valued Asset (LVA) [Cost]
	Z9701C
	Z970
	EA
	9X
	
	X
	X
	
	X

	Z9801
	Dummy for Asset
	Dummy for Asset
	Z9801
	Z980
	EA
	9Y
	
	
	X
	
	X

	Z9901
	Asset for Consign
	Asset for Consignment
	Z9901
	Z990
	EA
	9Z
	
	X
	X
	
	X

	Z9902
	NVA
	Non Valued Asset (NVA)
	Z9902
	Z990
	EA
	9W
	
	X
	X
	
	X
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Key Fields Definitions
	Field Name
	Description

	Asset Class
	Asset class ID

	Short Text 
	Asset class short description

	Asset Class Description
	Asset class description

	Account Determ.
	Account determination ID

	Scr.layout rule
	Screen layout rule ID

	Base Unit
	Default unit of measurement

	Number Range
	Number range ID

	Include Asset
	Indicator specifies default value for including asset in inventory list (SAP standard physical counts report)

	No AuC or Summary Management of AuC
	Indicator specifies that this asset class is not asset under construction.

	Line item settlement
	Indicator specifies that this asset class is asset under construction which is managed with the option for final line item settlement to receiving assets or cost centers.

	Manage historically
	Indicator specifies default value for managing historically (SAP standard asset history report)





2 [bookmark: _Toc107404503]Integration with General Ledger Accounting
2.1 [bookmark: _Toc107404504]Assign GL Accounts

	Script Description
	Assign GL accounts in account determination for asset posting

	Objective
	To specify the balance sheet accounts, special reserve accounts, and the depreciation accounts for asset accounting.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Assign G/L Accounts

	Transaction Code
	AO90

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Specify Account Determination

	Remark
	N/A



Screen: Change View “Chart of Accounts”: Overview
[image: ]
Select Chart of Depreciation, then double click on ‘Account Determination’



Screen: Change View “Account Determination”: Overview
[image: ]
Select Account Determination, then double click on ‘Balance Sheet Accounts’

Screen: Change View “Balance Sheet Accounts”: Overview
[image: ]
Double click on each Depreciation Area to maintain values.



Screen: Change View “Balance Sheet Accounts”: Details
[image: ]
Configure system as below table:
Account Determination for Fusion 1 Project is configured as listed in Appendix 01: Assign GL Accounts for Account Determination. 
Example:

[image: ]CN Asset Accounting (AA)

	[image: D:\work\BTS\Template\IAM.png]
	25/225
	Version: 



	Account Determ.
	Deprec. area
	Bal.Sh.Acct APC
	Loss Made on Asset Retirement w/o Reven.
	Clearing Acct. Revenue from Asset Sale:
	Gain from Asset Sale
	Loss from Asset Sale
	Cost elem. for settlmt AuC to CO objects
	Capital. difference/Non-operatng expense

	Z1101
	1
	1950001010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	
	2
	1950001010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	
	3
	1950001010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	Z3101A
	1
	1950112010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	
	2
	1950112010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	
	3
	1950112010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	Z3101C
	1
	1950112010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	
	2
	1950112010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	
	3
	1950112010
	6150099750
	1999999080
	4199924010
	4199924010
	
	

	Z6101A
	1
	1960001010
	6150099750
	1999999080
	4199924010
	4199924010
	
	1999923020

	
	2
	1960001010
	6150099750
	1999999080
	4199924010
	4199924010
	
	1999923020

	
	3
	1960001010
	6150099750
	1999999080
	4199924010
	4199924010
	
	1999923020

	Z9701A
	1
	1959999010
	6150099750
	
	
	
	
	

	
	2
	1959999010
	6150099750
	
	
	
	
	

	
	3
	1959999010
	6150099750
	
	
	
	
	

	Z9102
	1
	1959999030
	6150099750
	1999999080
	4199924010
	4199924010
	6150099960
	

	
	2
	1959999030
	6150099750
	1999999080
	4199924010
	4199924010
	6150099960
	

	
	3
	1959999030
	6150099750
	1999999080
	4199924010
	4199924010
	6150099960
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Key Fields Definitions
	Field Name
	Description

	Account Determ.
	Account determination ID

	Deprec. area
	Depreciation area ID

	Bal.Sh.Acct APC
	GL account number for asset acquisition cost

	Loss Made on Asset Retirement w/o Reven.
	GL account number for loss from asset write-off

	Clearing Acct. Revenue from Asset Sale:
	GL account number for clearing net revenue from asset sales 

	Gain from Asset Sale
	GL account number for gain from asset sales

	Loss from Asset Sale
	GL account number for loss from asset sales

	Cost elem. for settlmt AuC to CO objects
	GL account number (cost element) for settlement AuC to CO object in case on not settle to fixed asset

	Capital. difference/Non-operatng expense
	GL account number for different capitalization cost from depreciation area 01 (accounting book)
Remark: to post capitalization cost in depreciation area 02 (tax book) for ROU



Screen: Change View “Account Determination”: Overview
[image: ]
Select Account Determination, then double click on ‘Depreciation’



Screen: Change View “Depreciation”: Overview
[image: ]
Double click on each Depreciation Area to maintain values.

Screen: Change View “Depreciation”: Details
[image: ]
Configure system as below table:
Account Determination for Fusion 1 Project is configured as listed in Appendix 01: Assign GL Accounts for Account Determination. 


Example:
	Account Determ.
	Deprec. area
	Acc.dep. accnt.for ordinary depreciation
	Expense account for ordinary depreciat.

	Z1101
	1
	
	

	
	2
	
	

	
	3
	
	

	Z3101A
	1
	1950112020
	6161019010

	
	2
	1950112020
	6161019010

	
	3
	1950112020
	6161019010

	Z3101C
	1
	1950112020
	5161019010

	
	2
	1950112020
	5161019010

	
	3
	1950112020
	5161019010

	Z6101A
	1
	1960001020
	6162010010

	
	2
	1960001020
	6162010010

	
	3
	1960001020
	6162010010

	Z9701A
	1
	1959999030
	6150099700

	
	2
	1959999030
	6150099700

	
	3
	1959999030
	6150099700

	Z9102
	1
	
	

	
	2
	
	

	
	3
	
	



Key Fields Definitions
	Field Name
	Description

	Account Determ.
	Account determination ID

	Deprec. area
	Depreciation area ID

	Acc.dep. accnt.for ordinary depreciation
	GL account number for accumulated depreciation

	Expense account for ordinary depreciat.
	GL account number for depreciation expenses




2.2 [bookmark: _Toc107404505]Define Technical Clearing Account for Integrated Asset Acquisition

	Script Description
	Define technical clearing account for integrated asset acquisition posting

	Objective
	For an integrated asset acquisition posting, the system divides the business transaction into an operational part and a valuating part:
· For the operational part (vendor invoice), the system posts a document valid for all accounting principles against the technical clearing account for integrated asset acquisitions. From a technical perspective, the system generates a ledger-group-independent document.
· For each valuating part (asset posting with capitalization of the asset), the system generates a separate document that is valid only for the given accounting principle. This document is also posted against the technical clearing account for integrated asset acquisitions. From a technical perspective, the system generates ledger-group-specific documents for each accounting principle.
In this way, the system ensures that the technical clearing account for integrated asset acquisitions has a balance of zero (for each accounting principle and account assignment object) for every accounting principle in the chart of depreciation. So that the system can ensure the zero balance, manual postings cannot be made to the account.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Technical Clearing Account for Integrated Asset Acquisition -> Define Technical Clearing Account for Integrated Asset Acquisition

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Technical Clearing Account for Integrated Acquisition”: Overview
[image: ]
Configure system as below table:
	ChAc
	Account

	1000
	1999999090



Remark: For Fusion 1 Project (Wave 1), technical clearing account for asset acquisition is 1999999090 (Technical Clearing Account)

Key Fields Definitions
	Field Name
	Description

	ChAc.
	Chart of accounts ID

	Account
	GL account number for technical clearing account


2.3 [bookmark: _Toc107404506]Additional Accounts for Asset Accounting
2.3.1 [bookmark: _Toc107404507]Assign the Additional Accounts for Asset Accounting

	Script Description
	Assign the additional GL account for asset retirement by donation

	Objective
	To assign additional GL account by creating new account modification with target GL account.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Specify Posting Key for Asset Posting

	Transaction Code
	OBYD

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Configuration Accounting Maintain : Automatic Posts - Procedures
[image: ]
Double click on Procedure: ANC - Additional accounts for Asset Accounting

Screen: Configuration Accounting Maintain : Automatic Posts - Accounts
[image: ]
Configure system as below table:
	General modification
	Account

	DONA
	6150037010



Remark: For Fusion 1 Project (Wave 1), GL account for additional account modification: DONA (Donation) is 6150037010 (Donation Expense) used for posting retirement by donation
Key Fields Definitions
	Field Name
	Description

	General modification
	Account modification ID to assign additional GL account for automatic posting in asset accounting. These accounts have not to be reconciliation accounts.

	Account
	GL account number for target account



2.3.2 [bookmark: _Toc107404508]Define New Posting Schema

	Script Description
	Define new posting schema for asset retirement by donation

	Objective
	To define new posting schema for retirement by donation by copying from nearby posting schema (SAP standard).

	Initial Menu Path
	N/A

	Transaction Code
	SE38

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Assign the Additional Accounts for Asset Posting

	Remark
	Copy posting schema from ‘TH_200_007’ to ‘ZTH_200_007’



Screen: ABAP Editor: Initial Screen
[image: ]
Enter program: RAVCBUZSM (FI-AA: Call of view cluster VC_TA1MZ01 for maint. of SAP ln.itm schema), then click on execute button.


Screen: Change View “Line item schema”: Overview
[image: ]
Configure system by copying posting schema from ‘TH_200_007’ to ‘ZTH_200_007’ (Asset retirement by donation):
Remark: Posting Schema that start with Z is additional customizing for Fusion 1 Project and the rest is SAP standard provided.
Select Line Item Schema, then double click on ‘Characteristic Values’

Screen: Change View “Characteristic values”: Overview
[image: ]


Configure system as below table:
	Seq. No.
	Line
	Account
	Description
	Amount
	Amount

	90
	3
	DONA 
	Standard account____
	15
	Net book value



Key Fields Definitions
	Field Name
	Description

	Seq. No.
	Sequence number running after current number

	Line
	Line item number

	Account
	Account modification ID

	Description
	Account modification description

	Amount
	Symbolic amount ID for which amount to be posted in this line item. In this case, specify ‘15’ for Net book value amount

	Amount
	Symbolic amount description



2.3.3 [bookmark: _Toc107404509]Assign the New Posting Schemas to Transaction Types

	Script Description
	Assign the new posting schema to asset transaction type

	Objective
	To assign posting schema to asset transaction type which created separately for retirement by donation

	Initial Menu Path
	N/A

	Transaction Code
	SM34

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	· Define Transaction Types for Retirements 
· Define New Posting Schema

	Remark
	Define new asset transaction types separately for retirement by donation





Screen: View Cluster Editing: Initial Screen
[image: ]
Enter View Cluster: VC_T093H01 (Assignment to line item schema), then click on [image: ]

Screen: Display View “Country”: Overview
[image: ]
Select Country ‘TH’, then double click on ‘Assignment to line item schema’ 


Screen: Change View “Assignment to line item schema”: Overview
[image: ]
Configure system as below table:
	Crs-Sys.Ar
	Short description
	Tra
	Transaction Type Name
	Line Item Schema
	Text

	*
	
	20D
	Retirement by Donation
	ZTH_200_007
	Asset retirement by donation

	*
	
	25D
	Retirement by Donation for current-year acquis.
	ZTH_200_007
	Asset retirement by donation



Key Fields Definitions
	Field Name
	Description

	Crs-Sys.Ar
	Cross-system depreciation area has the same function and significance in all charts of depreciation. Normally it is not necessary to define cross-system depreciation areas.

	Short description
	Cross-system depreciation area ID

	Tra
	Asset transaction type ID

	Transaction Type Name
	Asset transaction type description

	Line Item Schema
	Line item schema ID

	Text
	Line item schema description





2.4 [bookmark: _Toc107404510]Post Depreciation to General Ledger Accounting
2.4.1 [bookmark: _Toc107404511]Specify Document Type for Posting of Depreciation

	Script Description
	Specify document type for depreciation posting

	Objective
	To determine the document type for each company code for depreciation posting.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Post Depreciation to General Ledger Accounting -> Specify Document Type for Posting of Depreciation -> Specify Document Type for Posting of Depreciation

	Transaction Code
	AO71

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A 



Screen: Change View “FI-AA: Document Type for Posting Depreciation”: Overview
[image: ]
Configure system as below table:
	CoCode
	Company Name
	Doc.Type
	Description

	1010
	BTSG
	AF
	Depreciation Posting

	1020
	Yongsu
	AF
	Depreciation Posting

	2010
	BTSC
	AF
	Depreciation Posting

	2020
	BIS
	AF
	Depreciation Posting

	2030
	NBM
	AF
	Depreciation Posting

	2040
	EBM
	AF
	Depreciation Posting

	2050
	BID
	AF
	Depreciation Posting

	3010
	VGI
	AF
	Depreciation Posting

	3020
	888
	AF
	Depreciation Posting

	3030
	VGI Advertising Media
	AF
	Depreciation Posting

	3040
	POV
	AF
	Depreciation Posting

	5010
	DNAL
	AF
	Depreciation Posting

	5020
	The Community One
	AF
	Depreciation Posting

	5030
	The Community Two
	AF
	Depreciation Posting

	5040
	Kingkaew Assets
	AF
	Depreciation Posting

	5050
	Mochit Land
	AF
	Depreciation Posting

	5060
	CAPRICORN HILL
	AF
	Depreciation Posting

	5300
	U City
	AF
	Depreciation Posting

	5310
	U Global
	AF
	Depreciation Posting

	5320
	TANAYONG HONG KONG
	AF
	Depreciation Posting

	5500
	EGS ASSETS
	AF
	Depreciation Posting

	5510
	Muangthong Assets
	AF
	Depreciation Posting

	5520
	Nine Square Property
	AF
	Depreciation Posting

	5530
	MAK8
	AF
	Depreciation Posting

	5540
	BTS Land
	AF
	Depreciation Posting

	5550
	Rong Pasee Roi Chak Sam
	AF
	Depreciation Posting

	5560
	KHONKAENBURI
	AF
	Depreciation Posting

	5610
	BOONBARAMEE METTA
	AF
	Depreciation Posting

	5620
	Pacific Hotel Chiangmai
	AF
	Depreciation Posting

	5630
	Pacific Chiangmai Co.,Ltd
	AF
	Depreciation Posting

	5800
	UNISON One
	AF
	Depreciation Posting

	5810
	Kamkoong Property
	AF
	Depreciation Posting

	5840
	Prime Area Retail
	AF
	Depreciation Posting

	5850
	U Remix
	AF
	Depreciation Posting

	5900
	TANAYONG PROPERTY
	AF
	Depreciation Posting

	5910
	Thana City Golf
	AF
	Depreciation Posting

	6200
	PROJECT GREEN
	AF
	Depreciation Posting

	6210
	SIAM PAGING
	AF
	Depreciation Posting

	6220
	TANAYONG FOOD & BEVERAGE
	AF
	Depreciation Posting

	6230
	PrannaKiri Assets
	AF
	Depreciation Posting

	6240
	Ratburana Property
	AF
	Depreciation Posting

	6250
	NPARK GLOBAL
	AF
	Depreciation Posting

	6260
	Phraram 9 Alliance
	AF
	Depreciation Posting

	6270
	Prime Area 12
	AF
	Depreciation Posting

	7010
	Prime Area 38
	AF
	Depreciation Posting

	7500
	KEYSTONE ESTATE
	AF
	Depreciation Posting

	7510
	Keystone Management
	AF
	Depreciation Posting

	7900
	Rabbit Life Insurance
	AF
	Depreciation Posting

	8020
	RR
	AF
	Depreciation Posting

	8030
	BPS
	AF
	Depreciation Posting

	8040
	BSSH
	AF
	Depreciation Posting

	8050
	RPS
	AF
	Depreciation Posting

	8090
	RBS
	AF
	Depreciation Posting

	8100
	RCASH
	AF
	Depreciation Posting

	8200
	HHT
	AF
	Depreciation Posting

	8300
	T23
	AF
	Depreciation Posting

	8310
	T1
	AF
	Depreciation Posting

	8330
	T3
	AF
	Depreciation Posting

	8340
	T4
	AF
	Depreciation Posting

	8350
	T5
	AF
	Depreciation Posting

	8360
	T6
	AF
	Depreciation Posting

	8370
	T7
	AF
	Depreciation Posting

	8380
	T8
	AF
	Depreciation Posting

	8390
	T9
	AF
	Depreciation Posting

	8400
	T10
	AF
	Depreciation Posting






Key Fields Definitions
	Field Name
	Description

	CoCode
	Company code ID

	Company Name
	Company code description

	Doc.Type
	Document type ID

	Description
	Document type description



2.4.2 [bookmark: _Toc107404512]Specify Intervals and Posting Rules

	Script Description
	Specify interval and posting rule for depreciation posting

	Objective
	To define the posting cycle for the depreciation areas that post depreciation values to Financial Accounting (how often depreciation is posted). 

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Post Depreciation to General Ledger Accounting -> Specify Intervals and Posting Rules

	Transaction Code
	OAYR

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Company code selection”: Overview
[image: ]
Select Company Code, then double click on ‘Posting rules’

Screen: Change View “Posting rules”: Overview
[image: ]
Double click on each Depreciation Area to maintain values.



Screen: Change View “Posting rules”: Details
[image: ]
Configure system as below table:
Account Assignment Objects for Fusion 1 Project is configured as listed in Appendix 02: Specify Interval and Posting Rules for Depreciation Posting. 
Example:
	Company Code
	Depreciat. Area
	Period and Method

	1010
	01
	Monthly posting

	
	02
	Monthly posting

	
	03
	Monthly posting

	2010
	01
	Monthly posting

	
	02
	Monthly posting

	
	03
	Monthly posting

	3010
	01
	Monthly posting

	
	02
	Monthly posting

	
	03
	Monthly posting

	5300
	01
	Monthly posting

	
	02
	Monthly posting

	
	03
	Monthly posting

	8100
	01
	Monthly posting

	
	02
	Monthly posting

	
	03
	Monthly posting

	8200
	01
	Monthly posting

	
	02
	Monthly posting

	
	03
	Monthly posting



Key Fields Definitions
	Field Name
	Description

	CoCode
	Company code ID

	Depreciat. Area
	Depreciation area ID

	Period and Method
	Posting period cycle for depreciation posting


2.5 [bookmark: _Toc107404513]Additional Account Assignment Objects
2.5.1 [bookmark: _Toc107404514]Activate Account Assignment Objects

	Script Description
	Activate account assignment objects for asset posting

	Objective
	To make settings for additional account assignment objects (for example, cost center, WBS element) during posting in Asset Accounting by following steps:
1. Activate the account assignment objects for Asset Accounting.
2. Specify whether the account assignment object is relevant to the balance sheet. Account assignment objects that are relevant to the balance sheet can no longer be changed directly in the asset master data once the asset has been capitalized. Instead, such assets have to be transferred to a new asset master data to make this change.
3. Specify whether the account assignment object entered when posting has to agree with the account assignment object entered in the asset master data.


	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Additional Account Assignment Objects -> Activate Account Assignment Objects

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Account Assignment Elements for Asset Accounting”: Overview
[image: ]
Configure system as below table:
	AcctAsgnOb
	Account Assignment Object Name
	Active
	Bal.Sheet
	Agreement

	KOSTL
	Cost Center
	X
	
	

	PS_PSP_PNR
	WBS Element of Investment Project
	X
	
	

	PS_PSP_PNR2
	WBS Element
	X
	
	



Key Fields Definitions
	Field Name
	Description

	AcctAsgnOb
	Account assignment object ID provided by SAP standard

	Account Assignment Object Name
	Account assignment object description

	Active
	Indicator specifies that this account assignment object is activated

	Bal.Sheet
	Indicator specifies that the account assignment object is relevant to the balance sheet.

	Agreement
	If this indicator is set, you cannot change the account assignment object when posting. It has to be aligned with the object in asset master data.




2.5.2 [bookmark: _Toc107404515]Specify Account Assignment Types for Account Assignment Objects

	Script Description
	Specify account assignment types for account assignment objects 

	Objective
	To assign account assignment type to account assignment object. The possible account assignment types for account assignment objects are: asset cost (balance sheet) posting or depreciation expense (p&l account). These assignments are dependent on
· Company code
· Depreciation area
· Transaction type
If you want to assign both account assignment types to an account assignment object, you have to make at least two entries for the account assignment object.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Additional Account Assignment Objects -> Specify Account Assignment Types for Account Assignment Objects

	Transaction Code
	ACSET

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Activate Account Assignment Objects

	Remark
	N/A



Screen: Change View “Company Code”: Overview
[image: ]
Select Company Code, then double click on ‘Depreciation Area’



Screen: Change View “Depreciation Area”: Overview
[image: ]
Select Depreciation Area, then double click on ‘Account Assignment Object’

Screen: Change View “Account Assignment Objects”: Overview
[image: ]
Configure system as below table:
Account Assignment Objects for Fusion 1 Project is configured as listed in Appendix 03: Specify Account Assignment Types for Account Assignment Objects. 
[image: ]CN Asset Accounting (AA)
Example:
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	Company Code
	Depreciat. Area
	AcctAsgnOb
	Acct Assgnmt Obj. Name
	Tra
	Transact. Type Text
	Account Assignment Type
	AcctAssgnt

	1010
	1
	KOSTL
	Cost Center
	*
	Generic Trans. Type
	01 APC Values Posting
	X

	
	
	KOSTL
	Cost Center
	*
	Generic Trans. Type
	02 Depreciation Run
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	250
	Retirement of current-yr acquis., w/o revenue
	01 APC Values Posting
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	320
	Retirmt transfer of curr-yr acquis.
	01 APC Values Posting
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	330
	Acquiring transfer of curr-yr acquis.
	01 APC Values Posting
	X

	
	2
	KOSTL
	Cost Center
	*
	Generic Trans. Type
	01 APC Values Posting
	X

	
	
	KOSTL
	Cost Center
	*
	Generic Trans. Type
	02 Depreciation Run
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	250
	Retirement of current-yr acquis., w/o revenue
	01 APC Values Posting
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	320
	Retirmt transfer of curr-yr acquis.
	01 APC Values Posting
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	330
	Acquiring transfer of curr-yr acquis.
	01 APC Values Posting
	X

	
	3
	KOSTL
	Cost Center
	*
	Generic Trans. Type
	01 APC Values Posting
	X

	
	
	KOSTL
	Cost Center
	*
	Generic Trans. Type
	02 Depreciation Run
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	250
	Retirement of current-yr acquis., w/o revenue
	01 APC Values Posting
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	320
	Retirmt transfer of curr-yr acquis.
	01 APC Values Posting
	X

	
	
	PS_PSP_PNR
	WBS Element of Investment Project
	330
	Acquiring transfer of curr-yr acquis.
	01 APC Values Posting
	X
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Key Fields Definitions
	Field Name
	Description

	Company Code
	Company code ID

	Depreciat. Area
	Depreciation area ID

	AcctAsgnOb
	Account assignment object ID provided by SAP standard

	Acct Assgnmt Obj. Name
	Account assignment object description

	Tra
	Asset transaction type ID. In case of assignment to all asset transaction types, specify ‘*’ for all generic transaction type.

	Transact. Type Text
	Asset transaction type description

	Account Assignment Type
	Account assignment type ID which describes the type of account assignment for an account assignment object. There are 2 account assignment types:
· 01 - Periodic posting (all values other than depreciation)
· 02 - Depreciation posting


	AcctAssgnt
	Indicator specifies that account assignment to the given account assignment object is active. If this indicator is set, the posted values to be updated on the account assignment object. 




3 [bookmark: _Toc107404516]General Valuation
3.1 [bookmark: _Toc107404517]Set Chart of Depreciation

	Script Description
	Set chart of depreciation to work out

	Objective
	This step is required for the organization with more than one chart of depreciation created. If you have created only one chart of depreciation, the system automatically uses this chart.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Set Chart of Depreciation

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Copy Reference Chart of Depreciation

	Remark
	For Fusion 1 Project, there is only one chart of depreciation. Thus, this step is not necessary.



Screen: Chart of Depreciation Selection
[image: ]
Enter Chart of Depreciation ID to be worked out.


3.2 [bookmark: _Toc107404518]Depreciation Areas
3.2.1 [bookmark: _Toc107404519]Define Depreciation Areas

	Script Description
	Define depreciation area for chart of depreciation and specify how each depreciation area posts to general ledger

	Objective
	To define the depreciation areas under chart of depreciation that post their acquisition transactions and/or depreciation to the general ledger. In addition, you can specify how each depreciation area posts to general ledger.
The system posts the acquisition transactions of the depreciation areas to the general ledger online automatically. You always have to use periodic processing to post depreciation to the general ledger.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Integration with General Ledger Accounting -> Define How Depreciation Areas Post to General Ledger

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Define Depreciation Areas”: Overview
[image: ]


Configure system as below table
	Ar.
	Name of Depreciation Area
	Real
	Trgt Group
	Acc. Princ.
	G/L

	1
	Accounting Depreciation
	X
	L1
	LACC
	1 Area Posts in Real Time

	2
	Tax Depreciation
	X
	L2
	LTAX
	1 Area Posts in Real Time

	3
	Different Fiscal Year Depreciation
	X
	LZ
	LYDF
	1 Area Posts in Real Time

	91
	Accounting Depreciation (Group Currency)
	X
	L1
	LACC
	0 Area Does Not Post

	92
	Tax Depreciation (Group Currency)
	X
	L2
	LTAX
	0 Area Does Not Post

	93
	Different Fiscal Year Depreciation (Group Currency)
	X
	LZ
	LYDF
	0 Area Does Not Post



Key Fields Definitions
	Field Name
	Description

	Ar.
	Depreciation area ID

	Name of Depreciation Area 
	Depreciation area description

	Real
	Indicator specifies the system to store the values of this depreciation area in the database. The values in this area are then updated each time a posting is made, and can be immediately evaluated.

	Trgt Group
	Ledger group ID in general ledger accounting to be posted

	Acc.Princ.
	Accounting principle ID which is the designation for the legal regulations according to which financial statements are drawn up and rendered. The characteristic accounting principle serves to simplify depiction of parallel accounting in the system.

	G/L
	Specifies how acquisition cost values and/or depreciation from this depreciation area are to be posted to the general ledger. There are 4 options provided by SAP standard as below:
· 0 – Area Does Not Post:
The system posts neither acquisition and production costs (APC) nor depreciation to the general ledger.
You use this setting, for example, for depreciation areas with parallel currencies.

· 1 – Aera Posts in Real Time:
The system posts both APC and depreciation to the general ledger for the depreciation area. APC is posted in real time. Depreciation is posted periodically. The posting document for the depreciation is posted for each asset in Financial Accounting.




· 3 – Area Posts Depreciation Only:
The system posts depreciation only on a periodic basis. APC is not posted. The posting document for the depreciation is posted for each asset in Financial Accounting.

· 4 – Area Posts APC Immediately and Depreciation:
The system posts both APC and depreciation to the general ledger for the depreciation area. APC is posted in real time. Depreciation is posted periodically. The posting document for the depreciation is posted for each asset in Financial Accounting.
This option is therefore equivalent to the Area Posts in Realtime option.




Screen: Change View “Define Depreciation Areas”: Details
[image: ]
Configure system as below table
	Depreciat. Area
	Short Text
	Acquisition Value
	Net Book Value
	Ordinary Depreciation

	1
	Accounting 
	* All Values Allowed
	* All Values Allowed
	* All Values Allowed

	2
	Tax
	* All Values Allowed
	* All Values Allowed
	* All Values Allowed

	3
	Diff.FY
	* All Values Allowed
	* All Values Allowed
	* All Values Allowed

	91
	Accounting-G
	* All Values Allowed
	* All Values Allowed
	* All Values Allowed

	92
	Tax-G
	* All Values Allowed
	* All Values Allowed
	* All Values Allowed

	93
	Diff.FY-G
	* All Values Allowed
	* All Values Allowed
	* All Values Allowed




Key Fields Definitions
	Field Name
	Description

	Depreciat. Area
	Depreciation area ID

	Short Text
	Depreciation area short description

	Acquisition Value
	Specify whether the real acquisition value in this depreciation area should have a positive or negative balance. There are 4 options provided by SAP standard as below:
· * - All Values Allowed
· + - Only Positive Values or Zero Allowed
· - - Only Negative Values or Zero Allowed
· + - No Values Allowed


	Net Book Value
	Specify whether the net book value in this depreciation area is always either positive or negative (or in both cases, also zero). There are 4 options provided by SAP standard as below:
· * - All Values Allowed
· + - Only Positive Values or Zero Allowed
· - - Only Negative Values or Zero Allowed
· + - No Values Allowed


	Ordinary Depreciation
	Specify whether ordinary depreciation in this depreciation area is always either positive or negative (or in both cases, also zero). There are 4 options provided by SAP standard as below:
· * - All Values Allowed
· + - Only Positive Values or Zero Allowed
· - - Only Negative Values or Zero Allowed
· ‘ ’ - No Values Allowed



3.2.2 [bookmark: _Toc107404520]Define Depreciation Area for Quantity Update

	Script Description
	Define depreciation area for updating quantity

	Objective
	To specify which depreciation area you want to use for updating quantities. The quantities in the asset master data are only updated if postings are made to the area specified here.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Depreciation Areas -> Define Depreciation Area for Quantity Update

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Setting Depreciation Area for Quantity Update”: Overview
[image: ]
Configure system as below table:
	Area
	Update Quantity
	Name of Depreciation Area

	1
	X
	Accounting Depreciation

	2
	
	Tax Depreciation

	3
	
	Different Fiscal Year Depreciation



Key Fields Definitions
	Field Name
	Description

	Area
	Depreciation area ID

	Update Quantity
	Indicator specifies that depreciation area is relevant for quantity update

	Name of Depreciation Area
	Depreciation area description




3.2.3 [bookmark: _Toc107404521]Specify Transfer of APC Values

	Script Description
	Specify transfer rules for acquisition values takeover

	Objective
	To define transfer rules for the acquisition cost values of depreciation areas. These transfer rules let you ensure that certain depreciation areas have identical asset values by specifying the reference depreciation area that provides values to another depreciation area. The system transfers the posting amounts of any transactions that affect acquisition costs from this area to the dependent area.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Depreciation Areas -> Specify Transfer of APC Values

	Transaction Code
	OABC

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Depreciation areas: Rules for value takeover”: Overview
[image: ]
Configure system as below table:


	Area
	Name of Depreciation Area
	ValAd
	Ident.

	01
	Accounting Depreciation
	00
	

	02
	Tax Depreciation
	00
	

	03
	Different Fiscal Year Depreciation
	00
	

	91
	Accounting Depreciation (Group Currency)
	01
	X

	92
	Tax Depreciation (Group Currency)
	02
	X

	93
	Different Fiscal Year Depreciation(Group Currency)
	03
	X



Key Fields Definitions
	Field Name
	Description

	Area
	Depreciation area ID

	Name of Depreciation Area
	Depreciation area description

	ValAd
	Depreciation area ID from which acquisition cost values are adopted

	Ident.
	Indicator specifies that adopted acquisition cost values are identical to the reference depreciation area.


3.2.4 [bookmark: _Toc107404522]Specify Transfer of Depreciation Terms

	Script Description
	Specify transfer rules for depreciation values takeover

	Objective
	To define transfer rules for the depreciation values of depreciation areas. These transfer rules let you ensure that certain depreciation areas have identical asset values by specifying the reference depreciation area that provides values to another depreciation area. The system transfers the posting amounts of any transactions that affect depreciation from this area to the dependent area.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Depreciation Areas -> Specify Transfer of Depreciation Terms

	Transaction Code
	OABD

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Depreciation areas: Rules for takeover of deprec. terms”: Overview
[image: ]
Configure system as below table:
	Ar.
	Name of Depreciation Area
	TTr
	Identical

	01
	Accounting Depreciation
	00
	

	02
	Tax Depreciation
	00
	

	03
	Different Fiscal Year Depreciation
	00
	

	91
	Accounting Depreciation (Group Currency)
	01
	X

	92
	Tax Depreciation (Group Currency)
	02
	X

	93
	Different Fiscal Year Depreciation(Group Currency)
	03
	X



Key Fields Definitions
	Field Name
	Description

	Ar.
	Depreciation area ID

	Name of Depreciation Area
	Depreciation area description

	TTr
	Depreciation area ID from which depreciation values are adopted

	Identical
	Indicator specifies that adopted depreciation values are identical to the reference depreciation area.





3.3 [bookmark: _Toc107404523]Determine Depreciation Areas in the Asset Class

	Script Description
	Determine default values of depreciation areas for asset class 

	Objective
	To determine the depreciation terms that are to be used in the asset class. Depending on the definition in the screen layout control used, these depreciation terms are offered either as optional or mandatory defaults when creating asset master data.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Determine Depreciation Areas in the Asset Class

	Transaction Code
	OAYZ

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Define Screen Layout for Asset Depreciation Areas

	Remark
	N/A



Screen: Change View “Asset class”: Overview
[image: ]
Select Asset Class, then double click on 'Depreciation areas’



Screen: Change View “Depreciation areas”: Overview
[image: ]
Configure system as below table:
Determination of depreciation area in asset class for Fusion 1 Project is configured as listed in Appendix 04: Determine Depreciation Area in the Asset Class. 
Example:
	Chart of dep.
	Asset Class
	Ar.
	Dep. Area
	Deact
	DepKy
	Use
	Per
	Layou

	1000
	Z1101
	01
	Accounting
	
	0000
	
	
	Z003

	
	
	02
	Tax
	
	0000
	
	
	Z003

	
	
	03
	Diff.FY
	
	0000
	
	
	Z003

	
	
	91
	Accounting-G
	
	0000
	
	
	Z003

	
	
	92
	Tax-G
	
	0000
	
	
	Z003

	
	
	93
	Diff.FY-G
	
	0000
	
	
	Z003

	
	Z1101I
	01
	Accounting
	
	0000
	
	
	Z003

	
	
	02
	Tax
	X
	0000
	
	
	

	
	
	03
	Diff.FY
	
	0000
	
	
	Z003

	
	
	91
	Accounting-G
	
	0000
	
	
	Z003

	
	
	92
	Tax-G
	X
	0000
	
	
	

	
	
	93
	Diff.FY-G
	
	0000
	
	
	Z003

	
	Z3101A
	01
	Accounting
	
	TH02
	5
	
	Z002

	
	
	02
	Tax
	
	TH02
	5
	
	Z002

	
	
	03
	Diff.FY
	
	TH02
	5
	
	Z002

	
	
	91
	Accounting-G
	
	TH02
	5
	
	Z002

	
	
	92
	Tax-G
	
	TH02
	5
	
	Z002

	
	
	93
	Diff.FY-G
	
	TH02
	5
	
	Z002

	
	Z9701A
	01
	Accounting
	
	GWG
	
	1
	Z003

	
	
	02
	Tax
	
	GWG
	
	1
	Z003

	
	
	03
	Diff.FY
	
	GWG
	
	1
	Z003

	
	
	91
	Accounting-G
	
	GWG
	
	1
	Z003

	
	
	92
	Tax-G
	
	GWG
	
	1
	Z003

	
	
	93
	Diff.FY-G
	
	GWG
	
	1
	Z003



Key Fields Definitions
	Field Name
	Description

	Chart of dep.
	Chart of depreciation ID

	Asset Class
	Asset class ID

	Ar.
	Depreciation area ID

	Dep. Area
	Depreciation area description

	Deact
	Indicator specifies that depreciation area is deactivated

	DepKy
	Depreciation key ID to be default values

	Use
	Useful life in year to be default values

	Per
	Useful life in period to be default values

	Layou
	Screen layout ID for depreciation area


3.4 [bookmark: _Toc107404524]Deactivate Asset Class for Chart of Depreciation

	Script Description
	Deactivate asset class for chart of depreciation

	Objective
	To lock asset class for entire chart of depreciation in order to prevent an asset class from being used inadvertently for which it is not intended.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Deactivate Asset Class for Chart of Depreciation

	Transaction Code
	AM05

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	Lock unused asset class to prevent from being used inadvertently



Screen: Change View “Lock Asset Class for Chart of Depreciation”: Overview
[image: ]
Configure system as below table:
	Class
	Short Text
	Lock

	1000
	Real estate
	X

	1100
	Buildings
	X

	2000
	Machinery
	X

	3000
	Fixtures & fittings
	X

	3100
	Vehicles
	X

	3200
	DP / Hardware
	X

	4000
	Assets under const.
	X

	4001
	Investment measure
	X

	5000
	LVA
	X

	6000
	Leasing (oper.)
	X

	6100
	Leasing (capital)
	X

	8000
	Objects of art
	X





Key Fields Definitions
	Field Name
	Description

	Class
	Asset class ID (Most of them are SAP standard asset class)

	Short Text
	Asset class short description

	Lock
	Indicator specifies that this asset class is deactivated from the chart of depreciation


3.5 [bookmark: _Toc107404525]Amount Specifications (Company Code/Depreciation Area)
3.5.1 [bookmark: _Toc107404526]Specify Low-Value Asset Maximum Amount and Quantity Check

	Script Description
	Specify how to check maximum amount and quantity check for low-value asset when posting transaction

	Objective
	To specify how you want the system to carry out the LVA maximum amount check for the asset class. There are 2 types of checking rule:
· A quantity check (when low-value assets are managed collectively on a single asset master data)
· An individual check (LVAs are managed individually)
During a quantity check, the system determines if the value of the collective low-value asset divided by the quantity entered in the asset exceeds the LVA maximum amount for the company code or depreciation area.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Amount Specifications (Company Code/Depreciation Area) -> Specify Max. Amount for Low-Value Assets + Asset Classes -> Specify LVA asset classes

	Transaction Code
	OAY2

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	Configuring for only low-value asset class





Screen: Change View “Asset class”: Overview
[image: ]
Select Asset Class, then double click on ‘Low-val. Asset check’

Screen: Change View “Low-val. Asset check”: Overview
[image: ]
Configure system as below table:


	Chart of dep.
	Asset Class
	Ar.
	Dep. Area
	LVA
	Description

	1000
	Z9701A
	01
	Accounting
	2
	Check maximum amount with quantity

	
	
	02
	Tax
	2
	Check maximum amount with quantity

	
	
	03
	Diff.FY
	2
	Check maximum amount with quantity

	
	
	91
	Accounting-G
	2
	Check maximum amount with quantity

	
	
	92
	Tax-G
	2
	Check maximum amount with quantity

	
	
	93
	Diff.FY-G
	2
	Check maximum amount with quantity

	
	Z9701C
	01
	Accounting
	2
	Check maximum amount with quantity

	
	
	02
	Tax
	2
	Check maximum amount with quantity

	
	
	03
	Diff.FY
	2
	Check maximum amount with quantity

	
	
	91
	Accounting-G
	2
	Check maximum amount with quantity

	
	
	92
	Tax-G
	2
	Check maximum amount with quantity

	
	
	93
	Diff.FY-G
	2
	Check maximum amount with quantity



Key Fields Definitions
	Field Name
	Description

	Chart of dep.
	Chart of depreciation ID

	Asset Class
	Asset class ID

	Ar.
	Depreciation area ID

	Dep. Area
	Depreciation area short description

	LVA
	Indicator specifies that asset class which you want a maximum amount check for low-value assets (LVAs). The system can check with following rules:
· 0 - No maximum amount check:
if you do not require a check of maximum amounts for assets in this class.

· 1 - Value based maximum amount check:
if you want to manage each LVA with its own asset master record (individual management).

· 2 - Check maximum amount with quantity:
if you want several LVAs to be managed in one asset master record (collective management).


	Description
	Low-Value Asset amount and quantity check description




3.5.2 [bookmark: _Toc107404527]Specify Maximum Amount for Low-Value Asset

	Script Description
	Specify maximum amount for low-value asset for each company code/depreciation area 

	Objective
	To determine the maximum amount for low-value assets (LVAs) for each company code/depreciation area by entering a maximum amount for each of the following:
· Acquisition postings
· Purchase orders (maximum LVA amount)

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Amount Specifications (Company Code/Depreciation Area) -> Specify Max. Amount for Low-Value Assets + Asset Classes -> Specify amount for low value assets

	Transaction Code
	OAYK

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	Configuring for only company code which utilizes LVA class



Screen: Change View “Company code selection”: Overview
[image: ]
Select Company code, then double click on ‘Amount for low-value assets’



Screen: Change View “Amount for low-value assets”: Overview
[image: ]
Configure system as below table:
Maximum amount of LVA for each company code/depreciation area for Fusion 1 Project is configured as listed in Appendix 05: Specify Maximum Amount for Low-Value Asset. 
Example:
	Company Code
	Ar.
	Name of Depreciation Area
	LVA Amount
	MaxLVA Pur
	Crcy

	1010
	01
	Accounting Depreciation
	2,000.00
	2,000.00
	THB

	
	02
	Tax Depreciation
	2,000.00
	2,000.00
	THB

	
	03
	Different Fiscal Year Depreciation
	2,000.00
	2,000.00
	THB

	
	91
	Accounting Depreciation (Group Currency)
	2,000.00
	2,000.00
	THB

	
	92
	Tax Depreciation (Group Currency)
	2,000.00
	2,000.00
	THB

	
	93
	Different Fiscal Year Depreciation(Group Currency)
	2,000.00
	2,000.00
	THB

	2010
	01
	Accounting Depreciation
	2,139.99
	1,999.99
	THB

	
	02
	Tax Depreciation
	2,139.99
	1,999.99
	THB

	
	03
	Different Fiscal Year Depreciation
	2,139.99
	1,999.99
	THB

	
	91
	Accounting Depreciation (Group Currency)
	2,139.99
	1,999.99
	THB

	
	92
	Tax Depreciation (Group Currency)
	2,139.99
	1,999.99
	THB

	
	93
	Different Fiscal Year Depreciation(Group Currency)
	2,139.99
	1,999.99
	THB

	3010
	01
	Accounting Depreciation
	2,139.99
	1,999.99
	THB

	
	02
	Tax Depreciation
	2,139.99
	1,999.99
	THB

	
	03
	Different Fiscal Year Depreciation
	2,139.99
	1,999.99
	THB

	
	91
	Accounting Depreciation (Group Currency)
	2,139.99
	1,999.99
	THB

	
	92
	Tax Depreciation (Group Currency)
	2,139.99
	1,999.99
	THB

	
	93
	Different Fiscal Year Depreciation(Group Currency)
	2,139.99
	1,999.99
	THB

	5300
	01
	Accounting Depreciation
	2,000.00
	2,000.00
	THB

	
	02
	Tax Depreciation
	2,000.00
	2,000.00
	THB

	
	03
	Different Fiscal Year Depreciation
	2,000.00
	2,000.00
	THB

	
	91
	Accounting Depreciation (Group Currency)
	2,000.00
	2,000.00
	THB

	
	92
	Tax Depreciation (Group Currency)
	2,000.00
	2,000.00
	THB

	
	93
	Different Fiscal Year Depreciation(Group Currency)
	2,000.00
	2,000.00
	THB

	8100
	01
	Accounting Depreciation
	2,000.00
	2,000.00
	THB

	
	02
	Tax Depreciation
	2,000.00
	2,000.00
	THB

	
	03
	Different Fiscal Year Depreciation
	2,000.00
	2,000.00
	THB

	
	91
	Accounting Depreciation (Group Currency)
	2,000.00
	2,000.00
	THB

	
	92
	Tax Depreciation (Group Currency)
	2,000.00
	2,000.00
	THB

	
	93
	Different Fiscal Year Depreciation(Group Currency)
	2,000.00
	2,000.00
	THB



Key Fields Definitions
	Field Name
	Description

	Company Code
	Company code ID

	Ar.
	Depreciation area ID

	Name of Depreciation Area
	Depreciation area description

	LVA Amount
	Maximum amount for checking posting to low value assets. This applies to all postings that would cause the acquisition value of the asset to exceed the specified maximum amount

	MaxLVA Pur
	Maximum amount for checking purchase orders for assets. This applies when purchase orders are created for assets in the Materials Management (MM) module. The system prevents the creation of purchase orders if the acquisition value of the asset would exceed the maximum LVA amount

	Crcy
	Currency ID





3.5.3 [bookmark: _Toc107404528]Specify Rounding of Net Book Value and/or Depreciation

	Script Description
	Specify rounding of net book value and/or depreciation for depreciation area

	Objective
	To define decimal rounding specifications for net book values at the end of the year, and for automatically depreciation calculation. These specifications are for each depreciation area and company code.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Amount Specifications (Company Code/Depreciation Area) -> Specify Rounding of Net Book Value and/or Depreciation

	Transaction Code
	OAYO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Company code selection”: Overview
[image: ]
Select Company code, then double click on ‘Rounding specifications’



Screen: Change View “Rounding specifications”: Overview
[image: ]
Double click on each Depreciation Area to maintain values

Screen: Change View “Rounding specifications”: Details
[image: ]
Configure system as below table:
Rounding specifications for each company code/depreciation area for Fusion 1 Project is configured as listed in Appendix 06: Specify Rounding of Net Book Value and/or Depreciation. 
Example:


	Company Code
	Deprec. area
	Name of Depreciation Area
	Arithmetic Rounding
	Round Up
	Round Down

	1010
	01
	Accounting Depreciation
	X
	
	

	
	02
	Tax Depreciation
	X
	
	

	
	03
	Different Fiscal Year Depreciation
	X
	
	

	
	91
	Accounting Depreciation (Group Currency)
	X
	
	

	
	92
	Tax Depreciation (Group Currency)
	X
	
	

	
	93
	Different Fiscal Year Depreciation(Group Currency)
	X
	
	



Key Fields Definitions
	Field Name
	Description

	Company Code
	Company code ID

	Deprec. area
	Depreciation area ID

	Name of Depreciation Area
	Depreciation area description

	Arithmetic Rounding
	For decimal places of currency, tenths up to and including 4 are rounded downward to the next whole number, starting with 5 they are rounded upward to the next whole number

	Round Up
	For decimal places of currency, always rounds to the next highest whole number.

	Round Down
	For decimal places of currency, always rounds to the next lowest whole number.


3.6 [bookmark: _Toc107404529]Specify the Use of Parallel Currencies

	Script Description
	Specify the use of parallel currencies

	Objective
	In case of using parallel currencies, to assign a currency type that is suitable for the given parallel currency to depreciation areas.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> General Valuation -> Currencies -> Specify the Use of Parallel Currencies

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Set Up Parallel Currencies”: Overview
[image: ]
Configure system as below table:
	Ar.
	Dep. Area
	Currency Type

	1
	Accounting
	

	2
	Tax
	

	3
	Diff.FY
	

	91
	Accounting-G
	30 Group Currency

	92
	Tax-G
	30 Group Currency

	93
	Diff.FY-G
	30 Group Currency



Key Fields Definitions
	Field Name
	Description

	Ar.
	Depreciation area ID

	Dep. Area
	Depreciation area short description

	Currency Type
	The currency type specifies the role of a currency in the SAP system





4 [bookmark: _Toc107404530]Depreciation
4.1 [bookmark: _Toc107404531]Valuation Methods
4.1.1 [bookmark: _Toc107404532]Define Base Methods

	Script Description
	Define base methods for depreciation calculation

	Objective
	To base methods for depreciation calculation. Base methods are valid in all charts of depreciation. You then assign them to depreciation keys.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Depreciation Key -> Calculation Methods -> Define Base Methods

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Base Method”: Overview
[image: ]
Configure system as below table:


	Base Method
	Text

	0002
	Ordinary: no automatic depreciation

	0007
	Ordinary: percentage from life (after end of life)

	0011
	Ordinary: percentage from useful life

	0017
	Ordinary: immediate deprec. (after end of life)

	Z018
	Ordinary: Unit-of-production depreciation



Remark: Base Method: Z018 is additional customizing for Fusion 1 Project by copying from ‘0018’. The rest is SAP standard provided.

Key Fields Definitions
	Field Name
	Description

	Base Method
	Base method ID of the depreciation key for calculating depreciation.

	Text
	Base method description



Screen: Change View “Base Method”: Details
[image: ]
Configure system as below table:


	Base Method
	Type of Depreciation
	Dep. Method
	Reduce Use.Life at FY End
	Dep. After Plnd.Life End
	Dep. Below NBValue Zero

	0002
	N Ord.depreciation
	N No automatic calculation
	
	No
	No

	0007
	N Ord.depreciation
	D Percentage from the useful life
	
	X Yes
	No

	0011
	N Ord.depreciation
	D Percentage from the useful life
	
	No
	No

	0017
	N Ord.depreciation
	V Immediate depreciation
	X
	X Yes
	No

	Z018
	N Ord.depreciation
	T No. of units/ remaining units
	
	No
	No



Key Fields Definitions
	Field Name
	Description

	Base Method
	Base method ID of the depreciation key for calculating depreciation.

	Type of Depreciation
	Depreciation type provided by SAP standard with 3 types below:
· N – Ordinary Depreciation
· S – Special Tax Depreciation
· Z – Interest


	Dep. Method
	Specify which depreciation calculation method that the base method should use. There are several options provide by SAP standard below:
· N - No automatic calculation (for no depreciation)
· D - Percentage from the useful life (for straight-line calculation)
· V - Immediate depreciation (for fully depreciated)
· T - No. of units/ remaining units (for unit of production calculation)


	Reduce Use.Life at FY End
	If you set this indicator, the system reduces the planned useful life so that the end of depreciation always coincides with the end of the fiscal year. This applied to LVA which always fully depreciated at the end of period.

	Dep. After Plnd.Life End
	Set this indicator, if you want the system to continue depreciation after the end of the planned useful life.

	Dep. Below NBValue Zero
	Set this indicator, if you want the system to continue depreciation after the book value is zero.


4.1.2 [bookmark: _Toc107404533]Maximum Amount Methods
4.1.2.1 [bookmark: _Toc107404534]Define Maximum Amount Methods

	Script Description
	Define maximum amount methods for depreciation calculation

	Objective
	To define maximum amount methods. You then assign them to depreciation keys. The calculation method contains a maximum depreciation amount that is not allowed to be exceeded before a certain calendar date. If the depreciation calculated by the system exceeds this maximum amount, then the system reduces depreciation to this maximum amount.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Depreciation Key -> Calculation Methods -> Define Maximum Amount Methods

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Maximum Amount Method”: Overview
[image: ]
Configure system as below table:

	Max. Amt.
	Annual
	Description of the Method

	TH0
	
	Maximum amount for Base value of car (TH)



Select Maximum Amount Method, then double click on ‘Maximum Amounts’
Key Fields Definitions
	Field Name
	Description

	Max. Amt.
	Maximum amount method ID of the depreciation key for calculating depreciation

	Annual
	Maximum amount for depreciation based on annual depreciation

	Description of the Method
	Maximum amount method description



Screen: Change View “Maximum Amounts”: Overview
[image: ]
Configure system as below table:
	Maximum Amount
	Description
	Valid To
	Currency
	Max.amount

	TH0
	Maximum amount for Base value of car (TH)
	31.12.9999
	THB
	1,000,000.00





Key Fields Definitions
	Field Name
	Description

	Maximum Amount
	Maximum amount method ID of the depreciation key for calculating depreciation

	Depreciation
	Maximum amount method description

	Valid To
	Calendar date up to which the entered maximum depreciation amount is valid

	Currency
	Currency ID

	Max.amount
	The maximum amount of depreciation allowed up to a certain calendar date


4.1.2.2 [bookmark: _Toc107404535]Define Maximum Base Value

	Script Description
	Define maximum base value for asset class of company code/depreciation area

	Objective
	To define limited acquisition values as base values for the calculation of depreciation. 
"Limited acquisition value" means that the system uses a specified maximum amount as the base value for depreciation. If the acquisition value of the asset is under this maximum amount, the system uses the actual acquisition value as the basis for depreciation. However, if the acquisition value of the asset exceeds this maximum amount, depreciation is based on this maximum amount. You can specify the maximum base amount for each depreciation area and asset class in each company code.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Further Settings -> Define Maximum Base Value

	Transaction Code
	OAW2

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Maximum base value”: Overview
[image: ]
Configure system as below table:
Maximum base value of asset class for Fusion 1 Project is configured as listed in Appendix 07: Define Maximum Base Value. 
Example:
	Company code
	Asset class
	Dep.area
	Valid To
	Maximum value

	1010
	Z4101A
	02
	31.12.9999
	1,000,000.00

	1010
	Z4101A
	92
	31.12.9999
	1,000,000.00

	1010
	Z4101C
	02
	31.12.9999
	1,000,000.00

	1010
	Z4101C
	92
	31.12.9999
	1,000,000.00

	2010
	Z4101A
	02
	31.12.9999
	1,000,000.00

	2010
	Z4101A
	92
	31.12.9999
	1,000,000.00

	2010
	Z4101C
	02
	31.12.9999
	1,000,000.00

	2010
	Z4101C
	92
	31.12.9999
	1,000,000.00

	3010
	Z4101A
	02
	31.12.9999
	1,000,000.00

	3010
	Z4101A
	92
	31.12.9999
	1,000,000.00

	3010
	Z4101C
	02
	31.12.9999
	1,000,000.00

	3010
	Z4101C
	92
	31.12.9999
	1,000,000.00

	5300
	Z4101A
	02
	31.12.9999
	1,000,000.00

	5300
	Z4101A
	92
	31.12.9999
	1,000,000.00

	5300
	Z4101C
	02
	31.12.9999
	1,000,000.00

	5300
	Z4101C
	92
	31.12.9999
	1,000,000.00

	8100
	Z4101A
	02
	31.12.9999
	1,000,000.00

	8100
	Z4101A
	92
	31.12.9999
	1,000,000.00

	8100
	Z4101C
	02
	31.12.9999
	1,000,000.00

	8100
	Z4101C
	92
	31.12.9999
	1,000,000.00

	8200
	Z4101A
	02
	31.12.9999
	1,000,000.00

	8200
	Z4101A
	92
	31.12.9999
	1,000,000.00

	8200
	Z4101C
	02
	31.12.9999
	1,000,000.00

	8200
	Z4101C
	92
	31.12.9999
	1,000,000.00



Key Fields Definitions
	Field Name
	Description

	Company code
	Company code ID

	Asset class
	Asset class ID

	Dep.area
	Depreciation area ID

	Valid To
	The maximum depreciation amount you entered is valid until this capitalization date.

	Maximum value
	The maximum amount allowed for the base value for depreciation in a depreciation area.



4.1.3 [bookmark: _Toc107404536]Define Multi-Level Methods

	Script Description
	Define multi-level methods for depreciation calculation

	Objective
	To define multi-level methods. You then assign them to depreciation keys. Each level represents a validity period for a given percentage rate.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Depreciation Key -> Calculation Methods -> Define Multi-Level Methods

	Transaction Code
	AFAMS

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Multilevel Method”: Overview
[image: ]

Screen: Change View “Multilevel Method”: Details
[image: ]
Configure system as below table:


	Multilev. Meth.
	Description of the Method
	Validity Start

	001
	0.0000%
	2 From ordinary depreciation start date

	002
	0.0000%
	2 From ordinary depreciation start date

	003
	0%; Base=05=Limit Repl.Value
	2 From ordinary depreciation start date

	004
	0%; Base=03=Repl.value
	2 From ordinary depreciation start date

	005
	0%; Base=01=Acq. value
	2 From ordinary depreciation start date

	Z04
	0%; Base=27=NBV
	2 From ordinary depreciation start date



Remark: Multilevel Method: Z04 is additional customizing for Fusion 1 Project by copying from ‘004’. The rest is SAP standard provided. 

Key Fields Definitions
	Field Name
	Description

	Multilev. Meth.
	Multilevel methods ID of the depreciation key for calculating depreciation

	Description of the Method
	Multilevel methods description

	Validity Start
	This indicator controls which date is used for the start of the validity period of the defined depreciation levels (for multi-level depreciation).
The system also uses this start date to determine the acquisition year of the asset, when the depreciation levels are staggered according to acquisition years.
· 1 - From capitalization date
· 2 - From ordinary depreciation start date
· 3 - From special depreciation start date
· 4 - From original acquisition date of AuC
· 5 - From changeover year




Select Multilevel Methods, then double click on ‘Levels’



Screen: Change View “Levels”: Overview
[image: ]
Configure system as below table:
	Multilev. Meth.
	Year
	Per
	BaseVal.
	Percent
	Rem. Life

	001
	999
	12
	24 Net book value
	
	X

	002
	999
	12
	24 Net book value
	
	

	003
	999
	12
	05 Limited replacement value
	
	

	004
	999
	12
	03 Replacement value
	
	

	005
	999
	12
	01 Acquisition value
	
	

	Z04
	999
	12
	24 Net book value with proportional value adjustments
	
	



Key Fields Definitions
	Field Name
	Description

	Multilev. Meth.
	Multilevel methods ID of the depreciation key for calculating depreciation

	Year
	The validity period for a percentage rate in calendar years.

	Per
	The validity period in calendar months for a percentage rate.





	BaseVal.
	Base value key for depreciation calculation provided by SAP standard as following:
01 - Acquisition value
02 - Half of acquisition value
03 - Replacement value
04 - Half of replacement value
05 - Limited replacement value
06 - Replacement value reduced by reserves
010 - Acquisition value reduced by unplanned depreciation
011 - Acquisition value reduced by special depreciation
012 - Acquisition value reduced by unplanned dep. (w/o write-up)
013 - Acquis. Value Reduced by Cumulated Unplanned Depreciation
014 - Acquisition value reduced by reserves
020 - Net book value without spec. dep. and current dep.
021 - Net book value without special depreciation
022 - Mean net book value without special depreciation
023 - Net book value without current depreciation
024 - Net book value
025 - Mean net book value
026 - Rem. book value w/o revaluation
027 - Net book value with proportional value adjustments
028 - Reduced base value (asset-specific reduction)
029 - External base value from real estate leasing
030 - Accumulated ordinary depreciation
031 - Cumulative special depreciation
032 - Accumulated ordinary and special depreciation
40	- Acquisitions

	Percent
	Percentage rate for the calculation of depreciation.

	Rem. Life
	Indicator specifies that the system determines the periodic depreciation percentage based on the remaining life. This indicator only makes sense for depreciation keys in which the base method uses the "percentage from the useful life" depreciation calculation method.




4.1.4 [bookmark: _Toc107404537]Period Control Methods
4.1.4.1 [bookmark: _Toc107404538]Maintain Period Control Key

	Script Description
	Define period control key for period control methods

	Objective
	To determines the start or end of depreciation based on the asset value date of a transaction (of the acquisition or retirement) using the period control. The period control is therefore an important part of the depreciation key. You can enter a separate period control for each period control method of the depreciation key for the following transaction types:
· Acquisitions
· Subsequent acquisitions in later years
· Retirements
· Transfers

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Period Control -> Maintain Period Control

	Transaction Code
	OAVS

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Period Control”: Overview
[image: ]
Configure system as below table:


	Per.Contr.
	Name of Period Control

	01
	Pro rata at period start date

	02
	Pro rata upto mid-period at period start date

	06
	At the start of the year



Key Fields Definitions
	Field Name
	Description

	Per.Contr.
	Period control key provided by SAP standard as following:
01 - Pro rata at period start date
02 - Pro rata upto mid-period at period start date
03 - Pro rata at mid-period
04 - First year convention at half year start date
06 - At the start of the year
07 - At mid-year
08 - At the end of the year (=Start date of following year)
09 - At mid-quarter
10 - At the first quarter
11 - Next month
12 - Next quarter
13 - Next half-year
14 - Modified half-year rule


	Name of Period Control
	Period control key description


4.1.4.2 [bookmark: _Toc107404539]Maintain Period Control Methods

	Script Description
	Maintain period control methods for depreciation calculation

	Objective
	To maintain period control methods and assign period control key to the period control methods for the following transaction types:
· Acquisitions
· Subsequent acquisitions in later years
· Retirements
· Transfers
By using period control methods, for example; you can specify that the depreciation start date for all acquisitions in the year is set to the first day of the period. You then assign them to depreciation keys. 

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Depreciation Key -> Calculation Methods -> Maintain Period Control Methods

	Transaction Code
	AFAMP

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Maintain Period Control

	Remark
	N/A



Screen: Change View “Period Control”: Overview
[image: ]
Configure system as below table:
	Period Control
	Description
	Acq
	Add
	Ret
	Trn

	001
	01/01/02/02
	01
	01
	02
	02

	002
	01/01/01/01
	01
	01
	01
	01

	003
	01/06/02/02
	01
	06
	02
	02



Key Fields Definitions
	Field Name
	Description

	Period Control
	Period control method ID of the depreciation key for calculating depreciation

	Description
	Period control method description

	Acq
	Period control key used for acquiring transactions (in the year of capitalization).

	Add
	Period control key used with subsequent acquisitions.

	Ret
	Period control key used with retirements.

	Trn
	Period control key used with transfer postings




4.2 [bookmark: _Toc107404540]Define the Cutoff Value Key

	Script Description
	Define the cutoff value key for depreciation calculation

	Objective
	To define the calculation key for automatically determining scrap values. For each depreciation key, you can specify whether the cut-off values entered in the asset master data should be deducted at the start or the end of the calculation of depreciation. For certain types of valuation, it makes sense, or is legally required, that you end depreciation when a certain value is reached. 

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Depreciation Key -> Further Settings -> Define the Cutoff Value Key

	Transaction Code
	ANHAL

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Cutoff Value Keys”: Overview
[image: ]
Configure system as below table:
	Cutoff Val
	Name of Cutoff Value Key

	ZTH
	Scrap value deduction for Thailand





Key Fields Definitions
	Field Name
	Description

	Cutoff Val
	Cutoff value key

	Name of Cutoff Value Key
	Cutoff value key description


4.3 [bookmark: _Toc107404541]Maintain Depreciation Key

	Script Description
	Maintain depreciation key for asset master data

	Objective
	To maintain depreciation keys by assigning calculation methods to them. You can divide the duration of depreciation into several phases. When you enter a changeover method for one of these phases, the system changes over to the next phase as soon as the event specified in the changeover method has occurred. The system then uses the depreciation calculation that is specified in the calculation method for this phase.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Depreciation -> Valuation Methods -> Depreciation Key -> Maintain Depreciation Key

	Transaction Code
	AFAMA

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	· Define Base Methods
· Define Maximum Amount Methods
· Define Multi-Level Methods
· Maintain Period Control Methods
· Define the Cutoff Value Key 

	Remark
	N/A



Screen: Change View “Depreciation Key”: Overview
[image: ]
Configure system as below table:
	DepKy
	Name for Whole Description
	Status

	0000
	No depreciation and no interest
	X Active

	GWG
	LVA 100 % Complete depreciation
	X Active

	STCK
	Unit-of-production depreciation (Example)
	X Active

	TH01
	Str.-line from total useful life - monthly      TH
	X Active

	TH02
	Str.-line from total useful life - daily        TH
	X Active

	TH04
	Str.-line from total useful life - daily (Car)TH
	X Active



Key Fields Definitions
	Field Name
	Description

	DepKy
	Depreciation key ID

	Name for Whole Description
	Depreciation key description

	Status
	Status of Depreciation Key which is one of 3 statuses below:
· X - Active:
The depreciation key has no errors, and can be used in asset master records.

· Inactive: 
Either the depreciation key or one of its calculation methods has errors. The depreciation key cannot be used.
· M - Migrated: 
The depreciation key has been migrated by the migration program from the old table to the new table. The old depreciation key is currently still valid for the calculation of depreciation.




Double click on each Depreciation Area to maintain values



Screen: Change View “Depreciation Key”: Details
[image: ]
Configure system as below table:
	Dep. key
	Maximum Amount
	Cutoff Val. Key
	Dep. to the Day
	No reduct. in short year
	Acq.Only Allowed in Capitalization Year

	0000
	
	
	
	
	No

	GWG
	
	
	
	X
	X Yes

	STCK
	
	
	
	
	X Yes

	TH01
	
	
	
	
	No

	TH02
	
	ZTH
	X
	
	No

	TH04
	TH0
	ZTH
	X
	X
	No



Key Fields Definitions
	Field Name
	Description

	Dep. key
	Depreciation key ID

	Maximum Amount
	Maximum amount method

	Cutoff Val. Key
	Cutoff value key

	Dep. to the Day
	Indicator specifies that the system calculates depreciation to the exact day. Any period control methods entered in the depreciation key are ignored for the entire useful life of the asset. This applies to all transactions (acquisitions, retirements, and transfers). The system always uses the asset value date as the depreciation start date.

	No reduct. in short year
	Indicator for controlling the calculation of depreciation in a shortened fiscal year. With this indicator you can specify individually for each depreciation key that depreciation not be reduced in the shortened fiscal year.

	Acq.Only Allowed in Capitalization Year
	Set this indicator, if the system should only allow additional acquisitions in the year of the initial acquisition or of the capitalization date.



Double click on ‘Assignment of Calculation Method’ to maintain values.

Screen: Change View “Assignment of Calculation Methods”: Overview
[image: ]
Configure system as below table:
	DepKy
	Dep./int.
	Phase
	Base Method
	Prd Cont
	Multilev. Meth.
	Chnge. Method

	0000
	N Ord.depreciation
	1 From the start of depreciation
	0002
	001
	002
	

	GWG
	N Ord.depreciation
	1 From the start of depreciation
	0017
	003
	005
	

	STCK
	N Ord.depreciation
	1 From the start of depreciation
	Z018
	003
	Z04
	

	TH01
	N Ord.depreciation
	1 From the start of depreciation
	0011
	002
	004
	5

	
	
	2 Changeover within planned life
	0017
	003
	005
	

	TH02
	N Ord.depreciation
	1 From the start of depreciation
	0007
	001
	003
	5

	
	
	2 Changeover within planned life
	0017
	003
	005
	

	TH04
	N Ord.depreciation
	1 From the start of depreciation
	0007
	001
	003
	5

	
	
	2 Changeover within planned life
	0017
	001
	001
	



Key Fields Definitions
	Field Name
	Description

	DepKy
	Depreciation key ID

	Dep./int.
	Depreciation type provided by SAP standard with 3 types below:
· N – Ordinary Depreciation
· S – Special Tax Depreciation
· Z – Interest


	Phase
	Depreciation phase (the duration of depreciation) which can be divided into several phases, during each of which the depreciation key uses different calculation methods for calculating depreciation.

	Base Method
	Base method ID

	Prd Cont
	Period control method ID

	Multilev. Meth.
	Multilevel method ID

	Chnge. Method
	Changeover method specifies when the changeover to a different phase of the depreciation key triggered.



Double click on each Depreciation Phase to maintain values.



Screen: Change View “Assignment of Calculation Methods”: Details
[image: ]
Configure system as below table:
	Dep. key
	Dep Type
	Phase
	Class

	0000
	N
	1
	0 No assignment

	GWG
	N
	1
	1 Straight-line depreciation

	STCK
	N
	1
	3 Other depreciation

	TH01
	N
	1
	1 Straight-line depreciation

	
	
	2
	1 Straight-line depreciation

	TH02
	N
	1
	1 Straight-line depreciation

	
	
	2
	1 Straight-line depreciation

	TH04
	N
	1
	1 Straight-line depreciation

	
	
	2
	1 Straight-line depreciation





Key Fields Definitions
	Field Name
	Description

	Dep.key
	Depreciation key ID

	DepType
	Depreciation type provided by SAP standard with 3 types below:
· N – Ordinary Depreciation
· S – Special Tax Depreciation
· Z – Interest


	Phase
	Depreciation phase (the duration of depreciation) which can be divided into several phases, during each of which the depreciation key uses different calculation methods for calculating depreciation. 

	Class
	Indicator for ordinary depreciation classification used for classifying depreciation calculated with this depreciation key with options below: 
· 0 – No Assignment
· 1 – Straight-line depreciation
· 2 – Declining-balance depreciation
· 3 – Other depreciation




5 [bookmark: _Toc107404542]Master Data
5.1 [bookmark: _Toc80015623][bookmark: _Toc107404543]Screen Layout
5.1.1 [bookmark: _Toc107404544][bookmark: _Toc80015624]Define Screen Layout for Asset Master Data
5.1.1.1 [bookmark: _Toc107404545]Configurable Entry Screen for Creating Multiple Assets

	Script Description
	Configurable entry screen for creating multiple assets

	Objective
	To activate input screen layout when creating multiple asset

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Screen Layout -> Define Screen Layout for Asset Master Data -> Define Screen Layout for Asset Master Data -> Configurable Entry Screen for Creating Multiple Assets

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A


	Remark
	N/A




Screen: Change View “Activate Config. Input Screen When Creating Multiple Asset”: Overview
[image: ]



Configure system as below table
	Activate Config. Input Screen When Creating Multiple Assets

	X Configurable Entry Screen for Creating Multiple Assets



Key Fields Definitions
	Field Name
	Description

	Activate Config. Input Screen When Creating Multiple Assets
	Indicator specifies that the system activates configuration input screen when creating multiple assets


5.1.1.2 [bookmark: _Toc107404546]Define Screen Layout for Asset Master Data

	Script Description
	Define screen layout for asset master data

	Objective
	To define the screen layout for asset master data. The screen layout contains the specifications for the field groups in the asset master. You enter the screen layout in the asset class. This method allows you to structure the master data individually for each asset class. Using the screen layout, you can define:
· which fields are
· required
· optional
· suppressed
· the maintenance level in the asset hierarchy
· which fields are copied, when creating an asset using another asset master record as a reference

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Screen Layout -> Define Screen Layout for Asset Master Data -> Define Screen Layout for Asset Master Data

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Create Screen Layout Rules

	Remark
	N/A





Screen: Change View “Screen Layout”: Overview
[image: ]
Select Screen Layout, then double click on ‘Logical field groups’

Screen: Change View “Screen Layout”: Overview
[image: ]
Select Logical Field Group, then double click on ‘Field group rules’ 



Screen: Change View “Field group rules”: Overview
[image: ]
Configure system as below table
Field status group of screen layout for asset master for Fusion 1 Project is configured as listed in Appendix 08: Define Screen Layout for Asset Master. 
[image: ]CN Asset Accounting (AA)
Example:
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	Version: 



	Layout
	Name of Screen Layout
	Log.Fld.Gr
	Log.Field Group Name
	FG
	Field Group Name Status
	Req.
	Opt.
	No.
	Disp
	Class
	MnNo.
	Sbno.
	Copy
	Multiple

	Z100
	Land & Building
	1
	General data
	01
	Description 1
	X
	
	
	
	
	X
	X
	X
	X

	
	
	
	
	02
	Description 2
	
	X
	
	
	
	X
	X
	X
	X

	
	
	
	
	03
	General long text
	
	X
	
	
	
	X
	X
	
	

	
	
	
	
	04
	Inventory number
	
	X
	
	
	
	
	X
	X
	X

	
	
	
	
	05
	Unit of measure
	
	X
	
	
	X
	X
	X
	X
	

	
	
	
	
	06
	Quantity
	
	X
	
	
	
	X
	X
	
	

	
	
	
	
	07
	Asset main no. text
	
	X
	
	
	
	X
	X
	X
	

	
	
	
	
	09
	Account allocation
	X
	
	
	
	X
	
	
	
	

	
	
	
	
	75
	Serial number
	
	X
	
	
	
	
	X
	X
	X

	
	
	
	
	79
	Longtxt.:C-acc.view
	
	X
	
	
	
	X
	X
	
	

	
	
	
	
	80
	Longtxt.:Tech.view
	
	X
	
	
	
	X
	X
	
	

	
	
	
	
	82
	History indicator
	
	X
	
	
	X
	X
	X
	X
	

	
	
	2
	Posting information
	10
	Capitalization date
	
	
	
	X
	
	
	X
	
	

	
	
	
	
	11
	Acquisition data
	
	
	
	X
	
	
	X
	
	

	
	
	
	
	12
	Deactivation
	
	X
	
	
	
	
	X
	
	

	
	
	
	
	13
	Planned deactivation
	
	
	X
	
	
	
	
	
	

	
	
	
	
	28
	Purchase order date
	
	
	X
	
	
	
	
	
	

	
	
	
	
	43
	Capitalization key
	
	
	X
	
	
	
	
	
	

	
	
	
	
	10
	Capitalization date
	
	
	
	X
	
	
	X
	
	

	
	
	
	
	11
	Acquisition data
	
	
	
	X
	
	
	X
	
	

	
	
	
	
	12
	Deactivation
	
	X
	
	
	
	
	X
	
	


[image: ]CN Asset Accounting (AA)


	[image: D:\work\BTS\Template\IAM.png]
	30/225
	Version: 



Key Fields Definitions
	Field Name
	Description

	Layout
	Screen layout ID for maintaining asset master data.

	Name of screen layout rule
	Screen layout description

	Log.Fld.Gr
	Logical field group ID 

	Log.Field Group Name
	Logical field group description

	FG
	Field group ID

	Field Group Name Status
	Field group description

	Req.
	If this indicator is set, the screen layout defines the corresponding field group as a required entry field.

	Opt.
	If this indicator is set, the screen layout defines the corresponding field group as an optional entry field.

	No.
	If this indicator is set, the screen layout suppresses the corresponding field group in the asset master data.

	Disp
	If this indicator is set, the screen layout defines the corresponding field group as a display field that cannot be maintained.

	Class
	If this indicator is set, the screen layout defines the asset class as the maintenance level for the corresponding field group.

	MnNo.
	If this indicator is set, the screen layout defines the asset main number as the maintenance level for the field group.
When a sub-number is created for the asset, the values for this field group in the sub-number are supplied by the asset main number.

	Sbno.
	If this indicator is set, the screen layout defines the sub-number as the maintenance level for the corresponding field group.

	Copy
	If this indicator is set, the screen layout specifies that when you create an asset using another asset as a reference, the specified field group is automatically supplied with values from the reference asset.

	Multiple
	If you set this indicator for a field group, the screen layout specifies that the master data fields of this field group are ready for input when you are creating multiple assets.




5.1.2 [bookmark: _Toc80015625][bookmark: _Toc107404547]Define Screen Layout for Asset Depreciation Areas

	Script Description
	Define screen layout for asset depreciation areas

	Objective
	To define the screen layout for the depreciation terms (depreciation key, useful life, and so on) in the asset master data. This screen layout is similar to the one for the general master data section of the asset master data. You can use it in a similar way to control the features of the depreciation areas in the asset master data.  It is possible to make different specifications in each depreciation area.  Using the screen layout, you can define:
· which fields are
· required
· optional
· suppressed
· the maintenance level in the asset hierarchy
· which fields are copied, when creating an asset using another asset master record as a reference

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Screen Layout -> Define Screen Layout for Asset Depreciation Areas

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Change View “Screen layout”: Overview
[image: ]


Configure system as below table
	ScrnLayout
	Scrn Layout description

	Z001
	Asset with Scrap Values (Req)

	Z002
	Asset with Scrap Values (Opt)

	Z003
	Asset without Scrap Values



Key Fields Definitions
	Field Name
	Description

	ScrnLayout
	Screen layout ID for depreciation area

	Scrn Layout description
	Screen layout description for depreciation area



Screen: Change View “Screen layout for”: Overview
[image: ]

[image: ]CN Asset Accounting (AA)
Configure system as below table
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	Screen Layout
	Name of screen layout
	FG
	Field group name
	Req.
	Opt.
	No.
	Disp
	Class
	MnNo.
	Sbno.
	Copy

	Z001
	Asset with Scrap Values (Req)
	01
	Depreciation keys
	X
	
	
	
	X
	X
	X
	X

	
	
	02
	Useful life
	
	X
	
	
	X
	
	X
	

	
	
	03
	Ord.dep.start date
	
	X
	
	
	
	
	X
	

	
	
	04
	Spec.dep.start date
	
	X
	
	
	
	X
	
	

	
	
	05
	Int.calc.start date
	
	
	X
	
	
	
	
	

	
	
	08
	Index series Rep.val
	
	
	X
	
	
	
	
	

	
	
	09
	Index series by age
	
	
	X
	
	
	
	
	

	
	
	10
	Prop.dep.variable
	
	
	X
	
	
	
	
	

	
	
	11
	Scrap value
	X
	
	
	
	
	
	X
	X

	
	
	12
	Orig.useful life
	
	
	X
	
	
	
	
	

	
	
	13
	Str.-line chnge-year
	
	
	X
	
	
	
	
	

	
	
	14
	Group asset
	
	
	X
	
	
	
	
	

	
	
	15
	Vintage year/month
	
	
	X
	
	
	
	
	

	
	
	16
	Operating readiness
	
	
	X
	
	
	
	
	

	
	
	17
	Negative values
	
	
	X
	
	
	
	
	

	
	
	18
	Deactiv. area
	
	X
	
	
	X
	
	
	

	
	
	19
	Expired useful life
	
	X
	
	
	
	X
	X
	

	
	
	20
	Exprd Life -Periods
	
	X
	
	
	
	X
	X
	

	
	
	22
	Scrap Value %
	
	
	X
	
	
	
	
	

	
	
	31
	Revaluation key
	
	
	X
	
	
	
	
	

	Z002
	Asset with Scrap Values (Opt)
	01
	Depreciation keys
	X
	
	
	
	X
	X
	X
	X

	
	
	02
	Useful life
	
	X
	
	
	X
	
	X
	

	
	
	03
	Ord.dep.start date
	
	X
	
	
	
	
	X
	

	
	
	04
	Spec.dep.start date
	
	X
	
	
	
	X
	
	

	
	
	05
	Int.calc.start date
	
	
	X
	
	
	
	
	

	
	
	08
	Index series Rep.val
	
	
	X
	
	
	
	
	

	
	
	09
	Index series by age
	
	
	X
	
	
	
	
	

	
	
	10
	Prop.dep.variable
	
	
	X
	
	
	
	
	

	
	
	11
	Scrap value
	
	X
	
	
	
	
	X
	X

	
	
	12
	Orig.useful life
	
	
	X
	
	
	
	
	

	
	
	13
	Str.-line chnge-year
	
	
	X
	
	
	
	
	

	
	
	14
	Group asset
	
	
	X
	
	
	
	
	

	
	
	15
	Vintage year/month
	
	
	X
	
	
	
	
	

	
	
	16
	Operating readiness
	
	
	X
	
	
	
	
	

	
	
	17
	Negative values
	
	
	X
	
	
	
	
	

	
	
	18
	Deactiv. area
	
	X
	
	
	X
	
	
	

	
	
	19
	Expired useful life
	
	X
	
	
	
	X
	X
	

	
	
	20
	Exprd Life -Periods
	
	X
	
	
	
	X
	X
	

	
	
	22
	Scrap Value %
	
	
	X
	
	
	
	
	

	
	
	31
	Revaluation key
	
	
	X
	
	
	
	
	

	Z003
	Asset without Scrap Values
	01
	Depreciation keys
	X
	
	
	
	X
	X
	X
	X

	
	
	02
	Useful life
	
	X
	
	
	X
	
	X
	

	
	
	03
	Ord.dep.start date
	
	X
	
	
	
	
	X
	

	
	
	04
	Spec.dep.start date
	
	X
	
	
	
	X
	
	

	
	
	05
	Int.calc.start date
	
	
	X
	
	
	
	
	

	
	
	08
	Index series Rep.val
	
	
	X
	
	
	
	
	

	
	
	09
	Index series by age
	
	
	X
	
	
	
	
	

	
	
	10
	Prop.dep.variable
	
	
	X
	
	
	
	
	

	
	
	11
	Scrap value
	
	
	X
	
	
	
	X
	X

	
	
	12
	Orig.useful life
	
	
	X
	
	
	
	
	

	
	
	13
	Str.-line chnge-year
	
	
	X
	
	
	
	
	

	
	
	14
	Group asset
	
	
	X
	
	
	
	
	

	
	
	15
	Vintage year/month
	
	
	X
	
	
	
	
	

	
	
	16
	Operating readiness
	
	
	X
	
	
	
	
	

	
	
	17
	Negative values
	
	
	X
	
	
	
	
	

	
	
	18
	Deactiv. area
	
	X
	
	
	X
	
	
	

	
	
	19
	Expired useful life
	
	X
	
	
	
	X
	X
	

	
	
	20
	Exprd Life -Periods
	
	X
	
	
	
	X
	X
	

	
	
	22
	Scrap Value %
	
	
	X
	
	
	
	
	

	
	
	31
	Revaluation key
	
	
	X
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Key Fields Definitions
	Field Name
	Description

	Screen Layout
	Screen layout ID for maintaining depreciation area in asset master data.

	Name of screen layout rule
	Screen layout description

	FG
	Field group ID

	Field Group Name 
	Field group description 

	Req.
	If this indicator is set, the screen layout defines the corresponding field group as a required entry field.

	Opt.
	If this indicator is set, the screen layout defines the corresponding field group as an optional entry field.

	No.
	If this indicator is set, the screen layout suppresses the corresponding field group in the asset master data.

	Disp
	If this indicator is set, the screen layout defines the corresponding field group as a display field that cannot be maintained.

	Class
	If this indicator is set, the screen layout defines the asset class as the maintenance level for the corresponding field group.

	MnNo.
	If this indicator is set, the screen layout defines the asset main number as the maintenance level for the field group.
When a sub-number is created for the asset, the values for this field group in the sub-number are supplied by the asset main number.

	Sbno.
	If this indicator is set, the screen layout defines the sub-number as the maintenance level for the corresponding field group.

	Copy
	If this indicator is set, the screen layout specifies that when you create an asset using another asset as a reference, the specified field group is automatically supplied with values from the reference asset.

	Multiple
	If you set this indicator for a field group, the screen layout specifies that the master data fields of this field group are ready for input when you are creating multiple assets.


[bookmark: _Toc80015626]

5.1.3 [bookmark: _Toc107404548]Specify Tab Layout for Asset Master Record
5.1.3.1 [bookmark: _Toc107404549]Define Tab Layout for Asset Master Data

	Script Description
	Define tab layout for asset master data

	Objective
	The asset master data is split over several tab pages due to its large number of possible fields. In this activity you define the layout of these tab pages.
You can specify which tab pages are seen for each asset class (or if needed, by chart of depreciation within the asset class). For each tab page, you can specify which field groups appear in which positions on the tab page.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Screen Layout -> Specify Tab Layout for Asset Master Record

	Transaction Code
	AOLA

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	Copy tab layout from ‘SAP’ (Standard tab layout) to ‘Z001’



Screen: Change View “Layout”: Overview
[image: ]
Configure system by copying Tab Layout from ‘SAP’ (Standard tab layout) to ‘Z001’ (BTSG-Customized Field Layout)


Key Fields Definitions
	Field Name
	Description

	Layout
	Tab layout ID for asset master data

	Layout description
	Tab layout description



Screen: Change View “Layout Asset Ma”: Overview
[image: ]
Select Tab Page, then double click on ‘Position of groups on the tab pages’

Screen: Change View “Layout Asset Master Data: Position”: Overview
[image: ]
Configure system as below table
	Layout
	Layout Description
	Tab Page
	Title
	Position
	Group
	Description

	Z001
	BTSG-Customized Field Layout
	1
	General
	4
	U9002
	Legacy System

	Z001
	BTSG-Customized Field Layout
	2
	Time-dependent
	2
	U9001
	BTSG-Media Customized Field

	Z001
	BTSG-Customized Field Layout
	4
	Origin
	3
	U9003
	Consolidation



Remark: Group Box: U9001, U9002, U9003 are additional customizing fields for Fusion 1 Project that used for keeping the additional data in asset master following
· Group Box: U9001 - BTSG-Media Customized Field including ‘Product’ and ‘Sub product’ fields to store characteristic values in CO-PA that using for company code under VGI only.

· Group Box: U9002 - Legacy System including ‘Legacy Asset No.’ field to store an asset no. from the legacy system.

· Group Box: U9003 - Consolidation including ‘Trading Partner(RPT)’ field to store trading partner in case of RPT.


Key Fields Definitions
	Field Name
	Description

	Layout
	Tab layout ID for asset master data

	Layout description
	Tab layout description

	Tab Page
	Number of tab index in tab for asset master data maintenance. The data in the master data is displayed in the form of a tab that consists of individual tab pages.
Tab page "01" is displayed on the far left, and is the first tab page visible when you call the master data transaction.
Tab page "02" is the second tab page from the left, tab page "03" is the third tab page from the left, and so on.

	Title
	Tab page description

	Position
	Position of group box on asset master screen which can be running after current position

	Group
	Group Box ID which is a group of master data field supplied by SAP standard. The group box ID supplied by SAP are identified by an 'S' in the first position of their number, followed by the number of the group box.

	Description
	Group box description


5.1.3.2 [bookmark: _Toc107404550]Assign Tab Layouts to Asset Classes

	Script Description
	Assign tab layouts to asset classes

	Objective
	The asset master data is split over several tab pages due to its large number of possible fields. In this activity you define the layout of these tab pages.
You can specify which tab pages are seen for each asset class. For each tab page, you can specify which field groups appear in which positions on the tab page.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Screen Layout -> Assign Tab Layouts to Asset Classes

	Transaction Code
	AOLK

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Display View “Asset Class”: Overview
[image: ]
Select Asset Class, then double click on ‘General Assignment of Layout’



Screen: Change View “General Assignment of Layout”: Overview
[image: ]
Configure system as below table
Assign tab layout to asset class for Fusion 1 Project is configured as listed in Appendix 09: Assign Tab Layout to Asset Class. 
Example:
	Class
	Asset Class Description
	Trans.grp
	Name
	Tab Layout
	Layout des

	Z1101
	Land (IP)
	CCRESP
	Cost center manager
	Z001
	BTSG-Customized Field Layout

	Z1101
	Land (IP)
	EMPLOYEE
	Employee Self-Service
	Z001
	BTSG-Customized Field Layout

	Z1101
	Land (IP)
	OTHERS
	Asset accountant
	Z001
	BTSG-Customized Field Layout

	Z1101I
	Land (IP)-Impairment
	CCRESP
	Cost center manager
	Z001
	BTSG-Customized Field Layout

	Z1101I
	Land (IP)-Impairment
	EMPLOYEE
	Employee Self-Service
	Z001
	BTSG-Customized Field Layout

	Z1101I
	Land (IP)-Impairment
	OTHERS
	Asset accountant
	Z001
	BTSG-Customized Field Layout

	Z1102
	Land (PPE)
	CCRESP
	Cost center manager
	Z001
	BTSG-Customized Field Layout

	Z1102
	Land (PPE)
	EMPLOYEE
	Employee Self-Service
	Z001
	BTSG-Customized Field Layout

	Z1102
	Land (PPE)
	OTHERS
	Asset accountant
	Z001
	BTSG-Customized Field Layout





Key Fields Definitions
	Field Name
	Description

	Class
	Asset class ID

	Asset Class Description
	Asset class description

	Trans.grp
	Transaction group ID provided by SAP standard with 3 types below:
· CCRESP - Cost center manager
· EMPLOYEE - Employee Self-Service
· OTHERS - Asset accountant



	Name
	Transaction group description

	Tab Layout
	Tab layout ID for asset master data

	Layout des
	Tab layout description


5.2 [bookmark: _Toc80015627][bookmark: _Toc107404551]User Fields
5.2.1 [bookmark: _Toc80015628][bookmark: _Toc107404552]Define 4-Character Evaluation Groups

	Script Description
	Define asset status and BOI data for asset master data

	Objective
	To define the characteristics of asset status (evaluation group 1) and BOI data (evaluation group 2) for asset master data. 
The evaluation groups 1-4 (with 4 characters) are another option for classifying assets for reporting. You can store the characteristics for these groups in the asset master data.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> User Fields -> Define 4-Character Evaluation Groups

	Transaction Code
	OAVA

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	Only evaluation group 1 & 2 have been adopted for Fusion 1 Project (Wave 1).





Screen: Change View “Evaluation Groups for Asset Accounting”: Overview
[image: ]
Configure system as below table
	No.
	Evalat.grps 1-4
	Description

	1
	DONA
	Donation

	
	FOUN
	Found

	
	LOST
	Lost

	
	SALE
	Sales

	
	WOFF
	Write-off

	
	WRTM
	Waiting for Retirement






Key Fields Definitions
	Field Name
	Description

	No.
	Evaluation group number 1-4 served to classify fixed assets as below: 
· Evaluation group 1: Asset Status
· Evaluation group 2: BOI Data
· Evaluation group 3 & 4: not used


	Evalat.grps 1-4
	Evaluation group ID 

	Description
	Evaluation group description


5.2.2 [bookmark: _Toc80015629][bookmark: _Toc107404553]Define 8-Character Evaluation Groups

	Script Description
	Define SubClass for asset master data

	Objective
	To define the characteristics of SubClass for asset master data.
The evaluation groups 5 (with 8 characters) are another option for classifying assets for reporting. You can store the characteristics for these groups in the asset master data.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> User Fields -> Define 8-Character Evaluation Groups

	Transaction Code
	OAV8

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Change View “Evaluation Groups 8 places”: Overview
[image: ]
Configure system as below table
Asset subclass for Fusion 1 Project is configured as listed in Appendix 10: Define SubClass. 
Example:
	Subclass
	Name

	11010001
	Land (IP)

	11010002
	Surplus for Land (IP)

	1101I001
	Impairment#1-Land (IP)

	1101I002
	Impairment#2-Land (IP)

	1101I003
	Impairment#3-Land (IP)

	1101I004
	Impairment#4-Land (IP)

	1101I005
	Impairment#5-Land (IP)

	11020001
	Land (PPE)

	11020002
	Surplus for Land (PPE)

	1102I001
	Impairment#1-Land (PPE)

	1102I002
	Impairment#2-Land (PPE)

	1102I003
	Impairment#3-Land (PPE)

	1102I004
	Impairment#4-Land (PPE)

	1102I005
	Impairment#5-Land (PPE)




Key Fields Definitions
	Field Name
	Description

	SubClass
	SubClass ID

	Name
	SubClass description



[bookmark: _Toc80015630]

5.2.3 [bookmark: _Toc107404554]Change Key Words in the Evaluation Groups
5.2.3.1 [bookmark: _Toc107404555]Change Key Words for Evaluation Group 1

	Script Description
	Change key words in the evaluation group 1 (Asset Status)

	Objective
	To change the SAP standard key words of the evaluation group 1 by assigning your own names to the individual evaluation group.  The system then replaces the SAP standard key words with your key words.  Your names then appear in all screens, in reporting, and in the short text of the field help.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> User Fields -> Change Key Words in the Evaluation Groups -> Change key words for evaluation group 1

	Transaction Code
	OACB

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Define 4-Character Evaluation Groups

	Remark
	This configuration is Workbench



Screen: Change Key Word
[image: ]
Configure system as below table
	Data Element
	Short field label
	Medium Field Label
	Long field label
	Heading
	Short Description

	ORD41
	Status
	Asset Status
	Asset Status
	STAT
	Asset Status






Key Fields Definitions
	Field Name
	Description

	Data Element
	Elementary data type or reference type of the ABAP Dictionary

	Short field label
	Short field label

	Medium Field Label
	Medium field label

	Long field label
	Long field label which is the text displayed on the screen of the user

	Heading	
	Heading to be defined to output the field values in lists. This heading is automatically included in the list header row in the logon language.

	Short Description
	Short description used as an explanatory text in documentation (F1 Help), and when lists are generated.


 
5.2.3.2 [bookmark: _Toc107404556] Change Key Words for Evaluation Group 5

	Script Description
	Change key words for evaluation group 5 (SubClass)

	Objective
	To change the SAP standard key words of the evaluation group 5 by assigning your own names to the individual evaluation group.  The system then replaces the SAP standard key words with your key words.  Your names then appear in all screens, in reporting, and in the short text of the field help.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> User Fields -> Change Key Words in the Evaluation Groups -> Change key words for evaluation group 5

	Transaction Code
	OACF

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Define 8-Character Evaluation Groups

	Remark
	This configuration is Workbench











Screen: Change Key Word
[image: ]
Configure system as below table
	Data Element
	Short field label
	Medium Field Label
	Long field label
	Heading
	Short Description

	GDLGRP
	SubClass
	SubClass
	SubClass
	SCLS
	SubClass






Key Fields Definitions
	Field Name
	Description

	Data Element
	Elementary data type or reference type of the ABAP Dictionary

	Short field label
	Short field label

	Medium Field Label
	Medium field label

	Long field label
	Long field label which is the text displayed on the screen of the user

	Heading	
	Heading to be defined to output the field values in lists. This heading is automatically included in the list header row in the logon language.

	Short Description
	Short description used as an explanatory text in documentation (F1 Help), and when lists are generated.


5.2.4 [bookmark: _Toc80015631][bookmark: _Toc107404557]Enter Your User Fields in Asset Class

	Script Description
	Enter your user fields in asset class

	Objective
	To store the allowed values of user fields that the system is to use as default values when creating fixed assets

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> User Fields -> Enter Your User Fields in Asset Class

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Define Asset Class

	Remark
	N/A





Screen: Change View “FI-AA: User fields for asset class”: Overview
[image: ]
Double click on each Asset Class to maintain values.

Screen: Change View “FI-AA: User fields for asset class”: Details
[image: ]
Configure system as below table



	Class
	Asset Class Description
	Asset Status
	BOI Data
	SubClass

	Z1101
	Land (IP)
	FOUN
	
	11010001

	Z1101I
	Land (IP)-Impairment
	FOUN
	
	

	Z1102
	Land (PPE)
	FOUN
	
	11020001

	Z1102I
	Land (PPE)-Impairment
	FOUN
	
	

	Z1103
	Land awaiting Development
	FOUN
	
	11030001

	Z1103I
	Land awaiting Development-Impairment
	FOUN
	
	

	Z1104A
	Land Improvement (IP) [Admin]
	FOUN
	
	11010001

	Z1104AI
	Land Improvement (IP) [Admin]-Impairment
	FOUN
	
	

	Z1104C
	Land Improvement (IP) [Cost]
	FOUN
	
	11010001

	Z1104CI
	Land Improvement (IP) [Cost]-Impairment
	FOUN
	
	

	Z1105A
	Land Improvement (PPE) [Admin]
	FOUN
	
	11010001

	Z1105AI
	Land Improvement (PPE) [Admin]-Impairment
	FOUN
	
	

	Z1105C
	Land Improvement (PPE) [Cost]
	FOUN
	
	11010001

	Z1105CI
	Land Improvement (PPE) [Cost]-Impairment
	FOUN
	
	

	Z1201A
	Building (IP) [Admin]
	FOUN
	
	

	Z1201AI
	Building (IP) [Admin]-Impairment
	FOUN
	
	

	Z1201C
	Building (IP) [Cost]
	FOUN
	
	

	Z1201CI
	Building (IP) [Cost]-Impairment
	FOUN
	
	

	Z1202A
	Building (PPE) [Admin]
	FOUN
	
	

	Z1202AI
	Building (PPE) [Admin]-Impairment
	FOUN
	
	

	Z1202C
	Building (PPE) [Cost]
	FOUN
	
	

	Z1202CI
	Building (PPE) [Cost]-Impairment
	FOUN
	
	

	Z1203A
	Building Improvement (IP) [Admin]
	FOUN
	
	

	Z1203AI
	Building Improvement (IP) [Admin]-Impairment
	FOUN
	
	

	Z1203C
	Building Improvement (IP) [Cost]
	FOUN
	
	

	Z1203CI
	Building Improvement (IP) [Cost]-Impairment
	FOUN
	
	

	Z1204A
	Building Improvement (PPE) [Admin]
	FOUN
	
	

	Z1204AI
	Building Improvement (PPE) [Admin]-Impairment
	FOUN
	
	

	Z1204C
	Building Improvement (PPE) [Cost]
	FOUN
	
	

	Z1204CI
	Building Improvement (PPE) [Cost]-Impairment
	FOUN
	
	

	Z1205A
	Renovation [Admin]
	FOUN
	
	

	Z1205C
	Renovation [Cost]
	FOUN
	
	

	Z1301C
	Golf Course Development [Cost]
	FOUN
	
	

	Z1301CI
	Golf Course Development [Cost]-Impairment
	FOUN
	
	

	Z2101C
	Machine-Rolling Stock [Cost]
	FOUN
	
	

	Z2102C
	Machine [Cost]
	FOUN
	
	

	Z2201A
	Operating Equipment [Admin]
	FOUN
	
	

	Z2201C
	Operating Equipment [Cost]
	FOUN
	
	

	Z2301A
	Utility & Supply [Admin]
	FOUN
	
	

	Z2301C
	Utility & Supply [Cost]
	FOUN
	
	

	Z3101A
	Furniture & Fixtures [Admin]
	FOUN
	
	

	Z3101C
	Furniture & Fixtures [Cost]
	FOUN
	
	

	Z3201A
	Office Equipment [Admin]
	FOUN
	
	

	Z3201C
	Office Equipment [Cost]
	FOUN
	
	

	Z3301A
	Computer [Admin]
	FOUN
	
	

	Z3301C
	Computer [Cost]
	FOUN
	
	

	Z4101A
	Vehicle [Admin]
	FOUN
	
	

	Z4101C
	Vehicle [Cost]
	FOUN
	
	

	Z5101C
	Digital Advertising [Cost]
	FOUN
	
	

	Z5201A
	Advertising Equipment [Admin]
	FOUN
	
	

	Z5201C
	Advertising Equipment [Cost]
	FOUN
	
	

	Z6101A
	Right of Use Asset-Land [Admin]
	FOUN
	
	61010001

	Z6101AI
	Right of Use Asset-Land [Admin]-Impairment
	FOUN
	
	

	Z6101C
	Right of Use Asset-Land [Cost]
	FOUN
	
	61010001

	Z6101CI
	Right of Use Asset-Land [Cost]-Impairment
	FOUN
	
	

	Z6102A
	Right of Use Asset-Building [Admin]
	FOUN
	
	61020001

	Z6102AI
	Right of Use Asset-Building [Admin]-Impairment
	FOUN
	
	

	Z6102C
	Right of Use Asset-Building [Cost]
	FOUN
	
	61020001

	Z6102CI
	Right of Use Asset-Building [Cost]-Impairment
	FOUN
	
	

	Z6103A
	Right of Use Asset-Equipment [Admin]
	FOUN
	
	61030001

	Z6103AI
	Right of Use Asset-Equipment [Admin]-Impairment
	FOUN
	
	

	Z6103C
	Right of Use Asset-Equipment [Cost]
	FOUN
	
	61030001

	Z6103CI
	Right of Use Asset-Equipment [Cost]-Impairment
	FOUN
	
	

	Z6104A
	Right of Use Asset-Vehicle [Admin]
	FOUN
	
	61040001

	Z6104AI
	Right of Use Asset-Vehicle [Admin]-Impairment
	FOUN
	
	

	Z6104C
	Right of Use Asset-Vehicle [Cost]
	FOUN
	
	61040001

	Z6104CI
	Right of Use Asset-Vehicle [Cost]-Impairment
	FOUN
	
	

	Z8101A
	Software & License [Admin]
	FOUN
	
	

	Z8101C
	Software & License [Cost]
	FOUN
	
	

	Z8102A
	Brand License [Admin]
	FOUN
	
	

	Z8103A
	Not Used
	FOUN
	
	

	Z8104A
	Trademarks [Admin]
	FOUN
	
	

	Z8201C
	Right on Civil to Government [Cost]
	FOUN
	
	

	Z8202A
	Right on Building to Government [Admin]
	FOUN
	
	

	Z8202C
	Right on Building to Government [Cost]
	FOUN
	
	

	Z8203C
	Right on E&M to Government [Cost]
	FOUN
	
	

	Z8301A
	Leasehold Right-Land [Admin]
	FOUN
	
	

	Z8301C
	Leasehold Right-Land [Cost]
	FOUN
	
	

	Z8302A
	Leasehold Right-Building [Admin]
	FOUN
	
	

	Z8302C
	Leasehold Right-Building [Cost]
	FOUN
	
	

	Z8303A
	Leasehold Right-Condo & Fixtures [Admin]
	FOUN
	
	

	Z8303C
	Leasehold Right-Condo & Fixtures [Cost]
	FOUN
	
	

	Z9101
	AuC-Investment Property
	FOUN
	
	91010001

	Z9102
	AuC-Property, Plant and Equipment
	FOUN
	
	91020001

	Z9103
	AuC-Intangible
	FOUN
	
	91030001

	Z9201C
	Spare Parts awaiting Transfer [Cost]
	FOUN
	
	92010001

	Z9701A
	Low Valued Asset (LVA) [Admin]
	FOUN
	
	

	Z9701C
	Low Valued Asset (LVA) [Cost]
	FOUN
	
	

	Z9801
	Dummy for Asset
	FOUN
	
	98010001

	Z9901
	Asset for Consignment
	FOUN
	
	

	Z9902
	Non Valued Asset (NVA)
	FOUN
	
	






Key Fields Definitions
	Field Name
	Description

	Class
	Asset class ID

	Asset Class Description
	Asset class description

	Asset Status
	Asset status (Evaluation Group-1)

	BOI Data
	BOI data (Evaluation Group-2)

	SubClass
	Subclass (Evaluation Group-5)


5.3 [bookmark: _Toc80015632][bookmark: _Toc107404558]Automatic Creation of Equipment Master Records
5.3.1 [bookmark: _Toc80015633][bookmark: _Toc107404559]Specify Conditions for Synchronization of Master Data

	Script Description
	Specify conditions for synchronization of master data

	Objective
	To specify conditions for synchronization of master data for automatically updating the data between equipment master and asset master.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Automatic Creation of Equipment Master Records -> Specify Conditions for Synchronization of Master Data

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A





Screen: Change View “Link from Equipment Category and Object Type to Asset Class”: Overview
[image: ]

Screen: Change View “Link from Equipment Category and Object Type to Asset Class”: Details
[image: ]
[image: ]CN Asset Accounting (AA)
Configure system as below table
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	Class
	Asset Class Description
	EquipCategory
	Edit asset master record – Create equipment
	Edit asset master record – Change equipment
	Edit asset master record – Create equipment
	Edit asset master record – Change equipment

	Z2101C
	Machine-Rolling Stock [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z2102C
	Machine [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z2201A
	Operating Equipment [Admin]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z2201C
	Operating Equipment [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z3101A
	Furniture & Fixtures [Admin]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z3201A
	Office Equipment [Admin]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z3201C
	Office Equipment [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z3301A
	Computer [Admin]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z3301C
	Computer [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z4101A
	Vehicle [Admin]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z4101C
	Vehicle [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z8201C
	Right on Civil to Government [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z9201C
	Spare Parts awaiting Transfer [Cost]
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z9901
	Asset for Consignment
	M
	No synchronization
	2 Direct synchronization after saving
	No synchronization
	2 Direct synchronization after saving

	Z9902
	Non Valued Asset (NVA)
	M
	No synchronization
	2 Direct synchronization after saving

	No synchronization
	2 Direct synchronization after saving
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Key Fields Definitions
	Field Name
	Description

	Class
	Asset class ID

	Asset Class Description
	Asset class description

	EquipCategory
	Equipment category ID for distinguishing individual technical objects according to their use.

	Edit asset master record – Create equipment
	Specifies whether the system automatically creates an equipment master when an asset master is created with possible settings below:
· No synchronization:
When the asset is created, the system does not automatically create an equipment master. However, you can create an equipment master manually.

· 1 - Saving triggers a workflow:
The system does not synchronize the master data, instead it triggers a workflow.

· 2 - Direct synchronization after saving:
When an asset master is created, the system automatically enters an equipment in the asset master. Asset master (such as company code) is copied to the equipment master. Before saving the asset, you can manually delete the equipment from the asset master.

· 3 - Direct synchronization plus workflow:
The system synchronizes the master data, and also triggers a workflow.



	Edit asset master record – Change equipment
	Specifies whether the system automatically adopts changes made to the asset master in the equipment master with possible settings below:
· No synchronization:
When the asset master is changed, the system does not change the equipment master.

· 1 - Saving triggers a workflow:
The system does not synchronize the master data, instead it triggers a workflow.

· 2 - Direct synchronization after saving:
When the asset master is changed, the system automatically changes the equipment master.

· 3 - Direct synchronization plus workflow:
The system synchronizes the master data, and also triggers a workflow.





		

	Edit equipment master record – Create asset
	Specifies whether the system automatically adopts changes made to the asset master in the equipment master with possible settings below:
· No synchronization:
When the equipment is created, the system does not automatically create an asset master. However, you can enter an asset master manually.

· 1 - Saving triggers a workflow:
The system does not synchronize the master data, instead it triggers a workflow.

· 2 - Direct synchronization after saving:
When an equipment master is created, the system automatically enters an asset in the equipment master. Equipment master (such as company code) is copied to the asset master.
Before saving the equipment, you can manually delete the asset from the equipment master.

· 3 - Direct synchronization plus workflow:
The system synchronizes the master data, and also triggers a workflow.



	Edit equipment master record – Change asset
	Specifies whether the system automatically adopts changes made to the asset master in the equipment master with possible settings below:
· No synchronization:
When the equipment master is changed, the system does not change the asset master.

· 1 - Saving triggers a workflow:
The system does not synchronize the master data, instead it triggers a workflow.

· 2 - Direct synchronization after saving:
When the equipment master is changed, the system automatically changes the asset master.

· 3 - Direct synchronization plus workflow:
The system synchronizes the master data, and also triggers a workflow.





[bookmark: _Toc80015634]

5.3.2 [bookmark: _Toc107404560]Assign Master Data Fields of Assets and Equipment

	Script Description
	Assign master data fields of assets and equipment

	Objective
	To specify conditions for synchronization of master data for automatically updating the data between equipment master and asset master.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Automatic Creation of Equipment Master Records -> Assign Master Data Fields of Assets and Equipment

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Change View “Field Assignment between FI-AA and PM”: Overview
[image: ]
Configure system as below table
	Sequence Number
	AA fld
	Description
	PM fld
	Description
	Assignment is active

	5
	BUKRS
	Company Code
	BUKRS
	Company Code
	X

	25
	WERKS
	Plant
	SWERK
	Maintenance Plant
	X

	30
	STORT
	Location
	STORT
	Location
	X






Key Fields Definitions
	Field Name
	Description

	Sequence Number
	Sequence Number provided by SAP standard 

	AA fld
	Integration of FI-AA and PM: field name of asset accounting (FI-AA)

	Description
	Description of field name FI-AA

	PM fld
	Integration of FI-AA and PM: field name of plant maintenance (PM)

	Description
	Description of field name PM

	Assignment is active
	Indicator specifies that, the system automatically changes the fields of linked asset master and equipment master so they correspond, when either of these types of master data is changed or created.


5.4 [bookmark: _Toc80015635][bookmark: _Toc107404561]Specify Time-Independent Management of Organiz. Units

	Script Description
	Specify time-independent management of organiz. units

	Objective
	To specify that the organizational assignments ‘cost center’ are not managed as time-dependent in the asset master record. This means that it is then not possible to define time intervals for these fields for the assignment to different ‘cost centers’ at different times. Once you make this specification, then you can only enter one value for these fields, which is valid in all time intervals.
You need to make this specification if the following applies: You want to be able to change the assignment to a cost center using a simple master data transaction, although you create balance sheets at profit center level. The system then automatically creates a transfer document when you make this master data change to the cost center (and thereby 'profit center').

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Specify Time-Independent Management of Organiz. Units

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A





Screen: Change View “Time-dependent management of organization units”: Overview
[image: ]
Configure system as below table
	CoCd
	Company Name
	Time-Independent Organiz.Units

	1010
	BTSG
	X

	5300
	Rabbit Holdings
	X

	5810
	Kamkoong Property
	X

	8100
	RCASH
	X




Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	Company Name
	Company code description

	Time-Independent Organiz.Units
	If this indicator is set, the system manages the organizational units 'cost center' (and thereby 'profit center') as not time dependent in the asset master records in this company code.
Any change to these organizational units during master data maintenance then automatically generates a transfer posting document.


[bookmark: _Toc80015636]

5.5 [bookmark: _Toc107404562]Define Location

	Script Description
	Define location

	Objective
	To define the locations within a plant. This helps you to identify where a plant entity is located.

	Initial Menu Path
	IMG -> Enterprise Structure -> Definition -> Logistics – General -> Define Location

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Change View “Locations”: Overview
[image: ]
Configure system as below table
Location for Fusion 1 Project is configured as listed in Appendix 11: Define Location. 
Example:


	Plant
	Location
	Name

	2010
	BTS-CEN
	Siam (Central)

	2010
	BTS-N08
	Mo Chit

	2031
	NBM-P01
	Nonthaburi Civic Center (NON)

	2041
	EBM-Y01
	Ratchada Station (RAT)

	
	BLD-208-00
	208 Wireless Road

	
	BLD-42T-00
	42 Tower

	
	BLD-ACR-00
	Anantara Chiang Mai Resort

	
	BLD-ACR-01
	Anantara Chiang Mai Resort/1st Floor

	
	BLD-ACR-02
	Anantara Chiang Mai Resort/2nd Floor

	
	BLD-TST-12
	TST Tower/12th Floor

	
	BLD-BTS-10
	BTS Tower/10th Floor

	
	1001
	เขตพระนคร/กรุงเทพมหานคร

	
	1002
	เขตดุสิต/กรุงเทพมหานคร

	
	1003
	เขตหนองจอก/กรุงเทพมหานคร

	
	1004
	เขตบางรัก/กรุงเทพมหานคร

	
	1005
	เขตบางเขน/กรุงเทพมหานคร




Key Fields Definitions
	Field Name
	Description

	Plant
	Maintenance plant for location pattern ‘A’ (Station) used for BTSC only 

	Location
	Location ID

	Name
	Location description



[bookmark: _Toc80015637]Select Location, then click on [image: ] (Address)



Screen: Edit Address: xxxx
[image: ]
Configure system for all location ID as below table
	Country

	TH



Key Fields Definitions
	Field Name
	Description

	Country
	Country ID 




6 [bookmark: _Toc107404563]Transactions
6.1 [bookmark: _Toc80015638][bookmark: _Toc107404564]Define Transaction Types for Acquisitions

	Script Description
	Define transaction types for asset acquisition

	Objective
	To define transaction type for posting asset acquisition

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Acquisitions -> Define Transaction Types for Acquisitions

	Transaction Code
	AO73

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “FI-AA: Transaction types”: Overview
[image: ]
Configure system as below table
	Transaction Type
	Transaction Type Name

	100
	External asset acquisition

	105
	Credit memo in invoice year

	10I
	Credit Allowance for Asset Impairment



Remark: Transaction Type: 10I is additional customizing for Fusion 1 Project used for posting asset impairment by copying from ‘105’. The rest is SAP standard provided.


Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID 

	Transaction Type Name
	Asset transaction type description



Screen: Change View “FI-AA: Transaction types”: Details
[image: ]
Configure system as below table
	Transaction Type
	Transaction Type Name
	Debit Trans. 
	Credit Trans.
	Capitalize Fixed Asset
	Document Type
	Asset Hist sheet Grp

	100
	External asset acquisition
	X
	
	X
	AA
	10

	105
	Credit memo in invoice year
	
	X
	X
	AA
	10

	10I
	Credit Allowance for Asset Impairment
	
	X
	X
	AA
	10



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID

	Transaction Type Name
	Asset transaction type description

	Debit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default debits in Asset Accounting.

	Credit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default credits in Asset Accounting.

	Capitalize Fixed Asset
	Indicator specifies that the acquisition date and depreciation start date will be set when posting is made.

	Document Type
	Default Document type ID for asset transaction type

	Asset Hist sheet Grp
	Summarize of asset transaction types for asset history sheet group



6.2 [bookmark: _Toc80015639][bookmark: _Toc107404565]Define Transaction Types for Retirements

	Script Description
	Define transaction types for asset retirement

	Objective
	To define transaction type for posting asset retirement

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Retirements -> Define Transaction Types for Retirements

	Transaction Code
	AO74

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “FI-AA: Transaction types”: Overview
[image: ]
Configure system as below table


	Transaction Type
	Transaction Type Name

	200
	Retirement without revenue

	210
	Retirement with revenue

	20D
	Retirement by Donation

	250
	Retirement of current-year acquis., w/o revenue

	260
	Retirement of current-year acquis. with revenue

	25D
	Retirement of current-year acquis. (Donation)



Remark: Transaction Type: 20D and 25D are additional customizing for Fusion 1 Project used for posting asset retirement by donation by copying from ‘200’ and ‘250’ in sequence. The rest is SAP standard provided.

Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID 

	Transaction Type Name
	Asset transaction type description



Screen: Change View “FI-AA: Transaction types”: Details
[image: ]
Configure system as below table


	Transaction Type
	Transaction Type Name
	Deactivate Fixed Asset 
	Document Type
	Retirement with Revenue
	Acquisition in Same Year
	Asset Hist sheet Grp

	200
	Retirement without revenue
	X
	AA
	
	250
	20

	210
	Retirement with revenue
	X
	AA
	X
	260
	Z1

	20D
	Retirement by Donation
	X
	AA
	
	25D
	20

	250
	Retirement of current-year acquis., w/o revenue
	X
	AA
	
	
	25

	260
	Retirement of current-year acquis. with revenue
	X
	AA
	X
	
	Z2

	25D
	Retirement of current-year acquis. (Donation)
	X
	AA
	
	
	25



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID

	Transaction Type Name
	Asset transaction type description

	Deactivate Fixed Asset
	Indicator specifies that the asset will be deactivated when posting is made with results in an acquisition value of zero (in other words, the asset retirement date and status will be set).

	Document Type
	Default Document type ID for asset transaction type

	Retirement with Revenue
	Indicator specifies that revenue amount is always required wen posting a retirement of a fixed asset using this transaction type.

	Acquisition in Same Year
	Asset transaction type for retirement/transfer current-year acquisition in same year. This is necessary for reports, in order to separate the current acquisitions and their depreciation from prior-year acquisitions.

	Asset Hist sheet Grp
	Summarize of asset transaction types for asset history sheet group



[bookmark: _Toc80015640]

6.3 [bookmark: _Toc107404566]Define Transaction Types for Transfers
6.3.1 [bookmark: _Toc107404567]Define Transaction Types for Retirement Transfers

	Script Description
	Define transaction types for asset values transfer for the retirement from the sending asset

	Objective
	To define transaction type for posting transfer asset values. The system requires at least two transaction types for transfers between assets:
· transaction type for the retirement from the sending asset
· transaction type for the acquisition on the receiving asset
The posting transaction is performed from the point of view of the sending asset.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Transfer Postings -> Define Transaction Types for Transfers -> Define Transaction Types for Retirement Transfers

	Transaction Code
	AO76

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “FI-AA: Transaction types”: Overview
[image: ]
Configure system as below table


	Transaction Type
	Transaction Type Name

	300
	Retirement transfer of prior-year acquis. from cap.asset

	320
	Retirement transfer of current-year acquis.



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID 

	Transaction Type Name
	Asset transaction type description



Screen: Change View “FI-AA: Transaction types”: Details
[image: ]
Configure system as below table
	Transaction Type
	Transaction Type Name
	Debit Trans.
	Credit Trans.
	Deactivate Fixed Asset
	Document Type
	Transfer adopting dep. Start date
	TTY Offsetting Entry 
	Acquisition in Same Year
	Asset Hist sheet Grp

	300
	Retirmt transfer of prior-yr acquis. frm cap.asset
	
	X
	X
	AA
	X
	310
	320
	30

	320
	Retirmt transfer of curr-yr acquis.
	
	X
	X
	AA
	X
	330
	
	32



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID

	Transaction Type Name
	Asset transaction type description

	Debit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default debits in Asset Accounting.

	Credit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default credits in Asset Accounting.

	Deactivate Fixed Asset
	Indicator specifies that the asset will be deactivated when posting is made with results in an acquisition value of zero (in other words, the asset retirement date and status will be set).

	Document Type
	Default Document type ID for asset transaction type

	Transfer adopting dep. Start date
	Indicator specifies that the system adopt the historical depreciation start date and capitalization date from the retiring asset when posting asset values transfer.

	TTY Offsetting Entry
	Asset transaction type offsetting entry for transfer

	Acquisition in Same Year
	Asset transaction type for retirement/transfer current-year acquisition in same year. This is necessary for reports, in order to separate the current acquisitions and their depreciation from prior-year acquisitions.

	Asset Hist sheet Grp
	Summarize of asset transaction types for asset history sheet group



6.3.2 [bookmark: _Toc107404568][bookmark: _Toc80015641]Define Transaction Types for Acquisition Transfers

	Script Description
	Define transaction types for asset values transfer for the acquisition on the receiving asset

	Objective
	To define transaction type for posting transfer asset. The system requires two transaction types for transfers between assets:
· transaction type for the retirement from the sending asset
· transaction type for the acquisition on the receiving asset
The posting transaction is performed from the point of view of the receiving asset.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Transfer Postings -> Define Transaction Types for Transfers -> Define Transaction Types for Acquisition Transfers

	Transaction Code
	AO75

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A




Screen: Change View “FI-AA: Transaction types”: Overview
[image: ]
Configure system as below table
	Transaction Type
	Transaction Type Name

	310
	Acquiring transfer of prior-year acquis. from cap.asset

	330
	Acquiring transfer of current-year acquis.



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID 

	Transaction Type Name
	Asset transaction type description





Screen: Change View “FI-AA: Transaction types”: Details
[image: ]
Configure system as below table
	Transaction Type
	Transaction Type Name
	Debit Trans.
	Credit Trans.
	Capitalize Fixed Asset
	Document Type
	Transfer adopting dep. Start date
	Acquisition in Same Year
	Asset Hist sheet Grp

	310
	Acquirg transfer of prior-yr acquis. frm cap.asset
	X
	
	X
	AA
	X
	330
	31

	330
	Acquiring transfer of curr-yr acquis.
	X
	
	X
	AA
	X
	
	33
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[image: ]CN Asset Accounting (AA)


	[image: D:\work\BTS\Template\IAM.png]
	42/149
	Version: 



	[image: D:\work\BTS\Template\IAM.png]
	137/225
	Version: 



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID

	Transaction Type Name
	Asset transaction type description

	Debit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default debits in Asset Accounting.

	Credit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default credits in Asset Accounting.

	Capitalize Fixed Asset
	Indicator specifies that the acquisition date and depreciation start date will be set when posting is made.

	Document Type
	Default Document type ID for asset transaction type

	Transfer adopting dep. Start date
	Indicator specifies that the system adopt the historical depreciation start date and capitalization date from the retiring asset when posting asset values transfer.

	Acquisition in Same Year
	Asset transaction type for retirement/transfer current-year acquisition in same year. This is necessary for reports, in order to separate the current acquisitions and their depreciation from prior-year acquisitions.

	Asset Hist sheet Grp
	Summarize of asset transaction types for asset history sheet group


6.4 [bookmark: _Toc107404569]Capitalization of Assets under Construction
6.4.1 [bookmark: _Toc80015642][bookmark: _Toc107404570]Define Transaction Types for AuC Capitalization

	Script Description
	Define transaction types for capitalization of asset under construction

	Objective
	To define transaction type for capitalizing assets under construction. 

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Capitalization of Assets under Construction -> Define Transaction Types

	Transaction Code
	OAXG

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “FI-AA: Transaction types”: Overview
[image: ]
Configure system as below table
	Transaction Type
	Transaction Type Name

	340
	Retmt transfer of prior-yr acquis f. AuC, line itm

	341
	Acquirg transfer of prior-yr acquis from AuC

	345
	Retmt transfer of curr-yr acquis f. AuC, line itm

	346
	Acquirg transfer of curr-yr acquis. from AuC



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID 

	Transaction Type Name
	Asset transaction type description





Screen: Change View “FI-AA: Transaction types”: Details
[image: ]
Configure system as below table
	Transaction Type
	Transaction Type Name
	Debit Trans.
	Credit Trans.
	Capitalize Fixed Asset
	Deactivate Fixed Asset
	Document Type
	TTY Offsetting Entry
	Acquisition in Same Year
	Asset Hist sheet Grp

	340
	Retmt transfer of prior-yr acquis f. AuC, line itm
	
	X
	
	X
	AA
	341
	345
	34

	341
	Acquirg transfer of prior-yr acquis from AuC
	X
	
	X
	
	AA
	
	346
	35

	345
	Retmt transfer of curr-yr acquis f. AuC, line itm
	
	X
	
	X
	AA
	346
	
	36

	346
	Acquirg transfer of curr-yr acquis. from AuC
	X
	
	X
	
	AA
	
	
	37



Key Fields Definitions
	Field Name
	Description

	Transaction Type
	Asset transaction type ID

	Transaction Type Name
	Asset transaction type description

	Debit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default debits in Asset Accounting.

	Credit Trans.
	Indicator specifies that the transactions posted with this transaction type are posted as default credits in Asset Accounting.

	Capitalize Fixed Asset
	Indicator specifies that the acquisition date and depreciation start date will be set when posting is made.

	Deactivate Fixed Asset
	Indicator specifies that the asset will be deactivated when posting is made with results in an acquisition value of zero (in other words, the asset retirement date and status will be set).

	Document Type
	Default Document type ID for asset transaction type

	TTY Offsetting Entry
	Asset transaction type offsetting entry for transfer

	Acquisition in Same Year
	Asset transaction type for retirement/transfer current-year acquisition in same year. This is necessary for reports, in order to separate the current acquisitions and their depreciation from prior-year acquisitions.

	Asset Hist sheet Grp
	Summarize of asset transaction types for asset history sheet group



6.4.2 [bookmark: _Toc80015643][bookmark: _Toc107404571]Determine Cost Element for Settlement to CO Receiver

	Script Description
	Determine cost element for AuC settlement to CO receiver

	Objective
	To settle an asset with line item management, it is possible to settle debits to CO receivers (particularly cost centers). This might be necessary if debits were capitalized to the asset under construction by mistake. The system requires a cost element in order to make this settlement to CO receivers.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Capitalization of Assets under Construction -> Determine Cost Element for Settlement to CO Receiver

	Transaction Code
	OA89

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Specify Account Determination

	Remark
	Able to maintain via ‘Assign GL Accounts’





Screen: Change View “Chart of Account”: Overview
[image: ]
Select Chart of Accounts, then double click on ‘Account Assignment’

Screen: Change View “Account Determination”: Overview
[image: ]
Select Account Determination for AuC, then double click on ‘Assign Accounts to Areas’



Screen: Change View “Account Accounts to Areas”: Overview
[image: ]
Double click on each Depreciation Area to maintain values.

Screen: Change View “Assign Accounts to Areas”: Details
[image: ]
Configure system as below table


	Chart of Accts
	Account Determ.
	Deprec. area
	Cost elem. for settlement AuC to CO Objects

	1000
	Z9101
	01
	6150099960 

	
	
	02
	6150099960 

	
	
	03
	6150099960 

	
	Z9102
	01
	6150099960 

	
	
	02
	6150099960 

	
	
	03
	6150099960 

	
	Z9103
	01
	6150099960 

	
	
	02
	6150099960 

	
	
	03
	6150099960 



Remark: For Fusion 1 Project (Wave 1), cost element for settlement AuC to CO object is 6150099960 (Settlement Clearing) 

Key Fields Definitions
	Field Name
	Description

	Chart of Accts
	Chart of Accounts ID

	Account Determ.
	Account Determination ID

	Deprec. area
	Depreciation Area ID

	Cost elem. for settlement AuC to CO Objects
	Cost element for settlement AuC to CO Object


[bookmark: _Toc80015644]

6.4.3 [bookmark: _Toc107404572]Define Settlement Profiles

	Script Description
	Define AuC settlement profile

	Objective
	To define settlement profile for assets under construction 

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Capitalization of Assets under Construction -> Define Settlement Profiles

	Transaction Code
	OKO7

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Settlement Profile”: Overview
[image: ]
Configure system as below table
	Settlement Profile
	Text

	AI
	Settlement Asset under Constr.



Key Fields Definitions
	Field Name
	Description

	Settlement Profile
	AuC settlement profile ID

	Text
	AuC settlement profile description





Screen: Change View “Settlement Profile”: Details
[image: ]
Configure system as below table:
	
	Value
	Description

	Settlement Profile

	Settlement Profile
	AI
	Settlement Asset under Constr.

	Actual Costs/Cost Sales

	To be Settle in Full
	X
	

	Default Values

	Default Object Type
	FXA
	Asset

	Valid Receivers

	Fixed Asset
	1
	Settlement Optional

	Cost Center
	1
	Settlement Optional

	Indicators

	% Settlement
	X
	

	Equivalence Numbers
	X
	

	Amount Settlement
	X
	

	Other Parameters

	Document Type
	AA
	Asset Posting





Key Fields Definitions
	Field Name
	Description

	Settlement Profile
	Settlement profile ID

	Description
	Settlement profile description

	Actual Costs/Cost Sales
	Controls whether actual costs to be settled.
· To be settled in full which is default for AuC settlement profile
· Can be settled 
· Not for settlement

	Default Object Type
	Default settlement object available for this settlement profile.

	Valid Receivers
	Specifies valid receiver whether costs can be settled to.
· Settlement not allowed: Do not allow settlement to receivers.
· 1 - Settlement Option: Allow settlement to receivers.
· 2 - Settlement Required: At least one settlement rule to have a receiver.

	%-Settlement
	If this indicator is set, you can use the settlement rule to determine the distribution rules by the percentage of costs to be settled.

	Equivalence Numbers
	If this indicator is set, you can define distribution rules in the settlement rule, according to which costs are settled proportionally.

	Amount Settlement
	If this indicator is set, you can define distribution rules in the settlement rule, which allow costs to be settled by amount.

	Indicators
	Assignment contains Source, Assessment Cost Element, Settlement cost elements

	Document Type 
	Default document type for AuC settlement 


6.4.4 [bookmark: _Toc107404573]Assign Settlement Profiles to Company Code 

	Script Description
	Assign settlement profiles

	Objective
	To assign AuC settlement profile to each company code

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Capitalization of Assets under Construction -> Assign Settlement Profiles

	Transaction Code
	OAAZ

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Define Settlement Profiles

	Remark
	N/A





Screen: Change View “FI-AA Settlement Profile”: Overview
[image: ]
Configure system as below table
	Cocd
	Company Name
	SProf.
	Text

	1010
	BTSG
	AI
	Settlement Asset under Constr.

	1020
	Yongsu
	AI
	Settlement Asset under Constr.

	2010
	BTSC
	AI
	Settlement Asset under Constr.

	2020
	BIS
	AI
	Settlement Asset under Constr.

	2030
	NBM
	AI
	Settlement Asset under Constr.

	2040
	EBM
	AI
	Settlement Asset under Constr.

	2050
	BID
	AI
	Settlement Asset under Constr.

	3010
	VGI
	AI
	Settlement Asset under Constr.

	3020
	888
	AI
	Settlement Asset under Constr.

	3030
	VGI Advertising Media
	AI
	Settlement Asset under Constr.

	3040
	POV
	AI
	Settlement Asset under Constr.

	5010
	DNAL
	AI
	Settlement Asset under Constr.

	5020
	The Community One
	AI
	Settlement Asset under Constr.

	5030
	The Community Two
	AI
	Settlement Asset under Constr.

	5040
	Kingkaew Assets
	AI
	Settlement Asset under Constr.

	5050
	Mochit Land
	AI
	Settlement Asset under Constr.

	5060
	CAPRICORN HILL
	AI
	Settlement Asset under Constr.

	5300
	U City
	AI
	Settlement Asset under Constr.

	5310
	U Global
	AI
	Settlement Asset under Constr.

	5320
	TANAYONG HONG KONG
	AI
	Settlement Asset under Constr.

	5500
	EGS ASSETS
	AI
	Settlement Asset under Constr.

	5510
	Muangthong Assets
	AI
	Settlement Asset under Constr.

	5520
	Nine Square Property
	AI
	Settlement Asset under Constr.

	5530
	MAK8
	AI
	Settlement Asset under Constr.

	5540
	BTS Land
	AI
	Settlement Asset under Constr.

	5550
	Rong Pasee Roi Chak Sam
	AI
	Settlement Asset under Constr.

	5560
	KHONKAENBURI
	AI
	Settlement Asset under Constr.

	5610
	BOONBARAMEE METTA
	AI
	Settlement Asset under Constr.

	5620
	Pacific Hotel Chiangmai
	AI
	Settlement Asset under Constr.

	5630
	Pacific Chiangmai Co.,Ltd
	AI
	Settlement Asset under Constr.

	5800
	UNISON One
	AI
	Settlement Asset under Constr.

	5810
	Kamkoong Property
	AI
	Settlement Asset under Constr.

	5840
	Prime Area Retail
	AI
	Settlement Asset under Constr.

	5850
	U Remix
	AI
	Settlement Asset under Constr.

	5900
	TANAYONG PROPERTY
	AI
	Settlement Asset under Constr.

	5910
	Thana City Golf
	AI
	Settlement Asset under Constr.

	6200
	PROJECT GREEN
	AI
	Settlement Asset under Constr.

	6210
	SIAM PAGING
	AI
	Settlement Asset under Constr.

	6220
	TANAYONG FOOD & BEVERAGE
	AI
	Settlement Asset under Constr.

	6230
	PrannaKiri Assets
	AI
	Settlement Asset under Constr.

	6240
	Ratburana Property
	AI
	Settlement Asset under Constr.

	6250
	NPARK GLOBAL
	AI
	Settlement Asset under Constr.

	6260
	Phraram 9 Alliance
	AI
	Settlement Asset under Constr.

	6270
	Prime Area 12
	AI
	Settlement Asset under Constr.

	7010
	Prime Area 38
	AI
	Settlement Asset under Constr.

	7500
	KEYSTONE ESTATE
	AI
	Settlement Asset under Constr.

	7900
	Rabbit Life Insurance
	AI
	Settlement Asset under Constr.

	8020
	RR
	AI
	Settlement Asset under Constr.

	8030
	BPS
	AI
	Settlement Asset under Constr.

	8040
	BSSH
	AI
	Settlement Asset under Constr.

	8050
	RPS
	AI
	Settlement Asset under Constr.

	8090
	RBS
	AI
	Settlement Asset under Constr.

	8100
	RCASH
	AI
	Settlement Asset under Constr.

	8200
	HHT
	AI
	Settlement Asset under Constr.

	8300
	T23
	AI
	Settlement Asset under Constr.

	8310
	T1
	AI
	Settlement Asset under Constr.

	8330
	T3
	AI
	Settlement Asset under Constr.

	8340
	T4
	AI
	Settlement Asset under Constr.

	8350
	T5
	AI
	Settlement Asset under Constr.

	8360
	T6
	AI
	Settlement Asset under Constr.

	8370
	T7
	AI
	Settlement Asset under Constr.

	8380
	T8
	AI
	Settlement Asset under Constr.

	8390
	T9
	AI
	Settlement Asset under Constr.

	8400
	T10
	AI
	Settlement Asset under Constr.





Key Fields Definitions
	Field Name
	Description

	Cocd
	Company code ID

	Company Name
	Company code description

	SProf.
	AuC settlement profile ID

	Text
	AuC settlement profile description


6.5 [bookmark: _Toc80015645][bookmark: _Toc107404574]Specify Default Transaction Types

	Script Description
	Specify default transaction types for asset transaction

	Objective
	To determine the transaction types that the system sets as defaults for the standard posting transactions of Asset Accounting.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Specify Default Transaction Types

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Default transaction types for FI-AA posting transaction”
[image: ]
Configure system as below table


	Acct. Transaction ID
	Description
	TType
	Transact. Type Text

	ABAO
	Asset sale without customer
	210
	Retirement with revenue

	ABAV
	Asset retirement by scrapping
	200
	Retirement without revenue

	ABGL
	Enter credit memo in year of invoice
	10I
	Credit Allowance for Asset Impairment

	ABUM
	Transfer From
	300
	Retirmt transfer of prior-yr acquis. frm cap.asset

	ABZO
	Asset acquis. autom. offset. posting
	100
	External asset acquisition



Key Fields Definitions
	Field Name
	Description

	Acct. Transaction ID
	Asset posting transaction ID

	Description
	Asset posting transaction description

	TType
	Asset transaction type ID 

	Transact. Type Text
	Asset transaction type description


6.6 [bookmark: _Toc80015646][bookmark: _Toc107404575]Determine Transaction Types for Internal Transactions

	Script Description
	Determine transaction types for internal transactions

	Objective
	To determine the transaction types that the system uses for postings
· which are initiated in other R/3 modules such as, Acquisition from invoice receipt, PS Settlement
· that are initiated automatically such as, Depreciation

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Determine Transaction Types for Internal Transactions

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A





Screen: Change View “Default transaction types”: Overview
[image: ]
Configure system as below table
	Transaction Name
	Tra
	Transaction Type Name

	Retirement
	210
	Retirement with revenue

	Post depreciation
	500
	Post depreciation

	Retirement w/o revenue
	200
	Retirement without revenue

	Settlement of old data from AuC
	340
	Retmt transfer of prior-yr acquis f. AuC, line itm

	Acquisition final settlement from CO
	116
	Acquisition - internal settlement to AuC

	Acquisition from invoice receipt
	100
	External asset acquisition

	External asset acquisition
	100
	External asset acquisition



Key Fields Definitions
	Field Name
	Description

	Transaction Name
	Asset transaction name

	Tra
	Asset transaction type ID 

	Transaction Type Name
	Asset transaction type description



6.7 [bookmark: _Toc80015647][bookmark: _Toc107404576]Specify How Default Asset Value Date is Determined
6.7.1 [bookmark: _Toc107404577]Define Variant for Determining Default Asset Value Date

	Script Description
	Define variant for determining default asset value date

	Objective
	To define which rules the system should use in each company code when determining the “Default asset value date” when posting asset transactions. A variant for determining the asset value date consists of a complete set of such rules for all transactions.  

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Specify How Default Asset Value Date is Determined -> Define variant for determining default asset value date

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A 

	Remark
	N/A



Screen: Change View “Variants”: Overview
[image: ]
Select variant: SAP_DEFAULT (Used when no variant assigned to company code), then double click on ‘Business Transaction’ 
Remark: Variant: SAP_DEFAULT is SAP standard provided.



Screen: Change View “Variants”: Overview
[image: ]
Configure system as below table
	Name of transaction
	Prim.Rule
	Alt.Rule

	Current-value depreciation
	9
	4

	Retirement
	1
	

	Settlement of AuC
	2
	

	Acquisition posting for settlement of AuC
	2
	

	Credit memo related to invoice
	12
	2

	Acquisition from settlement
	2
	

	Invoice receipt for purchase order
	12
	2

	Invoice receipt w/o purchase order
	9
	4

	Acquisition
	9
	4





Key Fields Definitions
	Field Name
	Description

	Name of transaction
	Asset transaction name

	Prim.Rule
	Primary rule for setting the asset value date which can use the following values:
01 = To be entered manually
02 = Posting date
03 = Document date
04 = Earlier of either document or posting date (if different fiscal year: posting date)
05 = First day of period
06 = First day of fiscal year
07 = User-specif. fixed date
08 = Current date
09 = Capitalization date
10 = Date of last retirement
11 = First day after last retirement
12 = Posting date, goods receipt
14 = Date of revaluation measure



	Alt.Rule
	Alternative rule for setting the asset value date which can use the following values:
01 = To be entered manually
02 = Posting date
03 = Document date
04 = Earlier of either document or posting date (if different fiscal year: posting date)
05 = First day of period
06 = First day of fiscal year
07 = User-specif. fixed date
08 = Current date
09 = Capitalization date
10 = Date of last retirement
11 = First day after last retirement
12 = Posting date, goods receipt
14 = Date of revaluation measure







[bookmark: _Toc107404578]6.7.2 Assign Value Date Variant to Company Code

	Script Description
	Assign asset value date variant to company code

	Objective
	To assign asset value date variant to each company code. You can assign one variant for determining asset value date to each asset company code. If do not make any assignment of this kind, the system will automatically use the "SAP_DEFAULT" variant.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Specify How Default Asset Value Date is Determined -> Assign value date variant to company code

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Define variant for determining default asset value date 

	Remark
	If you do not make any assignment of this kind, the system will automatically use the variant: SAP_DEFAULT.



Screen: Change View “Variants”: Overview
[image: ]
Configure system as below table


	CoCd
	Company Name
	Variant
	Variant Description

	1010
	BTSG
	
	

	1020
	Yongsu
	
	

	2010
	BTSC
	
	

	2020
	BIS
	
	

	2030
	NBM
	
	

	2040
	EBM
	
	

	2050
	BID
	
	

	3010
	VGI
	
	

	3020
	888
	
	

	3030
	VGI Advertising Media
	
	

	3040
	POV
	
	

	5010
	DNAL
	
	

	5020
	The Community One
	
	

	5030
	The Community Two
	
	

	5040
	Kingkaew Assets
	
	

	5050
	Mochit Land
	
	

	5060
	CAPRICORN HILL
	
	

	5300
	U City
	
	

	5310
	U Global
	
	

	5320
	TANAYONG HONG KONG
	
	

	5500
	EGS ASSETS
	
	

	5510
	Muangthong Assets
	
	

	5520
	Nine Square Property
	
	

	5530
	MAK8
	
	

	5540
	BTS Land
	
	

	5550
	Rong Pasee Roi Chak Sam
	
	

	5560
	KHONKAENBURI
	
	

	5610
	BOONBARAMEE METTA
	
	

	5620
	Pacific Hotel Chiangmai
	
	

	5630
	Pacific Chiangmai Co.,Ltd
	
	

	5800
	UNISON One
	
	

	5810
	Kamkoong Property
	
	

	5840
	Prime Area Retail
	
	

	5900
	TANAYONG PROPERTY
	
	

	5910
	Thana City Golf
	
	

	6200
	PROJECT GREEN
	
	

	6210
	SIAM PAGING
	
	

	6220
	TANAYONG FOOD & BEVERAGE
	
	

	6230
	PrannaKiri Assets
	
	

	6240
	Ratburana Property
	
	

	6250
	NPARK GLOBAL
	
	

	6260
	Phraram 9 Alliance
	
	

	6270
	Prime Area 12
	
	

	7010
	Prime Area 38
	
	

	7500
	KEYSTONE ESTATE
	
	

	7510
	Keystone Management
	
	

	7900
	Keystone Management
	
	

	8020
	RR
	
	

	8030
	BPS
	
	

	8040
	BSSH
	
	

	8050
	RPS
	
	

	8090
	RBS
	
	

	8100
	RCASH
	
	

	8200
	HHT
	
	

	8300
	T23
	
	

	8310
	T1
	
	

	8330
	T3
	
	

	8340
	T4
	
	

	8350
	T5
	
	

	8360
	T6
	
	

	8370
	T7
	
	

	8380
	T8
	
	

	8390
	T9
	
	

	8400
	T10
	
	




Key Fields Definitions
	Field Name
	Description

	CoCd
	Company Code ID

	Company Name
	Company code description

	Variant
	Variant ID

	Variant Description
	Variant ID description


[bookmark: _Toc80015648]

6.8 [bookmark: _Toc107404579]Maintain Message Types
6.8.1 [bookmark: _Toc107404580]Maintain Message Types for Asset Accounting

	Script Description
	Maintain message types for asset accounting

	Objective
	To set the message type (error, warning, note, switch off) for selected messages in the area of asset accounting posting. The messages are then sorted by application area, which you can recognize on the basis of the messages that appear.
The message has to be set up as configurable. This includes the value range of the allowed message types, as well as a standard message type. 

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Transactions -> Maintain Message Types

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Display View “Message Classes”: Overview
[image: ]
Select Application Area, then double click on ‘Message’. For Fusion 1 Project, the standard message in this following application area has been changed.
· AC: Error messages from Asset Customizing



Screen: Change View “Message”: Overview
[image: ]
Configure system as below table
	Area
	MsgNo
	Message Text
	User
	Online
	Batchl
	Standard

	AC
	305
	Account &3-&1 not allowed to be balance sheet account
	
	W
	W
	E

	AC
	306
	Account &3-&1 not defined as P&L account
	
	W
	W
	E



Key Fields Definitions
	Field Name
	Description

	Area
	Application area ID

	MsgNo
	Message ID

	Message Text
	Message description

	User
	User ID to be valid for message control

	Online
	Active message type for online transaction which can specify the following values:
· E: Error message
· W: Warning message
· I: Note in window
· -: Switch off message







	Batchl
	Active message type for batch input without online which can specify the following values:
· E: Error message
· W: Warning message
· I: Note in window
· -: Switch off message


	Standard
	SAP standard message types


6.8.2 [bookmark: _Toc107404581]Maintain Message Types for Financial Accounting

	Script Description
	Maintain message types for financial accounting

	Objective
	To set the message type (error, warning, note, switch off) for selected messages in the area of financial accounting posting. The messages are then sorted by application area, which you can recognize on the basis of the messages that appear.
The message has to be set up as configurable. This includes the value range of the allowed message types, as well as SAP standard message type.

	Initial Menu Path
	IMG -> Financial Accounting -> Financial Accounting Global Settings -> Tools -> Change Message Control

	Transaction Code
	OBA5

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Edit Table Views: Initial Screen
[image: ]
Enter the Application Area to be changed. For Fusion 1 Project, the SAP standard message in these following application areas has been changed.
· AW: AuC messages
· F5: Document Editing

Screen: Change View “Message Control by User”: Overview
[image: ]
Configure system as below table
	Area
	MsgNo
	Message Text
	User
	Online
	Batchl
	Standard

	AW
	851
	Asset &1: no subnumber with FM assignment &2
	
	W
	W
	E

	F5
	378
	Purchase document is allocated to asset & &
	
	W
	W
	E



Key Fields Definitions
	Field Name
	Description

	Area
	Application area ID

	MsgNo
	Message ID

	Message Text
	Message description

	User
	User ID to be valid for message control




	Online
	Active message type for online transaction which can specify the following values:
· E: Error message
· W: Warning message
· I: Note in window
· -: Switch off message


	Batchl
	Active message type for batch input without online which can specify the following values:
· E: Error message
· W: Warning message
· I: Note in window
· -: Switch off message


	Standard
	SAP standard message type
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7 [bookmark: _Toc107404582]Information System
7.1 [bookmark: _Toc80015650][bookmark: _Toc107404583]Define Sort Versions for Asset Reports

	Script Description
	Define sort versions for asset reports

	Objective
	To define sort version which determines the sort keys and summation criteria for your asset reports. (Such as, asset balance report)

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Information System -> Define Sort Versions for Asset Reports

	Transaction Code
	OAVI

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Change View “Sort Version for Asset Reporting”: Overview
[image: ]
Configure system as below table
	Sort Vers.
	Explanation

	0002
	Co code/ plant / cost center

	0007
	Co. code / asset class

	0010
	Co. code / asset class / location

	0014
	Cost center

	Z001
	Co. code / Asset Class / BS acccount

	Z002
	CoCd/Description2/Quantity/Scrap


Remark: Sort Version that start with Z is additional customizing for Fusion 1 Project and the rest is SAP standard provided. 

Key Fields Definitions
	Field Name
	Description

	Sort Vers.
	Sort version ID

	Description
	Sort version description



Screen: Change View “Sort Version for Asset Reporting”: Overview
[image: ]
Configure system as below table
	Sort Vers.
	Description
	Table
	Field Name
	Offs.
	Lng
	Total
	Statistics
	Page

	0002
	Co code/ plant / cost center
	ANLAV
	BUKRS
	
	
	X
	
	

	
	
	ANLAV
	WERKS
	
	
	X
	
	

	
	
	ANLAV
	KOSTL
	
	
	X
	
	X

	0007
	Co. code / asset class
	ANLAV
	BUKRS
	
	
	X
	
	

	
	
	ANLAV
	ANLKL
	
	
	X
	
	X

	0010
	Co. code / asset class / location
	ANLAV
	BUKRS
	
	
	X
	
	

	
	
	ANLAV
	ANLKL
	
	
	X
	
	

	
	
	ANLAV
	STORT
	
	
	X
	
	X


	0014
	Cost center
	ANLAV
	KOSTL
	
	
	X
	
	X

	Z001
	Co. code / Asset Class / BS acccount
	ANLAV
	BURKS
	
	
	X
	
	

	
	
	ANLAV
	ANLKL
	
	
	X
	
	X

	
	
	ANLAV
	KTANSW
	
	
	X
	
	

	Z002
	CoCd/Description2/Quantity/Scrap
	ANLAV
	BUKRS
	
	
	X
	
	

	
	
	ANLAV
	ANLKL
	
	
	X
	
	

	
	
	ANLAV
	TXA50
	
	
	X
	
	

	
	
	ANLAV
	MENGE
	
	
	X
	
	

	
	
	ANLB
	SCHRW
	
	
	X
	
	



Key Fields Definitions
	Field Name
	Description

	Sort Vers.
	Sort version ID

	Description
	Sort version description

	Table
	Table name

	Field Name
	Field name

	Offs.
	The number you enter an offset here, the field specified goes into the sort version only after this offset (in relation to the beginning of the field).

	Lng
	The length you enter here determines the length of the field in the sort version.

	Total
	Set this indicator, if you want values to be totaled at this sort level for reports using this sort version.

	Statistics
	By setting this indicator, you can further break down the totals in a sort level. At the present time, the totals can be broken down by Transaction types in asset transaction reports

	Page
	Set this indicator for the sort level, at which you want a page break in the printed version of the list. The system then makes a page break as soon as the sort level has new field contents.


[bookmark: _Toc80015651]

7.2 [bookmark: _Toc107404584]Asset History Sheet
7.2.1 [bookmark: _Toc80015653][bookmark: _Toc107404585][bookmark: _Toc80015652]Define History Sheet Groups

	Script Description
	Define history sheet groups to be used for history sheet version

	Objective
	To define the individual history sheet groups in this section. You classify transaction types for the definition of history sheet groups by assigning them to a history sheet group.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Information System -> Asset History Sheet -> Define History Sheet Groups

	Transaction Code
	OAV9

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Change View “Asset History Group and Name”: Overview
[image: ]
Configure system as below table


	Grp
	Name of Asset Hist. Sheet Grp

	10
	Acquisition

	20
	Retirement

	25
	Retirement of curr-yr acquisition

	30
	Retirmt transfer of prior-yr acquis.

	31
	Acquiring transfer of prior-yr acquis.

	32
	Retirmt transfer of curr-yr acquis.

	33
	Acquiring transfer of curr-yr acquis.

	34
	Retirmt transfer of prior-yr acquis. from AuC

	35
	Acquiring transfer of prior-yr acquis. from AuC

	36
	Retirmt transfer of curr-yr acquis. from AuC

	37
	Acquiring transfer of curr-yr acquis. from AuC

	YA
	Accum.values as of FY start (History sheet)

	YY
	Annual values (History sheet)

	YZ
	Accum.values as of FY end (History sheet)

	Z1
	Sales

	Z2
	Sales of curr-yr acquisition

	Z3
	Surplus

	Z4
	Surplus of curr-yr acquisition



Remark: History Sheet Group: Z1 and Z2 are additional customizing for Fusion 1 Project that used for grouping the asset retirement with revenue transaction (Asset Sales) for Transaction Type: 210 (Retirement with revenue) and Transaction Type: 260 (Retirement of current-year acquis. with revenue). The rest is SAP standard provided

Key Fields Definitions
	Field Name
	Description

	Grp
	Asset history sheet group ID for summarizing of asset transaction types for asset history sheet

	Name of Asset Hist. Sheet Grp
	Asset history sheet group description




7.2.2 [bookmark: _Toc107404586]Define History Sheet Versions

	Script Description
	Define history sheet version

	Objective
	To define the individual asset history sheet versions in this section.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Information System -> Asset History Sheet -> Define History Sheet Version

	Transaction Code
	OA79

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	Define history sheet groups

	Remark
	N/A



Screen: Choose Asset History Sheet Version
[image: ]
Remark: History Sheet Version: Z001 is additional customizing for Fusion 1 Project which is used for customizing report: ZAAR007 - Asset Movement Report
Configure system as below table
	Language
	Hist.Sht.Vers.
	Asset History Sheet Name

	EN
	Z001
	Fusion1: Asset Movement



Key Fields Definitions
	Field Name
	Description

	Language
	Language ID

	Hist.Sht.Vers
	Asset history sheet version ID

	Asset History Sheet Name
	Asset history sheet version description



Screen: Maintain Asset History Sheet Version: EN Z001
[image: ]
Configure system as below table
	Ast.Hist.Sht.Version
	Ast.Hist.Sht.Version Description
	Line
	Column
	Column Name

	Z001
	Fusion1: Asset Movement
	01
	00
	Acq.Cost B/F

	
	
	01
	10
	Acq.Cost

	
	
	01
	20
	Write-off

	
	
	01
	30
	Sales

	
	
	01
	40
	Acq.from AuC

	
	
	01
	50
	Retire.AuC

	
	
	01
	60
	Transfer-In

	
	
	01
	99
	Acq.Cost C/F

	
	
	02
	00
	Accum.Dep.B/F

	
	
	02
	10
	Depreciation

	
	
	02
	60
	Transfer-Out

	
	
	02
	99
	Accuml.Dep.C/F

	
	
	03
	10
	Bk.val. B/F

	
	
	03
	99
	Book.Val.C/F

	
	
	04
	10
	Revaluation



Key Fields Definitions
	Field Name
	Description

	Ast.Hist.Sht.Version
	Asset history sheet version ID

	Ast.Hist.Sht.Version Description
	Asset history sheet version description

	Line
	Line number of asset history sheet transaction starting from 01 to 99

	Column
	Column number of asset history sheet transaction starting from 01 to 98. Fixed column by the system is Column 00: Initial values and Column 99: Final values

	Column Name
	Column description in asset history sheet report



Screen: Maintain Asset History Sheet Version: EN Z001
[image: ]
Configure system as below table
	Version
	Line
	Column
	Hist.Sht.Item
	Grp
	Name of Asset Hist. Sheet Group
	Trn
	Ord

	Z001
	01
	00
	Acq.Cost B/F
	YA
	Accum.values as of FY start (History sheet)
	X
	

	
	
	10
	Acq.Cost
	10
	Acquisition
	X
	

	
	
	20
	Write-off
	20
	Retirement
	X
	

	
	
	
	
	25
	Retirement of curr-yr acquisition
	X
	

	
	
	30
	Sales
	Z1
	Sales
	X
	

	
	
	
	
	Z2
	Sales of curr-yr acquisition
	X
	

	
	
	40
	Acq.from AuC
	35
	Acquiring transfer of prior-yr acquis. from AuC
	X
	

	
	
	
	
	37
	Acquiring transfer of curr-yr acquis. from AuC
	X
	

	
	
	50
	Retire.AuC
	34
	Retirmt transfer of prior-yr acquis. from AuC
	X
	

	
	
	
	
	36
	Retirmt transfer of curr-yr acquis. from AuC
	X
	

	
	
	60
	Transfer-In
	31
	Acquiring transfer of prior-yr acquis.
	X
	

	
	
	
	
	33
	Acquiring transfer of curr-yr acquis.
	X
	

	
	
	99
	Acq.Cost C/F
	YZ
	Accum.values as of FY end (History sheet)
	X
	

	
	02
	00
	Accum.Dep.B/F
	YA
	Accum.values as of FY start (History sheet)
	
	X
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	10
	Depreciation
	10
	Acquisition
	
	X

	
	
	
	
	31
	Acquiring transfer of prior-yr acquis.
	
	X

	
	
	
	
	33
	Acquiring transfer of curr-yr acquis.
	
	X

	
	
	
	
	YY
	Annual values  (History sheet)
	
	X

	
	
	20
	Dep.Write-off
	20
	Retirement
	
	X

	
	
	
	
	25
	Retirement of curr-yr acquisition
	
	X

	
	
	
	
	30
	Retirmt transfer of prior-yr acquis.
	
	X

	
	
	
	
	32
	Retirmt transfer of curr-yr acquis.
	
	X

	
	
	30
	Dep.Sales.
	Z1
	Sales
	
	X

	
	
	
	
	Z2
	Sales of curr-yr acquisition
	
	X

	
	
	60
	Transfer-Out
	30
	Retirmt transfer of prior-yr acquis.
	X
	

	
	
	
	
	32
	Retirmt transfer of curr-yr acquis.
	X
	

	
	
	99
	Accuml.Dep.C/F
	YZ
	Accum.values as of FY end (History sheet)
	
	X

	
	03
	10
	Bk.val. B/F
	YA
	Accum.values as of FY start (History sheet)
	X
	X

	
	
	99
	Book.Val.C/F
	YZ
	Accum.values as of FY end (History sheet)
	X
	X



Key Fields Definitions
	Field Name
	Description

	Version
	Asset history sheet version ID

	Line
	Line number of asset history sheet transaction starting from 01 to 99

	Column
	Column number of asset history sheet transaction starting from 01 to 98. Fixed column by the system is Column 00: Initial values and Column 99: Final values

	Hist.Sht.Item
	Column description in asset history sheet report

	Grp
	Asset history sheet group ID for summarizing of asset transaction types for asset history sheet

	Name of Asset Hist. Sheet Group
	Asset history sheet group description

	Trn
	Indicator specifies that the transaction values for this transaction type group flow directly into the currently selected asset history sheet item.

	Ord
	Indicator specifies that the proportional accumulated depreciation for this depreciation type (ordinary depreciation) and for this transaction type group is taken over into the currently selected asset history sheet item.


7.3 [bookmark: _Toc107404587]Assign Asset Class/History Report

	Script Description
	Assign form for asset history report (asset chart)

	Objective
	To you assign asset history sheet form (standard) for the evaluation "Asset history" (asset chart) in the Asset Accounting.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Information System -> Define or Assign Forms -> Assign asset class/history sheet

	Transaction Code
	OAAY

	Configuration to PRD
	Via transport request 

	Prerequisite Step
	N/A

	Remark
	N/A





Screen: Change View “Asset class: Assignment of form for history”: Overview
[image: ]
Configure system as below table
	Class
	Asset Class Description
	Layout set name

	Z1101
	Land (IP)
	FIAA_F001

	Z1101I
	Land (IP)-Impairment
	FIAA_F001

	Z1102
	Land (PPE)
	FIAA_F001

	Z1102I
	Land (PPE)-Impairment
	FIAA_F001

	Z1103
	Land awaiting Development
	FIAA_F001

	Z1103I
	Land awaiting Development-Impairment
	FIAA_F001

	Z1104A
	Land Improvement (IP) [Admin]
	FIAA_F001

	Z1104AI
	Land Improvement (IP) [Admin]-Impairment
	FIAA_F001

	Z1104C
	Land Improvement (IP) [Cost]
	FIAA_F001

	Z1104CI
	Land Improvement (IP) [Cost]-Impairment
	FIAA_F001

	Z1105A
	Land Improvement (PPE) [Admin]
	FIAA_F001

	Z1105AI
	Land Improvement (PPE) [Admin]-Impairment
	FIAA_F001

	Z1105C
	Land Improvement (PPE) [Cost]
	FIAA_F001

	Z1105CI
	Land Improvement (PPE) [Cost]-Impairment
	FIAA_F001

	Z1201A
	Building (IP) [Admin]
	FIAA_F001

	Z1201AI
	Building (IP) [Admin]-Impairment
	FIAA_F001

	Z1201C
	Building (IP) [Cost]
	FIAA_F001

	Z1201CI
	Building (IP) [Cost]-Impairment
	FIAA_F001

	Z1202A
	Building (PPE) [Admin]
	FIAA_F001

	Z1202AI
	Building (PPE) [Admin]-Impairment
	FIAA_F001

	Z1202C
	Building (PPE) [Cost]
	FIAA_F001

	Z1202CI
	Building (PPE) [Cost]-Impairment
	FIAA_F001

	Z1203A
	Building Improvement (IP) [Admin]
	FIAA_F001

	Z1203AI
	Building Improvement (IP) [Admin]-Impairment
	FIAA_F001

	Z1203C
	Building Improvement (IP) [Cost]
	FIAA_F001

	Z1203CI
	Building Improvement (IP) [Cost]-Impairment
	FIAA_F001

	Z1204A
	Building Improvement (PPE) [Admin]
	FIAA_F001

	Z1204AI
	Building Improvement (PPE) [Admin]-Impairment
	FIAA_F001

	Z1204C
	Building Improvement (PPE) [Cost]
	FIAA_F001

	Z1204CI
	Building Improvement (PPE) [Cost]-Impairment
	FIAA_F001

	Z1205A
	Renovation [Admin]
	FIAA_F001

	Z1205C
	Renovation [Cost]
	FIAA_F001

	Z1301C
	Golf Course Development [Cost]
	FIAA_F001

	Z1301CI
	Golf Course Development [Cost]-Impairment
	FIAA_F001

	Z2101C
	Machine-Rolling Stock [Cost]
	FIAA_F001

	Z2102C
	Machine [Cost]
	FIAA_F001

	Z2201A
	Operating Equipment [Admin]
	FIAA_F001

	Z2201C
	Operating Equipment [Cost]
	FIAA_F001

	Z2301A
	Utility & Supply [Admin]
	FIAA_F001

	Z2301C
	Utility & Supply [Cost]
	FIAA_F001

	Z3101A
	Furniture & Fixtures [Admin]
	FIAA_F001

	Z3101C
	Furniture & Fixtures [Cost]
	FIAA_F001

	Z3201A
	Office Equipment [Admin]
	FIAA_F001

	Z3201C
	Office Equipment [Cost]
	FIAA_F001

	Z3301A
	Computer [Admin]
	FIAA_F001

	Z3301C
	Computer [Cost]
	FIAA_F001

	Z4101A
	Vehicle [Admin]
	FIAA_F001

	Z4101C
	Vehicle [Cost]
	FIAA_F001

	Z5101C
	Digital Advertising [Cost]
	FIAA_F001

	Z5201A
	Advertising Equipment [Admin]
	FIAA_F001

	Z5201C
	Advertising Equipment [Cost]
	FIAA_F001

	Z6101A
	Right of Use Asset-Land [Admin]
	FIAA_F001

	Z6101AI
	Right of Use Asset-Land [Admin]-Impairment
	FIAA_F001

	Z6101C
	Right of Use Asset-Land [Cost]
	FIAA_F001

	Z6101CI
	Right of Use Asset-Land [Cost]-Impairment
	FIAA_F001

	Z6102A
	Right of Use Asset-Building [Admin]
	FIAA_F001

	Z6102AI
	Right of Use Asset-Building [Admin]-Impairment
	FIAA_F001

	Z6102C
	Right of Use Asset-Building [Cost]
	FIAA_F001

	Z6102CI
	Right of Use Asset-Building [Cost]-Impairment
	FIAA_F001

	Z6103A
	Right of Use Asset-Equipment [Admin]
	FIAA_F001

	Z6103AI
	Right of Use Asset-Equipment [Admin]-Impairment
	FIAA_F001

	Z6103C
	Right of Use Asset-Equipment [Cost]
	FIAA_F001

	Z6103CI
	Right of Use Asset-Equipment [Cost]-Impairment
	FIAA_F001

	Z6104A
	Right of Use Asset-Vehicle [Admin]
	FIAA_F001

	Z6104AI
	Right of Use Asset-Vehicle [Admin]-Impairment
	FIAA_F001

	Z6104C
	Right of Use Asset-Vehicle [Cost]
	FIAA_F001

	Z6104CI
	Right of Use Asset-Vehicle [Cost]-Impairment
	FIAA_F001

	Z8101A
	Software & License [Admin]
	FIAA_F001

	Z8101C
	Software & License [Cost]
	FIAA_F001

	Z8102A
	Brand License [Admin]
	FIAA_F001

	Z8103A
	Not Used
	FIAA_F001

	Z8104A
	Trademarks [Admin]
	FIAA_F001

	Z8201C
	Right on Civil to Government [Cost]
	FIAA_F001

	Z8202A
	Right on Building to Government [Admin]
	FIAA_F001

	Z8202C
	Right on Building to Government [Cost]
	FIAA_F001

	Z8203C
	Right on E&M to Government [Cost]
	FIAA_F001

	Z8301A
	Leasehold Right-Land [Admin]
	FIAA_F001

	Z8301C
	Leasehold Right-Land [Cost]
	FIAA_F001

	Z8302A
	Leasehold Right-Building [Admin]
	FIAA_F001

	Z8302C
	Leasehold Right-Building [Cost]
	FIAA_F001

	Z8303A
	Leasehold Right-Condo & Fixtures [Admin]
	FIAA_F001

	Z8303C
	Leasehold Right-Condo & Fixtures [Cost]
	FIAA_F001

	Z9101
	AuC-Investment Property
	FIAA_F001

	Z9102
	AuC-Property, Plant and Equipment
	FIAA_F001

	Z9103
	AuC-Intangible
	FIAA_F001

	Z9201C
	Spare Parts awaiting Transfer [Cost]
	FIAA_F001

	Z9701A
	Low Valued Asset (LVA) [Admin]
	FIAA_F001

	Z9701C
	Low Valued Asset (LVA) [Cost]
	FIAA_F001

	Z9801
	Dummy for Asset
	FIAA_F001

	Z9901
	Asset for Consignment
	FIAA_F001

	Z9902
	Non Valued Asset (NVA)
	FIAA_F001



Remark: SAP standard layout: FIAA_F001 is a default for the asset history report (asset chart)

Key Fields Definitions
	Field Name
	Description

	Class
	Asset class ID

	Asset Class Description
	Asset class description

	Layout Set Name
	Layout set name for asset history report (asset chart)




7.4 [bookmark: _Toc107404588]Maintain Number Ranges for Lot ID of Asset Physical Counts

	Script Description
	Maintain lot ID number ranges for asset physical counts

	Objective
	To define the number range interval of lot ID for asset physical counts application on Fiori for each company code.

	Initial Menu Path
	IMG -> SAP NetWeaver -> Asset Accounting -> Business Warehouse -> General Settings -> Maintain number range objects

	Transaction Code
	SNRO

	Configuration to PRD
	Direct configuration

	Prerequisite Step
	N/A

	Remark
	Maintain for only company code which use Fiori application for asset physical counts



Screen: Number Range Object Editing
[image: ]
Enter object name ‘ZAALOTID’ (Physical Counts - Lot ID), then click on [image: ] (Interval Editing)



Screen: Edit Intervals: Physical Counts, Object ZAALOTID
[image: ]
Configure system by entering company code to maintain number range interval.
Click [image: ] to display number range
Click [image: ] to maintain number range
Click [image: ] to maintain current number for number range

Screen: Edit Intervals: Physical Counts, Object ZAALOTID, Subobject 1010
[image: ]
Configure system for all company codes which use Fiori application for asset physical counts as below table
	No
	Year
	From No.
	To Number
	NR Status
	Ext

	01
	2020
	001
	999
	
	

	01
	2021
	001
	999
	
	

	01
	2022
	001
	999
	
	

	01
	2023
	001
	999
	
	

	01
	2024
	001
	999
	
	

	01
	2025
	001
	999
	
	

	01
	2026
	001
	999
	
	

	01
	2027
	001
	999
	
	

	01
	2028
	001
	999
	
	

	01
	2029
	001
	999
	
	

	01
	2030
	001
	999
	
	



Key Fields Definitions
	Field Name
	Description

	No
	Number range number (Fixed ‘01’)

	Year
	Year of asset physical counts (A.D.)

	From No.
	The first number (lower limit) to be assigned of an interval 

	To Number
	The last number (upper limit) to be assigned of an interval 

	NR Status
	The last assigned number for an interval

	Ext
	Indicator which determines whether the interval is external number assignment


[bookmark: _Toc80015655]

8 [bookmark: _Toc107404589]Asset Data Transfer
8.1 [bookmark: _Toc80015657][bookmark: _Toc107404590]Define Transfer Date and Additional Parameters

	Script Description
	Define transfer date and additional parameters for asset accounting migration

	Objective
	To define legacy data transfer and document type for migration asset master & values 

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Asset Data Transfer -> Parameters for Data Transfer -> Define Transfer Date and Additional Parameters

	Transaction Code
	FAA_CMP_LDT

	Configuration to PRD
	Direct Configuration

	Prerequisite Step
	N/A

	Remark
	N/A



Screen: Change Setting for Company Code in Asset Accounting
[image: ]
Configure system as below table


	Company Code
	Sequence Number
	Transfer Date
	Legacy Data Transfer Status
	Document Type

	1010
	1
	31.07.2021
	2
	ZA

	1020
	1
	31.07.2021
	2
	ZA

	2010
	1
	31.07.2021
	2
	ZA

	2020
	1
	31.07.2021
	2
	ZA

	2030
	1
	31.07.2021
	2
	ZA

	2040
	1
	31.07.2021
	2
	ZA

	2050
	1
	31.07.2021
	2
	ZA

	3010
	1
	31.07.2021
	2
	ZA

	3020
	1
	31.07.2021
	2
	ZA

	3030
	1
	31.07.2021
	2
	ZA

	3040
	1
	31.07.2021
	2
	ZA

	5010
	1
	31.07.2021
	2
	ZA

	5020
	1
	31.07.2021
	2
	ZA

	5030
	1
	31.07.2021
	2
	ZA

	5040
	1
	31.07.2021
	2
	ZA

	5050
	1
	31.07.2021
	2
	ZA

	5060
	1
	31.07.2021
	2
	ZA

	5300
	1
	31.07.2021
	2
	ZA

	5310
	1
	31.07.2021
	2
	ZA

	5320
	1
	31.07.2021
	2
	ZA

	5500
	1
	31.07.2021
	2
	ZA

	5510
	1
	31.07.2021
	2
	ZA

	5520
	1
	31.07.2021
	2
	ZA

	5530
	1
	31.07.2021
	2
	ZA

	5540
	1
	31.07.2021
	2
	ZA

	5550
	1
	31.07.2021
	2
	ZA

	5560
	1
	31.07.2021
	2
	ZA

	5610
	1
	31.07.2021
	2
	ZA

	5620
	1
	31.07.2021
	2
	ZA

	5630
	1
	31.07.2021
	2
	ZA

	5800
	1
	31.07.2021
	2
	ZA

	5810
	1
	31.07.2021
	2
	ZA

	5840
	1
	31.07.2021
	2
	ZA

	5850
	1
	31.07.2021
	2
	ZA

	5900
	1
	31.07.2021
	2
	ZA

	5910
	1
	31.07.2021
	2
	ZA

	6200
	1
	31.07.2021
	2
	ZA

	6210
	1
	31.07.2021
	2
	ZA

	6220
	1
	31.07.2021
	2
	ZA

	6230
	1
	31.07.2021
	2
	ZA

	6240
	1
	31.07.2021
	2
	ZA

	6250
	1
	31.07.2021
	2
	ZA

	6260
	1
	31.07.2021
	2
	ZA

	6270
	1
	31.07.2021
	2
	ZA

	7010
	1
	31.07.2021
	2
	ZA

	7500
	1
	31.07.2021
	2
	ZA

	7510
	1
	31.07.2021
	2
	ZA

	8020
	1
	31.05.2022
	2
	ZA

	8030
	1
	31.05.2022
	2
	ZA

	8040
	1
	31.05.2022
	2
	ZA

	8050
	1
	31.05.2022
	2
	ZA

	8090
	1
	31.05.2022
	2
	ZA

	8100
	1
	31.07.2021
	2
	ZA

	8200
	1
	31.07.2021
	2
	ZA

	8300
	1
	31.05.2022
	2
	ZA

	8310
	1
	31.05.2022
	2
	ZA

	8330
	1
	31.05.2022
	2
	ZA

	8340
	1
	31.05.2022
	2
	ZA

	8350
	1
	31.05.2022
	2
	ZA

	8360
	1
	31.05.2022
	2
	ZA

	8370
	1
	31.05.2022
	2
	ZA

	8380
	1
	31.05.2022
	2
	ZA

	8390
	1
	31.05.2022
	2
	ZA

	8400
	1
	31.05.2022
	2
	ZA



Remark: 
· Define legacy data transfer date at 31.07.2021 for all company codes under Fusion 1 Project (Wave 1) 
· Document type for legacy data transfer is ZA (Asset Con. Document) 

Key Fields Definitions
	Field Name
	Description

	Company Code
	Company Code ID

	Sequence No.
	Sequence number of legacy asset transfer

	Transfer Date
	Transfer date for legacy assets transferred





	Legacy Data Transfer Status
	Status of legacy data transfer. The following statuses are possible:
· 0 - In Preparation:
With this status, the system allows incomplete Customizing settings for the legacy data transfer (for example, the document type for the posting of the legacy data transfer is allowed to be missing).

· 1 - Ongoing:
Only legacy data transfer postings are permitted; other types of postings (for example, acquisition postings and asset retirement postings) are not permitted.

· 2 - Ongoing (Other Postings Allowed):
Both legacy data transfer postings and other postings are permitted. This status makes sense when you perform further legacy data transfers in a company code that is already productive.

· 3 - Completed:
The legacy data transfer concerned is completed. Legacy data transfer postings are not allowed and you are not allowed to create legacy assets.



	Document Type
	Document type for legacy data transfer asset accounting



8.2 [bookmark: _Toc80015658][bookmark: _Toc107404591]Specify Offsetting Account for Legacy Data Transfer

	Script Description
	Specify conversion account for account posting of asset accounting migration. 

	Objective
	To specify a GL account that is used with the legacy data transfer for transferring asset balances

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Asset Data Transfer -> Parameters for Data Transfer -> Define Transfer Date and Additional Parameters

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request

	Prerequisite Step
	N/A

	Remark
	N/A





Screen: Change View “Offsetting Accounting for Legacy Data Transfer”: Overview
[image: ]
Configure system as below table
	ChAc
	G/L Account

	1000
	9910000009 



Remark: For Fusion 1 Project (Wave 1), offsetting account for Legacy Data Transfer is 9910000009 (Conversion-Asset) 

Key Fields Definitions
	Field Name
	Description

	ChAc
	Chart of accounts ID

	G/L Account
	GL account number for conversion asset balance account


[bookmark: _Toc80015659]

9 [bookmark: _Toc107404592]Validation
9.1 [bookmark: _Toc80015660][bookmark: _Toc107404593]Validation for Asset Master Data

	Script Description
	Define validation for asset master data

	Objective
	To define validation conditions for asset master data maintenance. The validation adds to the options provided in the asset master data maintenance in
· the ability to define the screen layout
· the maintenance level and
· the use of default value
During the validation, certain input values are checked against one or more conditions defined by the user. The validation runs after the first screen change after the entry is made. If the condition is met, the system accepts the entered values. If it is not, the system outputs an error message.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Define Validation

	Transaction Code
	OACV

	Configuration to PRD
	Via transport request

	Prerequisite Step
	N/A

	Remark
	This configuration is Workbench



Screen: Change View “Validation for Master Data (Asset Accounting)”: Overview
[image: ]
Configure system as below table
Validation for asset master data for Fusion 1 Project is configured as listed in Appendix 13: Assign Validation for Asset Master to Company Code. 
Example:
	CoCd
	FGTab
	Log.Fld.Gr
	Validation Description
	Validation
	Capit

	1010
	A
	3
	Time-dependent
	ZAAAMA3
	1 Active

	
	A
	4
	Allocations
	ZAAAMA4
	1 Active

	2010
	A
	3
	Time-dependent
	ZAAAMA3
	1 Active

	
	A
	4
	Allocations
	ZAAAMA4
	1 Active

	3010
	A
	3
	Allocations
	ZAAAMA3
	1 Active

	
	A
	4
	Time-dependent
	ZAAAMA4
	1 Active

	5300
	A
	3
	Allocations
	ZAAAMA3
	1 Active

	
	A
	4
	Time-dependent
	ZAAAMA4
	1 Active

	8100
	A
	3
	Allocations
	ZAAAMA3
	1 Active

	
	A
	4
	Time-dependent
	ZAAAMA4
	1 Active

	8200
	A
	3
	Allocations
	ZAAAMA3
	1 Active

	
	A
	4
	Time-dependent
	ZAAAMA4
	1 Active



Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	FGTab
	Field group table assignment ID which can use the following values:
· A: Asset master data (Table ANLA)
· B: Depreciation areas (Table ANLB)

	Log.Fld.Gr
	Logical field group ID in asset master data which can use the following values:
· 001: General data
· 002: Posting information
· 003: Time-dependent data
· 004: Allocations
· 005: Leasing
· 009: Origin
· 013: Equipment






	Validation
	Validation ID for asset master data with naming convention below:
	Z AA AM x y
· Digit 1: Z (Fixed)
· Digit 2-3: AA (Fixed) stands for Asset Accounting
· Digit 4-5: AM (Fixed) stands for Asset Master
· Digit 6: Field Group Table Assignment
· Digit 7: Logical Field Group

	Validation Description
	Validation description

	Capit
	Activation level for validation callup points which can use the following activation levels:
· 0: Inactive 
· 1: Active
· 2: Batch input processing



Screen: Change Validation: ZAAAMxy – Step nnn - Overview
[image: ]
Configure system as below table


	Validation 
	Step
	Prerequisite
	Check
	Message (Error)
	Message Text

	ZAAAMA3
	001
	ANLA-BUKRS <> '8200'
	ANLZ-PS_PSP_PNR2 = ''
	ZAA-003
	Do not enter WBS Element.

	ZAAAMA3
	002
	ANLA-BUKRS = '8200' AND ANLA-ANLKL LIKE '*A*'
	ANLZ-PS_PSP_PNR2 = ''
	ZAA-015
	Do not input WBS Element in Asset Class (Admin)

	ZAAAMA3
	003
	(ANLA-ANLKL LIKE 'Z97*') AND NOT (ANLA-ANLN1 IN ZFAA_DUMMYASSET)
	ANLZ-KOSTL <> ''
	ZAA-016
	Cost Center is required.

	ZAAAMA3
	004
	ANLA-ANLN1 IN ZFAA_DUMMYASSET
	ANLZ-KOSTL = ''
	ZAA-017
	Do Not Enter Cost Center in Dummy Asset.

	ZAAAMA4
	001
	NOT ANLA-ANLKL IN ZFAA_SUBCLASSALL
	ANLA-ANLKL :2-5: = ANLA-GDLGRP :1-4:
	ZAA-001
	Inconsistency between Asset Class and SubClass



Remark: 
· Validation: ZAAAMA3 in step 003 uses values list from Set master: ZFAA_DUMMYASSET for checking the condition
· Validation: ZAAAMA4 in step 001 uses values list from Set master: ZFAA_SUBCLASSALL for checking the condition
· Set master can be displayed via transaction code: GS03
· Customizing message type starting with ‘Z’ is maintained by ABAPer

Key Fields Definitions
	Field Name
	Description

	Validation 
	Validation ID

	Step
	Number of a validation step

	Prerequisite
	Prerequisite to be checked

	Check
	Condition logic to be checked

	Message
	Message output, if prerequisite is met and check is not fulfilled


[bookmark: _Toc80015661]

9.2 [bookmark: _Toc107404594]Validation for Transaction Data

	Script Description
	Validation for account posting related to asset transaction

	Objective
	To define additional checks for posting accounting documents in the form of validations for each company code. As for this part, only transaction related to asset accounting is taken into account.
During the validation, certain input values are checked against one or more conditions defined by the user. The validation runs after the first screen change after the entry is made. If the condition is met, the system accepts the entered values. If it is not, the system outputs an error message.

	Initial Menu Path
	IMG -> Financial Accounting Global Settings -> Tools -> Validation/Substitution -> Validation in Accounting Documents

	Transaction Code
	OB28

	Configuration to PRD
	Via transport request

	Prerequisite Step
	N/A

	Remark
	This configuration is Workbench



Screen: Change View “Validation for Accounting Documents”: Overview
[image: ]
Configure system as below table


	CoCd
	Call Point
	Validation
	Description
	Activtn Level

	1010
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	1020
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	2010
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	2020
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	2030
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	2040
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	2050
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	3010
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	3020
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	3030
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	3040
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5010
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5020
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5030
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5040
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5050
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5060
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5300
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5310
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5320
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5500
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5510
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5520
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5530
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5540
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5550
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5560
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5610
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5620
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5630
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5800
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5810
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5840
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5900
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	5910
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6200
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6210
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6220
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6230
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6240
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6250
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6260
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	6270
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	7010
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	7500
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	7510
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8020
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8030
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8040
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8050
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8090
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8100
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8200
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8300
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8310
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8330
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8340
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8350
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8360
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8370
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8380
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8390
	2
	ZFI0002
	FI Validation for Call Point 2
	1

	8400
	2
	ZFI0002
	FI Validation for Call Point 2
	1




Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	CallPnt
	Validation call point ID which can use the following activation levels:
· 1: Document header
· 2: Line item
· 3: Complete document


	Validation
	Validation ID for posting account documents with naming convention below:
	Z FI 000 n
· Digit 1: Z (Fixed)
· Digit 2-3: FI (Fixed) stands for Financial Accounting
· Digit 4-6: 000 (Fixed)
· Digit 7: Call Point ID

	Description
	Validation description


	Activtn Level
	Activation level for validation callup points which can use the following activation levels:
· 0: Inactive 
· 1: Active
· 2: Batch input processing





Screen: Change Validation: ZFI000x – Step nnn - Overview
[image: ]

Configure system as below table
	Validation 
	Step
	Prerequisite
	Check
	Message (Error)

	ZFI0002
	001
	BKPF-TCODE = 'ABAON' 
	U902
	ZAA-014



Remark: User Exit: U902 is used for validating of input assignment field as a required field when posting the asset retirement with revenue transaction (Asset Sales) via transaction code: ABAON. In addition, the values entered in assignment field must be correct format (Document No. + Fiscal Year) and also have to be existing in the system with line item of GL account: 1999999080 (Asset Selling Clear Revenue). 
Key Fields Definitions
	Field Name
	Description

	Validation 
	Validation ID

	Step
	Number of a validation step

	Prerequisite
	Prerequisite to be checked

	Check
	Condition logic to be checked

	Message
	Message output, if prerequisite is met and check is not fulfilled


10 [bookmark: _Toc80015662][bookmark: _Toc107404595]Substitution
10.1 [bookmark: _Toc107404596][bookmark: _Toc80015663]Substitution for Asset Master Data
10.1.1 [bookmark: _Toc107404597]Define substitution for automatic transfers

	Script Description
	Define substitution for automatic asset transfers between profit center

	Objective
	To define condition for substitution of automatic asset transfers posting. This substitution is trigged when changing cost center in asset master with different profit center for only the company applied with automatic transfer of organization units.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Define Substitution -> Define substitution for automatic transfers

	Transaction Code
	SPRO

	Configuration to PRD
	Via transport request

	Prerequisite Step
	Specify Time-Independent Management of Organiz Units

	Remark
	This configuration is Workbench



Screen: Change View “Substitution for transfer of organiz. units”: Overview
[image: ]
Configure system as below table
	CoCd
	Company Name
	Subst.
	Substitution Text

	1010
	BTSG
	ZAATF01
	Transfer Cost Center

	5300
	Rabbit Holdings
	ZAATF01
	Transfer Cost Center

	5810
	Kamkoong Property
	ZAATF01
	Transfer Cost Center

	8100
	RCASH
	ZAATF01
	Transfer Cost Center




Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	Company Name
	Company code description

	Subst.
	Substitution ID for transfer of organization units with naming convention below:
	Z AA TF nn
· Digit 1: Z (Fixed)
· Digit 2-3: AA (Fixed) stands for Asset Accounting
· Digit 4-5: TF (Fixed) stands for Transfer Posting
· Digit 6-7: Running Number

	Substitution Text
	Substitution description



Screen: Change Substitution: ZAATFxx – Step nnn - Overview
[image: ]
Configure system as below table
	Substitution 
	Step
	Prerequisite
	Substitution

	ZAATF01
	001
	SYST-TCODE = 'AS02' 
	Posting Date = ANLZ-ADATU





Key Fields Definitions
	Field Name
	Description

	Substitution 
	Substitution ID

	Step
	Number of a substitution step 

	Prerequisite
	Prerequisite to be checked

	Substitution
	Substitution the value, if prerequisite is met



10.1.2 [bookmark: _Toc107404598]Define substitution for creating assets

	Script Description
	Define substitution for creating assets

	Objective
	To define conditions for substitution for asset master data creation. This substitution is triggered when creating asset master data for assigned company code.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Define Substitution -> Define substitution for creating assets

	Transaction Code
	OACS

	Configuration to PRD
	Via transport request

	Prerequisite Step
	N/A

	Remark
	This configuration is Workbench



Screen: Change View “Master Data Substitution (Asset Accounting)”: Overview
[image: ]
Configure system as below table

	CoCd
	FGTab
	Log.Fld.Gr
	Subst.
	Substitution Text
	Capit

	1010
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	1020
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	2010
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	2020
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	2030
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	2040
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	2050
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	3010
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	3020
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	3030
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	3040
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5010
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5020
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5030
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5040
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5050
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5300
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5310
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5320
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5500
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5510
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5520
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5530
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5540
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5550
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5560
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5610
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5620
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5630
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5800
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5810
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5840
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5850
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5900
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	5910
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6200
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6210
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6220
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6230
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6240
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6250
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6260
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	6270
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	7010
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	7500
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	7510
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	7900
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8020
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8030
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8040
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8050
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8090
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8100
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8200
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8300
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8310
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8330
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8340
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8350
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8360
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8370
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8380
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8390
	A
	3
	ZAACAA3
	Time-dependent
	1 Active

	8400
	A
	3
	ZAACAA3
	Time-dependent
	1 Active



Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	FGTab
	Field group table assignment ID which can use the following values:
· A: Asset master data (Table ANLA)
· B: Depreciation areas (Table ANLB)

	Log.Fld.Gr
	Logical field group ID in asset master data which can use the following values:
· 001: General data
· 002: Posting information
· 003: Time-dependent data
· 004: Allocations
· 005: Leasing
· 009: Origin
· 013: Equipment




	Subst.
	Substitution ID for creating asset master data with naming convention below:
	Z AA CA x y
· Digit 1: Z (Fixed)
· Digit 2-3: AA (Fixed) stands for Asset Accounting
· Digit 4-5: CA (Fixed) stands for Create Asset
· Digit 6: Field Group Table Assignment
· Digit 7: Logical Field Group 

	Substitution text
	Substitution description

	Capit
	Activation level for validation callup points which can use the following activation levels:
· 0: Inactive 
· 1: Active
· 2: Batch input processing



Screen: Change Substitution: ZAACAxx – Step nnn - Overview
[image: ]
Configure system as below table
	Substitution 
	Step
	Prerequisite
	Substitution

	ZAACAA3
	001
	
	Responsible Cost Center = ANLZ-KOSTL





Key Fields Definitions
	Field Name
	Description

	Substitution 
	Substitution ID

	Step
	Number of a substitution step

	Prerequisite
	Prerequisite to be checked

	Substitution
	Substitution the value, if prerequisite is met



10.1.3 [bookmark: _Toc107404599]Define substitution for mass changes

	Script Description
	Define substitution for mass change of asset master data

	Objective
	To define conditions for substitution for asset master data maintenance. This substitution is triggered when performing mass change of asset master by using ‘Worklist’ via SAP standard report such as Asset Balance report.

	Initial Menu Path
	IMG -> Financial Accounting -> Asset Accounting -> Master Data -> Define Substitution -> Define substitution for mass changes

	Transaction Code
	OA02

	Configuration to PRD
	Via transport request

	Prerequisite Step
	N/A

	Remark
	This configuration is Workbench



Screen: Change View “Substitution in Mass Changes”: Overview
[image: ]
Configure system as below table
Substitution for mass changes for Fusion 1 Project is configured as listed in Appendix 13: Assign Substitution for Asset Mass Change to Company Code 
Example:
	CoCd
	Company Name
	No.
	Subst.
	Substitution Text

	1010
	BTSG
	1
	ZAAMC01
	Status: Found

	
	
	2
	ZAAMC02
	Status: Lost

	
	
	3
	ZAAMC03
	Status: Waiting for Retirement

	
	
	4
	ZAAMC04
	Status: Write-off

	
	
	5
	ZAAMC05
	Status: Sales

	
	
	6
	ZAAMC06
	Status: Donation

	
	
	7
	ZAAMC07
	Scrap Value = 1

	
	
	8
	ZAAMC08
	Physical Counts indicator = X

	
	
	9
	ZAAMC09
	Physical Counts indicator = ' '

	
	
	10
	ZAAMC10
	Block for Posting

	
	
	11
	ZAAMC11
	Unblock for Posting

	
	
	12
	ZAAMC12
	Quantity = 1

	2010
	BTSC
	1
	ZAAMC01
	Status: Found

	
	
	2
	ZAAMC02
	Status: Lost

	
	
	3
	ZAAMC03
	Status: Waiting for Retirement

	
	
	4
	ZAAMC04
	Status: Write-off

	
	
	5
	ZAAMC05
	Status: Sales

	
	
	6
	ZAAMC06
	Status: Donation

	
	
	7
	ZAAMC07
	Scrap Value = 1

	
	
	8
	ZAAMC08
	Physical Counts indicator = X

	
	
	9
	ZAAMC09
	Physical Counts indicator = ' '

	
	
	10
	ZAAMC10
	Block for Posting

	
	
	11
	ZAAMC11
	Unblock for Posting

	
	
	12
	ZAAMC12
	Quantity = 1

	3010
	VGI
	1
	ZAAMC01
	Status: Found

	
	
	2
	ZAAMC02
	Status: Lost

	
	
	3
	ZAAMC03
	Status: Waiting for Retirement

	
	
	4
	ZAAMC04
	Status: Write-off

	
	
	5
	ZAAMC05
	Status: Sales

	
	
	6
	ZAAMC06
	Status: Donation

	
	
	7
	ZAAMC07
	Scrap Value = 1

	
	
	8
	ZAAMC08
	Physical Counts indicator = X

	
	
	9
	ZAAMC09
	Physical Counts indicator = ' '

	
	
	10
	ZAAMC10
	Block for Posting

	
	
	11
	ZAAMC11
	Unblock for Posting

	
	
	12
	ZAAMC12
	Quantity = 1

	5300
	U City
	1
	ZAAMC01
	Status: Found

	
	
	2
	ZAAMC02
	Status: Lost

	
	
	3
	ZAAMC03
	Status: Waiting for Retirement

	
	
	4
	ZAAMC04
	Status: Write-off

	
	
	5
	ZAAMC05
	Status: Sales

	
	
	6
	ZAAMC06
	Status: Donation

	
	
	7
	ZAAMC07
	Scrap Value = 1

	
	
	8
	ZAAMC08
	Physical Counts indicator = X

	
	
	9
	ZAAMC09
	Physical Counts indicator = ' '

	
	
	10
	ZAAMC10
	Block for Posting

	
	
	11
	ZAAMC11
	Unblock for Posting

	
	
	12
	ZAAMC12
	Quantity = 1

	8100
	HHT
	1
	ZAAMC01
	Status: Found

	
	
	2
	ZAAMC02
	Status: Lost

	
	
	3
	ZAAMC03
	Status: Waiting for Retirement

	
	
	4
	ZAAMC04
	Status: Write-off

	
	
	5
	ZAAMC05
	Status: Sales

	
	
	6
	ZAAMC06
	Status: Donation

	
	
	7
	ZAAMC07
	Scrap Value = 1

	
	
	8
	ZAAMC08
	Physical Counts indicator = X

	
	
	9
	ZAAMC09
	Physical Counts indicator = ' '

	
	
	10
	ZAAMC10
	Block for Posting

	
	
	11
	ZAAMC11
	Unblock for Posting

	
	
	12
	ZAAMC12
	Quantity = 1

	8200
	RCASH
	1
	ZAAMC01
	Status: Found

	
	
	2
	ZAAMC02
	Status: Lost

	
	
	3
	ZAAMC03
	Status: Waiting for Retirement

	
	
	4
	ZAAMC04
	Status: Write-off

	
	
	5
	ZAAMC05
	Status: Sales

	
	
	6
	ZAAMC06
	Status: Donation

	
	
	7
	ZAAMC07
	Scrap Value = 1

	
	
	8
	ZAAMC08
	Physical Counts indicator = X

	
	
	9
	ZAAMC09
	Physical Counts indicator = ' '

	
	
	10
	ZAAMC10
	Block for Posting

	
	
	11
	ZAAMC11
	Unblock for Posting

	
	
	12
	ZAAMC12
	Quantity = 1



Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	Company Name
	Company code description

	No.
	Sequence number of substitutions

	Subst.
	Substitution ID for asset mass change with naming convention below:
	Z AA MC nn
· Digit 1: Z (Fixed)
· Digit 2-3: AA (Fixed) stands for Asset Accounting
· Digit 4-5: MC (Fixed) stands for Mass Change
· Digit 6-7: Sequence number

	Substitution Text
	Substitution description





Screen: Change Substitution: ZAACAA3 – Step 001 - Overview
[image: ]
Configure system as below table
	Substitution 
	Step
	Prerequisite
	Substitution

	ZAAMC01
	001
	
	Asset Status = FOUN

	ZAAMC02
	001
	
	Asset Status = LOST

	ZAAMC03
	001
	
	Asset Status = WRTM

	ZAAMC04
	001
	
	Asset Status = WOFF

	ZAAMC05
	001
	
	Asset Status = SALE

	ZAAMC06
	001
	
	Asset Status = DONA

	ZAAMC07
	001
	
	Scarp Value = 1

	ZAAMC08
	001
	
	Inventory Ind. = “X”

	ZAAMC09
	001
	
	Inventory Ind. = “ ”

	ZAAMC10
	001
	
	Posting Block = “X” 

	ZAAMC11
	001
	
	Posting Block = “ ”





Key Fields Definitions
	Field Name
	Description

	Substitution 
	Substitution name

	Step
	Number of a substitution step

	Prerequisite
	Prerequisite to be checked

	Substitution
	Substitution the value, if prerequisite is met


10.2 [bookmark: _Toc80015664][bookmark: _Toc107404600]Substitution for Transaction Data	

	Script Description
	Substitution for asset transaction

	Objective
	To define possible changes regarding your accounting documents in the form of substitutions of individual fields for your company codes, you can make changes both in the document header and in the line item. The substitutions are valid for both the manual entry of documents and for the automatic creation of documents.

	Initial Menu Path
	IMG -> Financial Accounting -> Financial Accounting Global Settings -> Tools -> Validation/Substitution -> Substitution in Accounting Documents

	Transaction Code
	OBBH

	Configuration to PRD
	Via transport request

	Prerequisite Step
	N/A

	Remark
	This configuration is Workbench



Screen: Change View “Substitution in Accounting Documents”: Overview
[image: ]
Configure system as below table
Example:
	CoCd
	CallPnt
	Subst.
	Description
	Activtn Level

	1010
	3
	ZFI0001
	RPT substitution
	1

	1020
	3
	ZFI0001
	RPT substitution
	1

	2010
	3
	ZFI0001
	RPT substitution
	1

	2020
	3
	ZFI0001
	RPT substitution
	1

	2030
	3
	ZFI0001
	RPT substitution
	1

	2040
	3
	ZFI0001
	RPT substitution
	1

	2050
	3
	ZFI0001
	RPT substitution
	1

	3010
	3
	ZFI0001
	RPT substitution
	1

	3020
	3
	ZFI0001
	RPT substitution
	1

	3030
	3
	ZFI0001
	RPT substitution
	1

	3040
	3
	ZFI0001
	RPT substitution
	1

	5010
	3
	ZFI0001
	RPT substitution
	1

	5020
	3
	ZFI0001
	RPT substitution
	1

	5030
	3
	ZFI0001
	RPT substitution
	1

	5040
	3
	ZFI0001
	RPT substitution
	1

	5050
	3
	ZFI0001
	RPT substitution
	1

	5060
	3
	ZFI0001
	RPT substitution
	1

	5300
	3
	ZFI0001
	RPT substitution
	1

	5310
	3
	ZFI0001
	RPT substitution
	1

	5320
	3
	ZFI0001
	RPT substitution
	1

	5500
	3
	ZFI0001
	RPT substitution
	1

	5510
	3
	ZFI0001
	RPT substitution
	1

	5520
	3
	ZFI0001
	RPT substitution
	1

	5530
	3
	ZFI0001
	RPT substitution
	1

	5540
	3
	ZFI0001
	RPT substitution
	1

	5550
	3
	ZFI0001
	RPT substitution
	1

	5560
	3
	ZFI0001
	RPT substitution
	1

	5610
	3
	ZFI0001
	RPT substitution
	1

	5620
	3
	ZFI0001
	RPT substitution
	1

	5630
	3
	ZFI0001
	RPT substitution
	1

	5800
	3
	ZFI0001
	RPT substitution
	1

	5810
	3
	ZFI0001
	RPT substitution
	1

	5840
	3
	ZFI0001
	RPT substitution
	1

	5850
	3
	ZFI0001
	RPT substitution
	1

	5900
	3
	ZFI0001
	RPT substitution
	1

	5910
	3
	ZFI0001
	RPT substitution
	1

	6200
	3
	ZFI0001
	RPT substitution
	1

	6210
	3
	ZFI0001
	RPT substitution
	1

	6220
	3
	ZFI0001
	RPT substitution
	1

	6230
	3
	ZFI0001
	RPT substitution
	1

	6240
	3
	ZFI0001
	RPT substitution
	1

	6250
	3
	ZFI0001
	RPT substitution
	1

	6260
	3
	ZFI0001
	RPT substitution
	1

	6270
	3
	ZFI0001
	RPT substitution
	1

	7010
	3
	ZFI0001
	RPT substitution
	1

	7500
	3
	ZFI0001
	RPT substitution
	1

	7510
	3
	ZFI0001
	RPT substitution
	1

	7900
	3
	ZFI0001
	RPT substitution
	1

	8020
	3
	ZFI0001
	RPT substitution
	1

	8030
	3
	ZFI0001
	RPT substitution
	1

	8040
	3
	ZFI0001
	RPT substitution
	1

	8050
	3
	ZFI0001
	RPT substitution
	1

	8090
	3
	ZFI0001
	RPT substitution
	1

	8100
	3
	ZFI0001
	RPT substitution
	1

	8200
	3
	ZFI0001
	RPT substitution
	1

	8300
	3
	ZFI0001
	RPT substitution
	1

	8310
	3
	ZFI0001
	RPT substitution
	1

	8330
	3
	ZFI0001
	RPT substitution
	1

	8340
	3
	ZFI0001
	RPT substitution
	1

	8350
	3
	ZFI0001
	RPT substitution
	1

	8360
	3
	ZFI0001
	RPT substitution
	1

	8370
	3
	ZFI0001
	RPT substitution
	1

	8380
	3
	ZFI0001
	RPT substitution
	1

	8390
	3
	ZFI0001
	RPT substitution
	1

	8400
	3
	ZFI0001
	RPT substitution
	1



Key Fields Definitions
	Field Name
	Description

	CoCd
	Company code ID

	CallPnt
	Validation call point ID which can use the following activation levels:
· 1: Document header
· 2: Line item
· 3: Complete document



	Subst.
	Substitution ID for posting account documents with naming convention below:
	Z FI 000 n
· Digit 1: Z (Fixed)
· Digit 2-3: FI (Fixed) stands for Financial Accounting
· Digit 4-6: 000 (Fixed)
· Digit 7: Call Point ID



	Description
	Substitution description

	Activtn Level
	Activation level for substitution callup points which can use the following activation levels:
· 0: Inactive 
· 1: Active
· 2: Batch input processing














Screen: Change Substitution: ZFI000x – Step nnn - Overview
[image: ]
Configure system as below table
	Substitution 
	Step
	Prerequisite
	Substitution

	ZAACAA3
	001
	
	U906



Remark: User Exist No. U906 is developed by ABAPer used for substitution trading partner & RPT indicator in asset accounting document referred to customizing program ZAAE006: Derive Trading Partner-RPT Indicator for Asset Posting. In addition, this user exit also used for all FI transactions (GL/AP/AR) related to RPT/NRT indicator.
Key Fields Definitions
	Field Name
	Description

	Substitution 
	Substitution ID

	Step
	Number of a substitution step 

	Prerequisite
	Prerequisite to be checked

	Substitution
	Substitution the value, if prerequisite is met


[bookmark: _Toc80015665]
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